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Welcome to PerkinElmer Spectrum Quant 

Spectrum Quant is a quantitative software system used to determine the quantities of 
components in a mixture by analyzing its IR spectrum. This is done by using different 
algorithms based on the nature of the sample being analyzed. 

NOTE: The QuantC, PCR+ and PLS1 algorithms are only available in Spectrum Quant if you 
have purchased a Quant Algorithm Pack license. 

Beer’s Law is an algorithm for calculating the quantities of each component, or property, in 
a multi-component sample by generating a regression equation of peak area or height as a 
function of a property value for a set of standard spectra. Putting the peak height or area of 
the sample into the regression equation gives the calculated property value for each 
component in the sample. 

PCR+ (Principal Component Regression) is an algorithm in which the spectra are modeled 
by one / a set of factors, and each property is modeled by relating the concentration values 
to those factors. The algorithm attempts to establish a relationship (one for each component 
or property of interest) between the spectra and a set of calibration standards and the 
corresponding property values determined by independent means. These relationships can 
be used for the subsequent prediction of unknown samples.  

PLS1 (Partial Least Square 1) is an algorithm in which each property is analyzed individually 
with respect to the spectral data. PLS1 seeks to express the variation in the property 
information by correlating it with the spectral information. The spectra are modeled by a 
different set of factors for each property, and the concentration values are modeled by the 
respective factors. Hence the PLS1 algorithm contains n separate calibrations (where n is the 
number of properties in the method), which gives a better signal/noise ratio.  

The QuantC algorithm uses data from complete spectra or selected regions, rather than 
measurements at discrete frequencies. Spectra of a series of standards of known composition 
are recorded and stored. When the spectrum of a sample is measured, the program attempts 
to match this spectrum by adding together the spectra of the standards in varying 
proportions, yielding a calculated sample spectrum. From the proportions of the standard 
spectra and the known concentrations and pathlength, the composition of the sample can be 
calculated. 

Beer’s Law is easy to use if your peak of choice is isolated, with no interference from other 
components in the mixture, and identifiable. QuantC, PCR+ and PLS1 are full-spectrum 
techniques, useful for bands where the peak positions are unknown, or where other bands 
overlap with the bands that are of interest. Unlike the Beer’s Law algorithm, they can also 
deal with non-linearity of components.  
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The Spectrum Quant Help System 

This help system covers the use of Spectrum Quant Standard and Spectrum Quant Enhanced 
Security (ES) software applications. 

NOTE: When you are working in Spectrum Quant, pressing the F1 key displays an 
appropriate Help topic. 

The help system is divided into the following areas:  

Getting Started - Building a New Method 

Working with Methods 

Predicting a Spectrum 

Publishing Results 

Configuring Default Parameters 

Viewing Spectra 

Audit Trail (Spectrum Quant ES only) 

Using and Customizing the User Interface 

Theory of the Quant Algorithms 

NOTE: In this help system, "C:" indicates the drive the software was installed on. 

 

 



Spectrum Quant User's Guide . 9 

Using Legacy Methods 

If you have an existing Quant method produced using another PerkinElmer quantification 
software package, such as Spectrum Beer’s Law or Spectrum Quant+, you can open your 
method in Spectrum Quant. The method formats that you can open will depend upon the 
algorithm licenses you have purchased. 

You must ensure that your standard spectra are in the appropriate file location for your 
legacy Quant method. However, once saved as a Spectrum Quant (*.qmd) method, the 
spectra will be embedded in the method file. 

NOTE: In Spectrum Quant ES, a signature may be required when opening legacy methods 
for the Quant - Open non-ES data signature point. 

Even if your method was previously calibrated, Spectrum Quant will require you to recalibrate 
it before predicting samples. Refer to Calibrating a Method for more information. 

Methods edited in Spectrum Quant will be saved in the Spectrum Quant (*.qmd) format. 

Recreating an Existing Quant+ Method in Spectrum Quant 

There are a number of differences between the legacy Quant+ software and Spectrum Quant 
which may have an effect on your results.  

Offset Baseline Correction 

In Quant+, the Offset baseline correction is calculated after any blank regions (both user-
defined and due to default thresholds) have been removed from the spectra.  

To achieve equivalent results in Spectrum Quant: 

 Use the range selector in Baseline Correction to manually add the blank regions from 
your Quant+ method. 

 Check the calibration report from your Quant+ method for any blank regions applied 
by the default thresholds and include these to the blank regions in the new Spectrum 
Quant method.  

MSC Normalization 

In Quant+, the range used by MSC Normalization excludes any blank regions (both user-
defined or due to default thresholds).  

To achieve equivalent results in Spectrum Quant: 

 Use the range selector in Normalization to manually add the blank regions from your 
Quant+ method. 

 Check the calibration report from your Quant+ method for any blank regions applied 
by the default thresholds and include these to the blank regions in the new Spectrum 
Quant method. 

Smooth 

Quant+ uses a Savitzky-Golay function to smooth the data, whereas Spectrum Quant uses a 
triangular function. This may lead to small differences between the smoothed spectra in the 
two methods. 
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Derivative Baseline Correction 

The noise reduction in Derivative baseline correction is expressed in Quant+ as the number 
of points across the width of the filter. In Spectrum Quant, the number of points across half 
the filter's width is used instead.   

To apply the same noise reduction in Spectrum Quant: 

 Calculate the filter's half-width corresponding to the full-width used in your Quant+ 
method. 

 If the full-width is N points, the half-width is (N − 1)/2 points. 

In Quant+, the noise reduction is applied at the specific data interval used in each spectrum. 
In Spectrum Quant, the noise reduction is applied after all the spectra have been 
interpolated to the data interval used by the method. If your spectra have different sampling 
intervals, or the method data interval is different from the spectral data interval, then you 
may not obtain identical results in the new method. 

Cross Validation Results 

Where mean or auto scaling is selected in the algorithm parameters, Quant+ applies the 
scaling before performing cross validation. In Spectrum Quant, the scaling is re-calculated for 
every iteration of the cross validation. Therefore, there will be small differences between the 
cross validation results for the two methods. There will be no effect on the final model unless 
the cross validation results cause the new method to select a different number of factors 
from the Quant+ method. 

Factor Limits 

In PLS1 algorithm methods, Quant+ performs a calculation that selects the optimum number 
of Latent Variables (factors) that are needed to most accurately model the values of a 
property. In Spectrum Quant, the same process occurs, but you can set a minimum number 
of Latent Variables that must be used. If you see differences in the number of factors used in 
the two methods, try reducing the minimum number of Latent Variables to a value equal to 
or less than the number used in your Quant+ method. However, check that the number of 
factors used in both methods is sufficient to accurately model your data. 

Outlier Thresholds 

In Spectrum Quant, a standard that falls within the outermost 10% of the normal distribution 
for the set of standards is considered an outlier. The threshold used in Quant+ was 5%. 
Therefore, there may be some instances when a standard that was previously within the 
outlier thresholds is now outside them. 

 



Getting Started - Building a 
New Method 
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Building a New Method 

Before you can use Spectrum Quant to predict the properties in a mixture, you need to build 
a method using a set of standard spectra that you have collected. The samples used for the 
standard spectra have different known concentrations of each component. 

The Quant method contains a list of the standard spectra and the concentration values for 
each component in the spectra. When you build a method, you also define the parameters 
that you are going to use for the prediction: which baseline correction, if any, you are going 
to use, which regions of the spectra you are going to use, etc. 

When Spectrum Quant opens, a new method is automatically created for you to use. 
However, if you need to create a new method yourself: 

 Select New from the File menu. 

 OR 

 Press CTRL+N. 

 A new method is added to the Method Explorer and given the default name New 
Method. The Summary tab for the method is displayed in the Viewing Area. 

NOTE: In Spectrum ES, you must have the permission Quant - Create/Edit a Method to 
create a new method. 

Building a New Method 

1. If required, enter a new Method Name on the Summary tab. 

 Any additional information can be entered in the Method Description field. 

2. Select Standards in the Method Explorer. 

 The Standards tab is displayed in the Viewing Area. A property column, Property1, is 
already added to the table, which you can rename. 

3. Click Add Standards. 

 The Add Standard Spectra dialog is displayed. 

4. Browse to and select the spectrum or spectra you would like to add, and then click 
Open. 

 The spectra added are listed in the Standards table.  

5. Click Add Column to add any additional columns you require to define the 
properties for the prediction. 

 As well as adding further property columns, you can also add a Normalization column 
or add Classification columns. You can normalize your standards by multiplying each 
property value by a scaling factor, for example, the pathlength for the measurement. 
Classifications and classes are used to group standards, for example, to easily 
distinguish between samples by source location, supplier, or some other 
differentiation. 

6. Enter the property values for your standards. 

7. Enter any normalization factor for your standards. 

8. Assign classes to your standards, if applicable. 

9. Select Algorithm in Method Explorer. 

 The Algorithm Summary tab is displayed in the Viewing Area. 
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10. Select an Algorithm from the drop-down list. 

 The options available depend on the algorithms you have purchased. 

 A tab is added for the appropriate algorithm settings. 

 For each of the algorithms, a tab is created for each property defined on the 
Standards tab. 

11. Select the parameters tab and then set up the peak, bands, spectra and regression 
parameters. 

 Refer to Beer’s Law Parameters for details of the peak and regression parameters for 
the Beer’s Law algorithm. Refer to QuantC Algorithm Parameters, PCR+ Algorithm 
Parameters and PLS1 Algorithm Parameters for details of the parameters of these 
full-spectrum algorithms. 

 A Summary of the algorithm parameters defined is displayed on the Algorithm 
Summary tab. 

12. For each algorithm, repeat Step 11 for each property. 

13. Select Calibrate from the Action menu to run the calibration. 

14. Select Save from the File menu and type a file name for the method. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Save Method signature point. 

15. Click OK to save the method. 

Additional Information 

Before you can use the method, it must be calibrated. Refer to Calibrating a Method for more 
information. 

Any spectra added to the Standards table are stored in the method when it is saved. To view 
the properties of a spectrum saved in the method or add a comment to a spectrum, see 
Status. 

To export a spectrum from a method as a binary (*.sp) or ASCII (*.asc) file, see Saving 
Spectra from the Spectral View. 
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Summary 

The Summary tab displays information about the method: 

• Method Name 

• Method Description / Method Version Description 

• Method Information 

• Model Information 

The Summary tab is displayed when a new method or method version is created, a method 
is opened, or a method version is selected. If the Summary tab is not currently displayed: 

 Select the Method Name or Version Name in the Method Explorer. 

 The Summary tab is displayed in the Viewing Area. 

Method Information 

The following method details are displayed: 

Version Number Available if versioning is set up for this method. 

Last Modified By Name of the user who last edited the method. 

Last Modified Date 

and Time 

The date and time the method was last modified. 

Creation Date and 

Time 

The date and time the method was created. 

Created By Name of the User who created the method. 

Number of 

Properties 

The number of properties in the method. 

Number of 

Standards 

The number of calibration standards in the method. 

Number of 

Classifications 

The number of classifications in the method. 

Method Status 

(Spectrum Quant ES 

only) 

The current status of the method: Not Registered, 

Unlocked, Locked, Reviewed, Approved. 

For more information, refer to Method Browser. 
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Model Information 

The following model details are displayed: 

Method Valid Yes or No. 

If the Method Valid status is No, a reason will be given. 

For example, Too Few Standards Included.  

Calibration 

Completed / 

Version Calibration 

Completed 

Yes or No. 

Algorithm The algorithm (selected on the Algorithm Summary tab). 

If the model has been calibrated, additional information about the calibration, such as the 
Correlation Coefficient and Standard Error of Prediction for each property, will be displayed. 

Additional Information 

You can edit the Method Name if the method has not been saved. If versioning is enabled 
and you want to rename a method, you can only change the Method Name in Version 1 of 
the method. 

For more information on managing method versions, refer to Method Versioning. Versioning 
is enabled on the Setup Method Options tab. 

You can edit the Method Description at any time. 

Method Valid 

To perform a calibration the Method Valid status (displayed in the Model Information) must 
be Yes.  

If the Method Valid status is No, a reason will be given. For example, Too Few Standards 
Included. 

A method is generally valid when: 

• Three or more standards have been added to the Standards table. 

 AND 

• A Property column has been added and the standards have been assigned property 
values. 

 AND 

• Peak parameters have been set up for each property (if applicable). 

NOTE: The peak position must be in the range of all the spectra included in the Standards 
table. 
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Standards 

The Standards tab enables you to select the spectra to be used as calibration standards in 
your model. 

 Select Standards in the Method Explorer. 

 The Standards tab is displayed in the Viewing Area. 

NOTE: A column selector in the top left corner of the Standards table enables you to define 
which columns are displayed by selecting the appropriate check box. The options are: 
Exclude, Name, Data/Time, Cross Validation Pattern, File Path, and any property or 
classification columns. 

Adding, Removing and Excluding Standards 

Adding Standards 

1. Click Add Standards. 

The Add Spectra dialog is displayed. 

2. Select the spectra to be used as standards and then click Open. 

 By default, binary spectra (*.sp files) are displayed. You can also open interferograms 
(*. ig files), JCAMP-DX files (*.dx, *.jdx), Omnic files (*.spa), GRAMS (*.spc), or 
spectra saved as data points in a PerkinElmer ASCII text format (*.asc files). 

 If you have Spectrum Quant ES you may be prompted to enter an electronic 
signature for the Quant - Open non-ES Data signature point. 

 A row is added to the Standards table for each spectrum selected. 

NOTE: If the Assign sample custom fields to properties and classifications dialog is 
displayed, refer to Adding Standards with Custom Fields. 

Adding Standards with Custom Fields 

If your spectra have Custom Fields associated with them, you can set up a Property, 
Classification or Normalization column for the Custom Field. You can create a new column, or 
select an existing column. If you do not want to include data in a Custom Field, you can 
select to Ignore it. 

1. Click Add Standards. 

 The Add Spectra dialog is displayed. 

2. Select the spectra to be used as standards and then click Open. 

 The Assign sample custom fields to properties and classifications dialog is displayed, 
which lists the Custom Fields for the selected spectra. 

3. For each Custom Field select the Type of column you want to create in the table. 

 The options are Property, Classification or Normalization. If you do not want to 
add a column for the Custom Field to the Standards table, you can select Ignore. 
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4. If you want to create a new column in the Standards table, with the column name 
set to the name of the Custom Field, then ensure that Use existing column is not 
selected. 

 OR 

 To use an existing column, select the Use existing column check box and then 
select the appropriate Property/Class Name from the drop-down list. 

 If Normalization was selected as the column Type, and there is already a 
Normalization column in the table, then Use existing column will be enabled. The 
Property/Classification Name option will be blank. 

5. Click Accept. 

The spectra are added to the Standards table, and the data in the Custom Field for 
the spectra selected are added either to a new column with the same name, or to 
the column with the Property/Class Name selected. 

OR 

 To ignore data in all Custom Fields, click Ignore. 

 The spectra are added to the Standards table, but any data in Custom Fields will be 
ignored. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Open non-ES Data signature point. 

Selecting Rows 

 Select, or deselect, a complete row in the table by clicking the first (left most) column 
in the row.  

 Any selected rows (or cells) are highlighted. 

 To select a block of rows, hold down the SHIFT key and click the first column in the 
first row and last rows, or click and drag up or down the table. 

 To select a row, or deselect a row leaving the others selected, hold down the CTRL 
key as you click the rows. 

Selecting Columns 

 Select, or deselect, a complete column in the table by clicking the column header.  

 Any selected cells are highlighted. 

Removing Standards 

1. Select the standards that you want to remove by clicking the first (left most) column 
in the row. 

2. Click Remove Standards. 

The Remove Standards dialog is displayed. 

3. Click Yes. 

The selected standards are removed from the Standards table. 
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Excluding Standards 

To exclude one or more standards from the calibration: 

 Select the appropriate Exclude check box next to the standard you want to exclude. 

 The data for the standard is removed from the Property vs. Property Plot. The 
standard is not removed from the Standards table. The standard will not be included 
in the calibration. 

Adding a Property Column 

NOTE: A property column (Property1) is added to the Standards table by default. You can 
rename a property. 

1. Click Add Column. 

2. Select Add Property from the drop-down list. 

 The Add Property dialog is displayed. 

3. Type the Property Name and Units. 

4. Click OK to add the Property Name as a column in the Standards table. 

 The units are displayed in parentheses after the Property Name in the column 
header. 

 To enter, or edit, the value of any property, double-click the left mouse button in the 
appropriate cell and then type the required value. 

Adding, Renaming and Deleting a Property using the Context menu 

To Add a property: 

1. Right-click on the header of an existing property column and select Add Property. 

 The Add Property dialog is displayed. 

2. Type the Property Name and Units. 

3. Click OK to add the Property Name as a column in the Standards table. 

 The units are displayed in parentheses after the Property Name in the column 
header. 

4. To enter, or edit, the value of any property, double-click the left mouse button in the 
appropriate cell and then type the required value. 

To Rename a property: 

1. Right-click on the header of the property column and then select Rename 
Property. 

 The Rename Property dialog is displayed. 

2. Type the new Property Name and, if required, type the new Units. 
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3. Click OK to apply the changes to the column in the Standards table. 

 OR 

 Click Cancel to exit the dialog without saving the changes. 

To Delete a property: 

1. Right-click on the header of the property column and select Delete Property. 

 The Remove Column dialog is displayed. 

2. Click Yes to remove the column from the Standards table. 

 OR 

 Click No to exit the dialog without saving the changes. 

Adding a Normalization Column 

You can normalize your standards by multiplying the each property value by a scaling factor. 
The default scaling factor is 1.0. 

The main reason for using a scaling factor is when you wish to use pathlength normalization. 
In this case, type the pathlength for each standard in the Normalization column. 

1. Click Add Column. 

2. Select Add Normalization from the drop-down list. 

NOTE: There can be only one Normalization column in the Standards table. If a 
Normalization column has already been added to the table, then the Add 
Normalization option will not be available. 

 The Normalization column is added to the Standards table. The default value is 1. 

3. To change the Normalization value, select the cell and type a new value. 

Deleting the Normalization Column using the Context menu 

1. Right-click on the header of the Normalization column and select Delete 
Normalization. 

 The Remove Column dialog is displayed. 

2. Click Yes to remove the column from the Standards table. 

 OR 

 Click No to exit the dialog without saving the changes. 
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Adding a Classification Column 

NOTE: Classifications created on the Setup Classifications tab can be used with any method. 
Classifications created inside a method are specific to that method and will not be 
added to the Classifications on the Setup Classifications tab. Any changes made to a 
Classification on the Setup Classifications tab will not be applied in an existing 
method. Similarly, any changes made to a Classification within a method will not be 
applied to the setup version. 

Classifications and classes are used to group standards. The spectra in each group can be 
assigned a display color. 

1. Click Add Column. 

2. Select Add Classification from the drop-down list. 

 The Add Classification dialog is displayed. 

3. To create a New Classification for the method, type a new Classification Name in 
the New Classification field. 

 OR 

 To use an existing Classification, select the drop-down arrow under Classification 
Name and then select the appropriate Classification. 

 All the Classifications created on the Setup Classifications tab are included in this list. 

4. Set up the Classes for the Classification in the table. 

 You can modify the name and display Color of existing Classes, or add new Classes. 
Click inside a row in the table to edit a class; or to create a new Class, type the new 
Class name in the field marked by a *. 

 The class is assigned a default color. To change the Color, select the drop-down 
arrow and then select a color from the palette. 

5. When you have set up all the Classes you require, click OK. 

 A Classification column of the selected name is added to the Standards table. 

Applying a Class to a Standard 

1. Select the cell in the Classification column for the standard you want to edit. 

2. Select the drop-down arrow to display the list of available Classes. 

3. Select the applicable Class from the list. 

Adding, Editing and Deleting a Classification using the Context menu 

To Add a Classification: 

1. Right-click on the header of a Classification column and select Add Classification. 

 The Add Classification dialog is displayed. 

2. Follow the instructions for adding a new Classification given above. 
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To Edit a Classification: 

1. Right-click on the header of the Classification column and select Edit 
Classification. 

 The Edit Classification dialog is displayed. 

2. Type a new Classification Name, if required. 

3. Add, delete or modify the Classes as described above. 

4. Click OK to exit the dialog and apply the changes. 

 OR 

 Click Cancel to exit the dialog without saving the changes. 

NOTE: If you delete or modify a Class that is in use in the Standards table, then the 
corresponding cell will be highlighted in pink until a new Class is assigned. 

To Delete a Classification: 

1. Right-click on the header of the Classification column and select Delete 
Classification. 

 The Remove Column dialog is displayed. 

2. Click Yes to remove the column from the Standards table. 

 OR 

 Click No to exit the dialog without saving the changes. 

Removing Columns 

1. Select the column that you want to remove by clicking on the column header. 

2. With the column selected, click Remove Column. 

 The Remove Column dialog is displayed. 

3. Click Yes to remove the column from the Standards table. 

 OR 

 Click No to exit the dialog without saving the changes. 

Using Cross Validation 

 Select the Cross Validation option that will be used when calibrating the method 
from the drop-down list. 

 The options are Leave 1 Out, K Fold and None. The default is None. 

 If you select K Fold, you are prompted to select the Number of Blocks and the 
Pattern by which standards are grouped. When you have set up the blocks, the Cross 
Validation Pattern column is added to the Standards table. 

 Refer to Cross Validation for more information. 
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Using the Spectral View 

Adding Spectra to the Spectral View 

To display spectra in the Spectral View you need to select the appropriate rows in the 
Standards table: 

 Select, or deselect, a complete row in the table by clicking the first (left most) column 
in the row.  

 Any selected rows (or cells) are highlighted. 

 To select a block of rows, hold down the SHIFT key and click the first column in the 
first row and last rows, or click and drag up or down the table. 

 To select or deselect a row, leaving the others selected, hold down the CTRL key as 
you click the rows. 

The Spectrum Browser 

The Spectral View includes a table, or spectrum browser, that enables you to select which 
curves you want to work with (for example, when rescaling spectra using the Autorange 
options). The names of the selected spectra are marked by a , and are drawn in full color; 
any unselected curves are not marked and are drawn dimmed. 

 To select a curve in the spectrum browser, click its name. 

 OR 

 Hover your mouse over the curve, right-click and then choose Select Only This 
Curve. 

 The curve is selected, and all other files deselected. 

 To select a block of curves, hold down SHIFT and click the first and the last name in 
the block. 

 To select or deselect a curve, leaving the others selected, hold down the CTRL key as 
you click the name of the curve. 

 To select all the curves in the Spectral View, press CTRL+A. 

NOTE: You can hide the spectrum browser by selecting Hide Information Pane on the 
Advanced tab of the Graph Properties dialog. 

Displaying Spectra by Classification 

If the Standards table contains a Classification column, then the spectra displayed in the 
Spectral View are colored according to the Class associated with them. If you have more 
than one Classification defined for your Standards, you can choose which Classification is 
used in the Spectral View: 

 Select the required classification from the Select Classification drop-down list. 

 The display the color of the spectra in the Spectral View is updated. 

NOTE: For information on assigning classifications to standards, refer to Adding a 
Classification Column. 
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Viewing Statistical Data 

 Select Show Statistical Data to view the statistical data for the algorithm. 

 A mean spectrum (Mean.sp) and a standard deviation spectrum (Standard 
Deviation.sp) are displayed on the Spectral View. A property correlation spectrum is 
displayed for each property specified in the method ([Property name].sp). The 
property correlation spectrum is calculated by multiplying the differences between 
each standard spectrum and the mean spectrum by the difference between the 
corresponding property value and the mean property value, and summing over all the 
standards. Peaks that do not correlate with the change in concentration are summed 
to zero, producing a spectrum that highlights the peaks that change with variation in 
concentration, that is, the peaks that relate to the property. 

 To export a spectrum from a method as a binary (*.sp) or ASCII (*.asc) file, see 
Saving Spectra from the Spectral View. 

Using the Property vs Property Graph 

The Property vs Property graph enables you to view the spread in the property values, and 
investigate if there is any correlation between different properties in the Standards table. By 
default, the graph displays the Index vs the first property in the Standards table. 

Select the property of interest from the Y Axis drop-down list, and then select the required 
option for display from the X Axis drop-down list. You can select Index, Ordered or any 
property defined in the Standards table. 

Selecting Index plots the standards in the order they appear in the Standards table (1, 2, 3, 
etc.) against the value of the property selected for the Y axis. 

Selecting Ordered plots the standards in order of increasing value of the property selected 
for the Y axis against the value of that property. 

Selecting a property for display on the X axis plots the value of that property against the 
value of the property selected for the Y axis. The Correlation between the two properties is 
displayed on the graph. 

Displaying Data by Classification 

If the Standards table contains a Classification column, then the color and shape of data 
points in the Property vs Property graph can be dependent on the Class associated with 
them. If you have more than one Classification defined for your Standards, you can choose 
which Classification is used in the Spectral View: 

 Select the required classification from the Select Classification drop-down list. 

 The color of the data points is keyed to the class assigned to the property value. 

 If you do not select a classification from the drop-down list, all data points are 
displayed according to the global settings. 

NOTE: For information on assigning classifications to standards, refer to Adding a 
Classification Column. 
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Pre-Processing 

When you are building a method, you can select processing that will be applied to all spectra 
(the standard spectra and the sample spectrum) before a Quant calibration or prediction is 
performed. 

1. Select Pre-Processing in the Method Explorer. 

The Summary tab is displayed in the Viewing Area. 

2. Select the appropriate Pre-Processing Steps from the table below the standard 
spectra by checking the checkboxes. 

A tab will be added in the Viewing Area for each of the steps selected. 

The spectra in the Viewing Area can be displayed according to their classification, if any are 
configured. 

 Select the required classification from the Select Classification drop-down list. 

Additional Information 

The pre-processing steps available will depend upon the algorithm being used by the 
method.  

You can select which steps are applied by default to all new methods on the Setup Summary 
tab in the Pre-Processing setup section. You can also configure the default options and 
settings for each steps. 
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Range 

The Range pre-processing step enables you to set regions of the data to be included or 
excluded in the Quant method calculations, and the data interval to be used for all standard 
and sample spectra.  

NOTE: The Range pre-processing option is not available for the Beer’s Law algorithm. 

You can enter the values in text boxes or set them interactively. 

 Use the Select Spectra drop-down list to choose a standard spectrum to view. 

 Select the Raw option to view the original spectrum, or Preprocessed to view the 
spectrum after pre-processing has been applied. 

Ranges 

To set data ranges: 

1. Click the Add button. 

A narrow green band is displayed on the standard spectrum in the Viewing Area. 

2. To resize the shaded area, position the mouse pointer over its left or right edge. 

The mouse pointer changes to a double-headed arrow . 

3. Drag the edge to change the size of the shaded area. 

The start and end abscissa values are shown in the table and on the spectrum. 

4. To move the shaded area, position the mouse pointer inside it. 

The mouse pointer changes to a four-headed arrow . 

5. Drag the shaded area to the required position. 

The new start and end abscissa values are shown in the table and on the spectrum. 

6. To analyze the spectra using only the shaded area, select the Include selection 
mode. 

The area will be colored green. 

OR 

If you want to exclude the shaded area from the calculations, select the Exclude 
selection mode. 

The area will be colored pink. 

You can set up more than one shaded area by repeating steps 1–6 above. When multiple 
ranges are set up, the active area appears darker in color than the others.  

NOTE: You cannot combine included and excluded regions. If you want to define a range for 
the pre-processing which contains a blank region, select two ranges using the Include 
selection mode on either side of the blank region. 

To remove a range: 

 Click the button to the left of the range values in the table to highlight the row, and 
then click the Remove button. 
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Automatic Blanking 

You can choose to exclude peaks above and below certain ordinate values from the method 
calculations. 

To exclude peaks above a certain value: 

 Check the Upper Threshold checkbox, and enter the ordinate value above which 
peaks in the spectra should be ignored. 

 By default, this option is selected with a value of 1.5. 

To exclude peaks below a certain value: 

 Check the Lower Threshold checkbox, and enter the ordinate value below which 
peaks in the spectra should be ignored. 

You can also apply Atmospheric Blanking, which removes any peaks in the spectra that are 
due to atmospheric carbon dioxide and water: 

 Check the Atmospheric Blanking checkbox. 

By default, Spectrum Quant will use the largest data interval from the standard spectra in its 
calculations. If you want to use another value (for example, to reduce the number of 
calculations to be performed): 

 Check the Use Data Interval checkbox, and enter a value. 
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Weighting 

The Weighting pre-processing step enables you to adjust the influence of regions of the 
spectrum where the absorbance data are less reliable because they are affected by factors 
other than the sample. 

NOTE: The Weighting pre-processing option is not available for the Beer’s Law algorithm. 

 Use the Select Spectra drop-down list to choose a standard spectrum to view. 

 Select the Raw option to view the original spectrum, or Preprocessed to view the 
spectrum after pre-processing has been applied. 

Four Weighting Factors are available: Instrument Response, Transmission, Atmospheric and 
Smooth. See Additional Information for further details. 

To apply the Weighting Factors: 

 Check the checkboxes for the weighting factors you want to apply. 

 If you select Instrument Respose Weighting, choose the type of weighting from 
the Types drop-down list. The options are MIR Black Body, NIR Black Body and 
User Defined. See Additional Information for further details. 

 If you select Smooth, click the browse button in the Types column to select the 
number of half width points to use in the smoothing. Use the scale or the text box to 
enter the number of half width points (range 2–74), and then click Close. 

See Additional Information for further details. 

Additional Information 

The Instrument Response Weighting factor applies a spectrum of the source being used 
in the instrument to correct for differences in the signal output across the wavelength range. 
Three types of correction are available. Use MIR Black Body if your samples are scanned 
over the mid-infrared range. Use NIR Black Body if your samples are scanned over the 
near infrared range. Selecting User Defined displays an Open File dialog, from where you 
can select a spectrum for a different source.  

The Transmission Weighting factor applies a black band filter that reduces the influence 
of regions where the transmission is low, because they have high noise in absorbance.  

The Atmospheric Weighting factor consists of CO2 blanking and H2O blanking. This 
reduces or eliminates the effect of differences in atmospheric conditions when spectra are 
collected. CO2 blanking removes the influence of carbon dioxide on your spectrum; it 
excludes all data between 2390 and 2280 cm-1. H2O blanking excludes all data between 7450 
and 6950 cm-1, 5600 and 5100 cm-1, 4000 and 3500 cm-1, and 1900 and 1300 cm-1. 

The Smooth factor reduces the noise level of your spectrum, but it also degrades the 
resolution of your spectrum and cause features in the spectrum to become broader. If you 
use too great a level of smoothing, bands are broadened excessively and resolution is lost. 
Smoothing should not change band areas or the position of symmetrical bands. It is 
unsuitable for spectra with very sharp peaks.  

The number of half width points defines the degree of smoothing applied to the spectrum; 
the larger this number, the more smoothing that is applied. 
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Normalization 

The Normalization pre-processing step enables you to select an option for normalizing the 
data used in the Quant method, to assist with comparing different spectra.  

NOTE: The Normalization pre-processing option is not available for the Beer’s Law algorithm. 

 Use the Select Spectra drop-down list to choose a standard spectrum to view. 

 Select the Raw option to view the original spectrum, or Preprocessed to view the 
spectrum after pre-processing has been applied. 

Four Normalization options are available. 

• Path Length – this option normalizes every data point in the spectrum by a 
user-defined factor. 

• Reference Band – this option uses an internal standard to overcome variations due 
to path length, when the path length cannot be determined. 

• MSC – Multiplicative Scatter Correction normalization compensates for wavelength-
dependent light scattering variations encountered during reflectance spectroscopy. 

• SNV – Standard Normal Variate normalization effectively removes the multiplicative 
interferences of scatter and particle size that are a particular problem with near 
infrared, diffuse reflectance spectra. 

See Additional Information for further details. 

Path Length 

1. In the Normalization tab, select Path Length. 

2. In the Standards table, click the Add Column button. 

3. Select Add Normalization. 

A Normalization column appears in the table. 

4. Enter the path length values for each standard. 

Reference Band 

1. In the Normalization tab, select Reference Band. 

You should now set up the peak parameters for the spectral band that you want to 
use as an internal reference. You can use a peak area or a peak height (either the 
height at a defined abscissa value or the maximum height over a range). The values 
can be measured from zero absorbance or from a user-defined baseline. You can use 
the Vertical Cursor and the markers on the graph to define the peak parameters. 
Alternatively, you can just enter the values directly into the table. The graph display 
will be updated accordingly.  

2. Select Area, Height or Max Height as the Peak Type. 

Area calculates the area under the curve over a selected range. Height determines 
the height of the selected peak. Max Height determines the maximum peak height 
over a selected range. 
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3. Select the number of Bases for the Baseline. 

 If no bases are selected, the zero absorbance is used as the baseline.   

 If Base 1 only is selected, then a horizontal baseline is drawn at the ordinate value 
defined on the graph. If Base 1 and Base 2 are selected, the baseline is drawn 
between the two points defined on the graph. 

 If one or more bases are selected, then the options Min Bases and Mean Bases 
become available. 

 Min Bases adds range markers for each base point (displayed on the graph as two 

hollow triangles ). The base point used (marked on the graph by a solid 
triangle) is the minimum value between the markers. 

 Mean Bases adds range markers for each base point ( ). The base point 
used (not marked on the graph) is the mean value between the markers. 

4. Move the Vertical Cursor to the peak position you want to use to calculate the 
property, and then double-click to add the peak position to the table. 

 Position the mouse pointer over the Vertical Cursor until the mouse cursor changes to 
a double-headed arrow . Hold down the left mouse button and then move the 
mouse left or right to drag the cursor to the new position. Release the mouse button. 
Then double-click the left mouse button. The values in the peak table are 
automatically updated. 

NOTE: The peak position must be in the range of all the spectra included in the Standards 
table. 

5. Use the graph markers to adjust the point on the curve at which the height will be 
determined, the range over which the peak area or maximum height will be 
calculated, or the position of the baseline markers, as required. 

 To move a range or baseline marker, hover the cursor over it until a double-headed 
arrow   is displayed, click the left mouse button and then drag the marker to the 
new position on the curve. Release the left mouse button. The values in the peak 
table are automatically updated. Alternatively, you can just type the values you want 
directly into the table. The graph display will be updated accordingly. 
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Area 

Area is defined by Start and End abscissa values (displayed as vertical lines on the 
graph). If no bases are selected, then the Area is measured from the curve to zero 
absorbance. If one or two bases are selected (shown as triangles on the graph), then the 
Area is measured from the curve to the baseline. Here is an example of the peak Area 
markers with two base points: 
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Height 

Height is defined by an abscissa value (X in the table). If no bases are selected, then the 
Height is measured from the curve to zero absorbance. If one or two bases are selected 
(shown as triangles on the graph), then the Height is measured from the curve to the 
baseline. Here is an example of the Height marker with two base points. 
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Max Height 

Max Height is defined by Start and End abscissa values (displayed as vertical lines on the 
graph). The Max Height is the maximum peak height between the Start and End abscissa 
values. If no bases are selected, then the Max Height is measured from the curve to zero 
absorbance. If one or two bases are selected (shown as triangles on the graph), then the 
Max Height is measured from the curve to the baseline. Here is an example of the Max 
Height markers with two base points. 

 

MSC 

1. In the Normalization tab, select MSC. 

You should now select the range over which you want the MSC normalization to be 
applied. 

2. Click the Add button. 

A narrow green band is displayed on the standard spectrum in the Viewing Area. 

3. To resize the shaded area, position the mouse pointer over its left or right edge. 

The mouse pointer changes to a double-headed arrow . 

4. Drag the edge to change the size of the shaded area. 

The start and end abscissa values are shown in the table and on the spectrum. 

5. To move the shaded area, position the mouse pointer inside it. 

The mouse pointer changes to a four-headed arrow . 

6. Drag the shaded area to the required position. 

The new start and end abscissa values are shown in the table and on the spectrum. 
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7. To apply the normalization over only the shaded area, select the Include option. 

The area will be colored green. 

OR 

If you want to exclude the shaded area from the normalization, select the Exclude 
option. 

The area will be colored pink. 

You can set up more than one shaded area by repeating steps 2–7 above. When multiple 
ranges are set up, the active area appears darker in color than the others. 

NOTE: You cannot combine included and excluded regions. If you want to define a range for 
the pre-processing which contains a blank region, select two ranges using the Include 
option on either side of the blank region. 

To remove a range: 

 Click the button to the left of the range values in the table to highlight the row, and 
then click the Remove button. 

NOTE: Selecting an MSC range will not affect the appearance of the pre-processed 
spectrum, because the normalization is relative to all the standards. 

SNV 

1. In the Normalization tab, select SNV. 

2. If you want to use detrending, check the Use Detrending checkbox. 

Detrending accounts for the variation in baseline shift and curvilinearity that is often 
seen in near infrared, diffuse reflectance spectra. 

Additional Information 

Reference Band normalization requires the use of an internal standard which contains a 
spectral peak (or band) that is not overlapped by other components of the standards or 
samples. It is the height of this peak that is normalized. 

With MSC normalization, the scatter of each standard is estimated relative to the mean 
standard, and then normalized such that each standard has the same scatter as the mean. 
Sample spectra are then treated in the same way during a prediction using the Quant 
method.  

SNV normalization applies an offset and scaling to each spectrum so that the average 
absorbance is zero and the RMS value is 1. The normalization is automatically applied over 
the same range as the method, allowing for any blank regions that are selected. 
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Baseline Correction 

The Baseline Correction pre-processing step allows you to select a type of correction for the 
baselines in your standard and sample spectra.  

 Use the Select Spectra drop-down list to choose a standard spectrum to view. 

 Select the Raw option to view the original spectrum, or Preprocessed to view the 
spectrum after pre-processing has been applied. 

Four Baseline Correction types are available: 

• Derivative – uses first or second order derivative spectra to correct the baseline and 
sharpen the appearance of the spectral peaks for the standards and samples in the 
Quant method. 

• Offset – a horizontal offset spectrum is added to the standards in the Quant method, 
to minimize problems such as negative intensities and spikes which are associated 
with correction routines that use a single frequency. 

• Slope – a linearly sloping baseline spectrum and a horizontal offset spectrum are 
added to the standards in the Quant model. 

• Curve – a parabolic baseline spectrum, a linearly sloping baseline spectrum and a 
horizontal offset spectrum are all added to the standards in the Quant model.  

NOTE: Only the Derivative option is available for the Beer’s Law algorithm. 

Derivative 

1. In the Baseline Correction tab, select Derivative. 

2. Select whether to use the First- or Second-order derivative spectrum. 

3. Enter the number of Half Width Points to use for the noise reduction in the spectrum 
(range 2–74). 

OR  

Use the scale to select the degree of noise reduction. 

See Additional Information for further details. 

Offset 

1. In the Baseline Correction tab, select Offset. 

You should now select the range of the spectrum to use for the baseline correction. 

2. Click the Add button. 

A narrow green band is displayed on the standard spectrum in the Viewing Area. 

3. To resize the shaded area, position the mouse pointer over its left or right edge. 

The mouse pointer changes to a double-headed arrow . 

4. Drag the edge to change the size of the shaded area. 

The start and end abscissa values are shown in the table and on the spectrum. 
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5. To move the shaded area, position the mouse pointer inside it. 

The mouse pointer changes to a four-headed arrow . 

6. Drag the shaded area to the required position. 

The new start and end abscissa values are shown in the table and on the spectrum. 

7. To generate the baseline correction using only the shaded area, select the Include 
option. 

The area will be colored green. 

OR 

If you want to exclude the shaded area from the calculations, select the Exclude 
option. 

The area will be colored pink. 

You can set up more than one shaded area by repeating steps 2–7 above. This allows you to 
correct the baseline using appropriate regions from anywhere in the spectrum. When 
multiple ranges are set up, the active area appears darker in color than the others. 

NOTE: You cannot combine included and excluded regions. If you want to define a range for 
the pre-processing which contains a blank region, select two ranges using the Include 
option on either side of the blank region. 

To remove a range: 

 Click the button to the left of the range values in the table to highlight the row, and 
then click the Remove button. 

Slope 

1. In the Baseline Correction tab, select Slope. 

2. Select the range for the baseline correction as described in the procedure for the 
Offset option. 

3. Check the Restrict Range checkbox to prevent the corrected baseline from being 
extrapolated outside the range you have selected. 

If Restrict Range is not selected, then the corrected baseline will be extrapolated 
across the entire range of the spectrum. 

Curve 

1. In the Baseline Correction tab, select Curve. 

2. Select the range for the baseline correction as described in the procedure for the 
Offset option. 

3. Check the Restrict Range checkbox to prevent the corrected baseline from being 
extrapolated outside the range you have selected. 

If Restrict Range is not selected, then the corrected baseline will be extrapolated 
across the entire range of the spectrum. 
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Additional Information 

Derivative spectra usually have sharper features than the original spectra. In quantitative 
analysis, they can be sued to reduce the effect of overlapping bands. The amplitudes of 
features in derivative spectra can be used in the same way as peak absorbances. Taking the 
first derivative of a spectrum removes any baseline offset, while the second derivative also 
removes any linear slope. Second derivative spectra also have sharp minima at the same 
positions as the maxima in the original spectrum, so they can be used to identify peak 
positions in complex regions. 

Derivative spectra emphasize narrow features, including noise, relative to broad ones. You 
can control this to some extent by varying the width of the derivative function, which is 
equivalent to applying noise reduction to the derivative spectrum. 
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Algorithm 

The Algorithm Summary tab enables you to choose the Algorithm for your method. 

1. Select Algorithm from the Method Explorer. 

 The Algorithm Summary tab is displayed in the Viewing Area. 

2. Select the appropriate Algorithm from the drop-down list. 

 An appropriate algorithm parameters tab will be added in the Viewing Area. If you 
select the Beer’s Law algorithm, a tab will be added for each of the properties defined 
in the Standards section. Each property tab will showing the name of the 
corresponding property. 

NOTE: If you change the algorithm, the current parameter settings will be lost. 

Summary 

The Summary section displays a table of the parameter configured for the algorithm. For 
Beer’s Law algorithm methods, this includes the Property Name and Units and, if the 
parameters have been set up, the Calculation Type and Peak Parameters. 

Additional Information 

You can define the Algorithm that will be applied by default to all new methods on the Setup 
Default Algorithm tab. You can also define some default parameters for each Algorithm.  
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Beer’s Law Algorithm Parameters 

If Beer’s Law is selected as the Algorithm, you need to set up the peak and regression 
parameters for each property defined on the Standards tab. 

To display the Beer’s Law parameters: 

1. Select Beer’s Law from the Algorithm drop-down list on the Algorithm Summary tab.  

 A Beer’s Law tab is added to the Viewing Area for each property defined on the 
Standards tab. 

2. Select the tab for the property you want to set up. 

 A summary of the Peak Parameters for each property set up is added to the 
Algorithm Summary tab. 

Selecting a Spectrum 

Before defining the peak parameters, select an appropriate Standard spectrum to display: 

 Select the spectrum you want to view from the Select spectrum for parameter 
display drop-down list. 

 The spectrum with the highest property value for the current property is displayed by 
default. 

NOTE: If you want to view the spectra with different units, select the appropriate option 
from the View menu to convert the spectrum to absorbance (A) or percentage 
transmittance (%T). 

Setting the Peak Parameters 

You can calculate the property values using a peak area or a peak height (either the height 
at a defined abscissa value or the maximum height over a range). The values can be 
measured from zero absorbance or from a user-defined baseline. You can also calculate the 
property using the average of two peaks, using the Peak Ratio option. 

You can use the Vertical Cursor and the markers on the graph to define the peak 
parameters. Alternatively, you can just type the values you want directly into the table. The 
graph display will be updated accordingly. 

To define the Peak Parameters: 

1. Select Area, Height or Max Height as the Peak Type. 

 Area calculates the area under the curve over a selected range. Height determines 
the height of the selected peak. Max Height determines the maximum peak height 
over a selected range. 

2. If you want to calculate a peak ratio, select Peak Ratio. 

 A row is added to the peak table for the second peak and a row is added for the 
ratio. The ratio is automatically named [Peak Name Row 1]/[Peak Name Row 2]. 

 You can edit the name of a peak. Click the left mouse button in the appropriate cell 
and type a new name. 
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3. Select the number of Bases for the Baseline. 

 If no bases are selected, the zero absorbance is used as the baseline.   

 If Base 1 only is selected, then a horizontal baseline is drawn at the ordinate value 
defined on the graph. If Base 1 and Base 2 are selected, the baseline is drawn 
between the two points defined on the graph. 

 If one or more bases are selected, then the options Min Bases and Mean Bases 
become available. 

 Min Bases adds range markers for each base point (displayed on the graph as two 

hollow triangles ). The base point used (marked on the graph by a solid 
triangle) is the minimum value between the markers. 

 Mean Bases adds range markers for each base point ( ). The base point 
used (not marked on the graph) is the mean value between the markers. 

4. If you selected Peak Ratio in Step 2, select the row in the table for the first peak you 
want to define. 

5. Move the Vertical Cursor to the peak position you want to use to calculate the 
property, and then double-click to add the peak position to the table. 

 Position the mouse pointer over the Vertical Cursor until the mouse cursor changes to 
a double-headed arrow . Hold down the left mouse button and then move the 
mouse left or right to drag the cursor to the new position. Release the mouse button. 
Then double-click the left mouse button. The values in the peak table are 
automatically updated. 

NOTE: The peak position must be in the range of all the spectra included in the Standards 
table. 

6. Use the graph markers to adjust the point on the curve at which the height will be 
determined, the range over which the peak area or maximum height will be 
calculated, or the position of the baseline markers, as required. 

To move a range or baseline marker, hover the cursor over it until a double-headed arrow 
  is displayed, click the left mouse button and then drag the marker to the new position 

on the curve. Release the left mouse button. The values in the peak table are 
automatically updated. Alternatively, you can just type the values you want directly into 
the table. The graph display will be updated accordingly. 
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Area 

Area is defined by Start and End abscissa values (displayed as vertical lines on the 
graph). If no bases are selected, then the Area is measured from the curve to zero 
absorbance. If one or two bases are selected (shown as triangles on the graph), then the 
Area is measured from the curve to the baseline. Here is an example of the peak Area 
markers with two base points: 
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Height 

Height is defined by an abscissa value (X in the table). If no bases are selected, then the 
Height is measured from the curve to zero absorbance. If one or two bases are selected 
(shown as triangles on the graph), then the Height is measured from the curve to the 
baseline. Here is an example of the Height marker with two base points. 
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Max Height 

Max Height is defined by Start and End abscissa values (displayed as vertical lines on the 
graph). The Max Height is the maximum peak height between the Start and End abscissa 
values. If no bases are selected, then the Max Height is measured from the curve to zero 
absorbance. If one or two bases are selected (shown as triangles on the graph), then the 
Max Height is measured from the curve to the baseline. 

Here is an example of the Max Height markers with two base points. 

 

7. If you selected Peak Ratio in Step 2, repeat Steps 5-6 for the second peak. 

NOTE: If you modify the parameters of either peak row, then the ratio values are 
automatically updated. 
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Setting the Regression Parameters 

The Regression Parameters enable you to select the type of fit that will be used in the 
calibration: 

1. Display the Fit Type drop-down list and then select the required option. 

 The options are Linear, Quadratic, Cubic and User Defined. 

2. For Linear, Quadratic and Cubic fits, select Force through zero if you want to force 
the fit through the origin. 

 OR 

 For the User Defined fit, enter appropriate values for the a0, a1, a2 and a3 
coefficients. 

Additional Information 

After setting the parameters, the method must be calibrated before it is used to perform a 
Prediction. See Calibrating a Method. 

You can set up the default parameters that will be applied to new methods using the 
Algorithm Defaults option. New methods created using the Beer’s Law algorithm will use the 
parameters defined on the Setup Algorithm Defaults tab. 
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PCR+ Algorithm Parameters 

If PCR+ is selected as the Algorithm, you need to set up the appropriate parameters on the 
PCR+ tab. 

X-Scaling 

There are three options: 

• Mean - the mean spectrum of the standards is subtracted from each standard 

• Auto - in addition to mean scaling, each standard is divided by the standard 
deviation spectrum of the standard, so that all wavelengths have equal weighting 

• Off - no X-scaling is applied  

Number of Principal Components 

Enter the maximum number of factors that will be calculated to model the variation in the 
dataset, or use the default value. 
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PLS1 Algorithm Parameters 

If PLS1 is selected as the Algorithm, you need to set up the appropriate parameters on the 
PLS1 tab. 

X-Scaling 

There are two options: 

• Mean - the mean spectrum of the standards is subtracted from each standard 

• Auto - in addition to mean scaling, each standard is divided by the standard 
deviation spectrum of the standard, so that all wavelengths have equal weighting 

Y-Scaling 

There are two options: 

• Mean - the mean value of each property is subtracted from the respective property 
values of the standards  

• Auto - in addition to mean scaling, each property value is divided by the standard 
deviation of the property values 

Number of Latent Variables 

Enter the maximum number of factors that will be used to model the property and correlated 
spectral variation in the standards, or use the default value. 
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QuantC Algorithm Parameters 

If QuantC is selected as the Algorithm, you need to set up the appropriate parameters on the 
QuantC tab. 

Baseline Components 

In QuantC methods, you can choose to apply additional baseline components which are then 
used together with the standards to generate a fit to the sample spectrum.  

NOTE: These additional components are separate from the Baseline Correction pre-
processing settings applied to the standard and sample spectra. 

The options available are:  

• None - no additional baseline components are added to the method.  

• Offset - a horizontal baseline is added to the method to offset any vertical variation 
in the baseline. 

• Slope - a linearly sloping baseline spectrum and a horizontal offset spectrum are 
added to the method. 

• Curve - a parabolic baseline spectrum, a linearly sloping baseline spectrum and a 
horizontal offset spectrum are all added to the method. 

Auto Weighting 

QuantC has its own weighting correction which uses both the standards and the sample to 
find the minimum transmittance value, and then reduces the influence of that area 
accordingly. 

 Check the Auto Weighting checkbox if you want to use this weighting in your 
method. 

 This will override the weighting factors set up in Pre-Processing.  
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Calibrating a Method 

Before a Quant method is used for a prediction, it must be calibrated. 

NOTE: Methods that use the QuantC algorithm do not require calibration. 

Calibrating a Method 

1. Open the method you wish to calibrate. 

 If the method contains versions, select the name of the version that you want to 
calibrate in the Method Explorer. 

2. Select Calibrate from the Action menu. 

 OR 

 Click  on the Action bar. 

 If the method has not previously been saved, the Method Save As dialog is displayed; 
refer to Saving a Method.  

 The method is calibrated and the Review tab is displayed. During the calibration a 
progress bar is displayed. When the calibration is complete, the graphs and report 
are generated for each property in the method. 

 If you have Spectrum Quant ES and have selected Auto save method on 
calibration on the Setup Method Options tab, then you may be prompted to enter 
an electronic signature for the Quant - Save Method signature point. 

NOTE: If the calibrate option is not available, either the method has been calibrated already 
or is not valid. Refer to the Model Information on the Summary tab to check the 
Method Valid status and the Calibration Completed status. 

Additional Information 

After calibration, save the method to save the results of the calibration; refer to Saving a 
Method. 

You can set up the software to automatically save a new version after calibration; refer to 
Setup Method Options. 
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Saving a Method 

Methods created or modified in Spectrum Quant will be saved in the QMD format. 

Save 

Use the Save command to save a method to the current location using the current filename. 

 Select Save from the File menu. 

 OR 

 Press CTRL+S. 

 The method is saved using the current name. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Save Method signature point. 

 If the method has not been saved before, the Method Save As dialog is displayed. 

Save As 

Use the Save As command to specify a new Method Name and file Location. 

1. Select Save As from the File menu. 

The Method Save As dialog is displayed. 

2. Type the Method Name. 

3. Select a save Location from the drop-down list. 

Browse Opens the Browse for Folder dialog. Navigate to and open the folder where you 
want to save the method. 

Private The Private folder location is specific to the user:  
For Windows 7/8: C:\ProgramData\PerkinElmer\Quant\Users\<User 
name>\methods  
For Windows XP: C:\Documents and Settings\All Users\Application 
Data\PerkinElmer\Quant\Users\<User name>\methods  

Public The Public folder is visible to all users and was specified during installation of 
Spectrum software. The default location is C:\pel_data\Quant\Methods  

The path selected is displayed below the Location field. The default location is 
Private. 

4. Click OK to save the Method. 

Save Method Without Spectra 

Use the Save Method Without Spectra command to save your method without including the 
calibration or validation spectra. 

 Select Save Method Without Spectra from the File menu. 

 The current method is saved using the current name without including any spectra. It 
can still be validated with new samples and used for predictions. 

NOTE: The existing method file is overwritten. 



Getting Started - Building a New Method . 49 

Additional Information 

You can set up the software to automatically save a new version after calibration; refer to 
Setup Method Options. For more information on creating and managing versions, see Method 
Versioning. 

When a method has been saved, it can no longer be renamed. To give your method a new 
name, use the Save As command. In Spectrum Quant ES, once a method has been Approved 
it cannot be modified. To save changes you must use Save As to create a new version of the 
method. The new method will have the Method Status Unlocked. 
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Exit and Save Options 

To Exit Spectrum Quant: 

1. Select Exit from the File menu.  

 OR 

 Click Close (X) at the top right of the Spectrum Quant window. 

 If you have a method with unsaved changes, the Save Method Changes or Save 
Version Changes dialog is displayed. 

2. Select Yes to save the changes to the method and close Spectrum Quant.  

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Save Method signature point. 

 OR 

 Select No to close Spectrum Quant without saving the changes. 

 OR 

Select Cancel to return to Spectrum Quant. 
 
 



Working with Methods 
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Working with Methods 

Before you can use Spectrum Quant to predict the properties in a mixture, you need to build 
and calibrate a new method using a set of standard spectra. Method Versioning enables you 
to save multiple versions of the calibration. 

The Spectrum Quant Method contains a list of the standard spectra and the concentration 
values for each property in the spectra. When you build a method, you also define the 
parameters that you are going to use for the prediction: which baseline correction, if any, 
you are going to use, which regions of the spectra you are going to use, etc. 

When the method has been calibrated, you can then perform an Independent Validation by 
predicting samples of known concentration using the calibration.  

Refer to the following topics for more information on working with methods: 

Opening and Editing a Method 

Cross Validation 

Review 

Independent Validation 

Method Versioning 

Additional Information 

If you have Spectrum Quant ES, refer to the following topics for information on reviewing or 
approving locked methods: 

Locking/Unlocking Methods 

Reviewing/Approving Methods 
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Opening a Method 

Files created in Spectrum Quant have the file extension QMD. You can open legacy files 
created in other PerkinElmer quantification packages, such as PerkinElmer Spectrum Beer’s 
Law. The file formats that you can open will depend upon the Algorithms you have 
purchased. 

If you have Spectrum Quant ES, a signature may be required to open the file when you open 
an unregistered method (that is, a method created in Spectrum Quant Standard, in any other 
PerkinElmer software application or in another Spectrum Quant ES database). Once a 
method has been opened, it will be registered to the database. 

1. Select Open from the File menu, or press CTRL+O. 

 The Open dialog is displayed. 

2. Select the Method you want to open. 

3. Click Open. 

 The method opens. 

 If a method is already open in the software that has unsaved changes, you will be 
prompted to save the changes before the new method is opened. If you have 
Spectrum Quant ES, you may be prompted to enter an electronic signature for the 
Quant - Save Method signature point. 

4. Click on the appropriate option in the Method Explorer to display the parameters you 
want to change. 

5. Make the required changes on the corresponding tab in the Viewing Area. 

NOTE: In Spectrum Quant Standard, a method can be opened and edited at any time.  
In Spectrum Quant ES, a locked method (Method Status Locked, Reviewed or 
Approved) cannot be modified. A Locked or Reviewed method must be unlocked by a 
user with the appropriate permissions first. An Approved method cannot be modified. 
Alternatively, save the locked method under a new name. The Method Status will 
revert to Unlocked. 

6. Save the Method. 

Additional Information 

You can also open a method from the Method Browser tab. 

If you open a method that contains versions when Use versioning is disabled, a message 
will be displayed asking if you want versions to be enabled for the method. If you select Yes, 
then versioning will be enabled for all methods. If you select No, then versioning will be 
enabled for that method only. 

For more details on managing method versions, refer to Method Versioning. 
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Method Versioning 

Method versioning enables you to manage different versions of the same method. Versions 
can be edited at any time. 

You can define the version of the method that will be used to perform a prediction using the 
Quant process in Spectrum software. Refer to Defining the default version. The currently 
active (selected) version is used to perform a prediction in Spectrum Quant.  

To enable versioning, the Use versioning option must be selected on the Setup Method 
Options tab. This will automatically enable the Create Version option in the File menu. The 
method name in the Method Explorer will be replaced by the version name. 

Selecting a Version 

 Select the version name in the Method Explorer. 

 The method shortcuts for the version will be displayed in the Method Explorer. 

NOTE: If the previously selected version contained unsaved changes, you will be prompted 
to save them. 

Creating a New Version 

When you create a new method version it will be based on the version currently selected in 
the Method Explorer. 

1. Select a version of the method in the Method Explorer. 

2. Select Create version from the File menu. 

 A new version with the name Version n + 1 will be created. Any unsaved changes to 
the previous version will be saved. 

Managing Method Versions 

Renaming a version 

1. In the Method Explorer, click the right mouse button on the name of the version you 
want to rename. 

 A shortcut menu is displayed. 

2. Select Rename. 

 The Rename Version dialog is displayed. 

3. Type a New name for the version. 

4. Click OK. 

 The version name is updated in the Method Explorer. 

NOTE: This will not change the name of the method, only the version. To change the name 
of an unsaved method, edit the method name on the Summary tab of Version 1 of 
the method. To change the name of a method that has been saved, use the Save As 
option from the File menu. 
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Deleting a version 

1. In the Method Explorer, click the right mouse button on the name of the version you 
want to delete. 

 A shortcut menu is displayed. 

2. Select Delete. 

3. When prompted, click Yes to delete the version. 

 The version is deleted from the method. 

Defining the default version 

The name of the current default version is displayed in bold in the Method Explorer. The 
default version is used for predictions using the Quant process in Spectrum software. 

1. Save the version that you want to set as the default. 

2. In the Method Explorer, click the right mouse button on the name of the version you 
want to set as the default. 

 A shortcut menu is displayed. 

3. Select Set As Default. 

 The name of the new default version is displayed in bold in the Method Explorer. 

NOTE: In Spectrum Quant ES, when a method containing versions is Approved, only the 
default version is retained. Any other versions are removed. 

Additional Information 

Information about the status of the method version is displayed in the Method Explorer: 

• An asterisk (*) indicates that a version has been edited but not yet saved. 

• The name of the default version is displayed in bold. 

A maximum number of 32 versions can be created for a method. If you reach the maximum, 
save the method under a new file name, and then delete some versions of the method. 

Removing versioning 

If you disable the Use versioning option on the Setup Method Options tab, a warning 
message will be displayed. All the versions of the method, except for the default version, will 
be removed. 
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Cross Validation  

The Cross Validation option on the Standards tab of the method enables you to perform an 
approximation of an independent validation using only the data in the calibration set. This is 
done by removing one or more standards from the calibration and then predicting that 
standard against the calibration, and repeating until each standard, or group of standards, 
has been left out once. Unlike Independent Validation, Cross Validation affects the outcome 
of the method calibration. 

The results of the Cross Validation are plotted on the Review tab.  

The options are: 

• Leave 1 Out: Removes each standard in turn from the calibration set, performs the 
calibration, and then predicts the removed standard using that calibration. 

• K Fold: Allows you to define a number of groups, or blocks, of standards. The Cross 
Validation excludes each block in turn from the calibration, performs the calibration, 
and then predicts these blocks against the calibration. 

NOTE: If any spectra are Excluded, they will be omitted from both the Cross Validation and 
the Calibration. 

If you select K Fold, you will be prompted to select the Number of Blocks and the Pattern 
by which standards are grouped. When you have set up the blocks, the Cross Validation 
Pattern column is added to the Standards table. 

Three types of patterns can be defined: 

• Block: The standards are grouped in blocks. 

 For example, if you have 12 standards and the Number of Blocks is set to 3 then the 
Cross Validation Pattern column will have standards numbered 1 to 3 in blocks (1, 1, 
1, 1, 2, 2, 2, 2, 3, 3, 3, 3) 

• Sequence: The standards are grouped in sequence. 

 For example, if you have 12 standards and the Number of Blocks is set to 3 then the 
Cross Validation Pattern column will have standards numbered 1 to 3 in sequence (1, 
2, 3, 1 ,2, 3, ...) 

• Random: The standards are grouped randomly. 

 For example, if you have 12 standards and the Number of Blocks is set to 3 then the 
Cross Validation Pattern column will have standards numbered randomly 1 to 3 (for 
example, 1, 2, 1, 3, 2, 2, 1, 1, 2, ...) 

NOTE: You can edit the block number of each standard to any allowed value. An excluded 
spectrum is assigned the number 0. 
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Review 

Review enables you to review the calibration data after a method has been calibrated. 

 Select Review in the Method Explorer. 

 The Review tabs are displayed in the Viewing Area. 

 For further details of the review options, see Additional Information. 

Reviewing a Calibration 

If your model contains more than one Property or component, or your standards have more 
than one Classification defined, then you can select which to view using the drop-down 
lists at the top of the Viewing Area. 

The color of the data points in the graphs will be updated for the Classification selected. If no 
Classification is included in the model, the data points will be displayed in the default color. 

Maximizing Graphs and Reports 

If your view contains more than one graph or report and you want to review one in more 
detail, then you can maximize it to fill the Viewing Area: 

 Click the  icon at the top-right of the graph or report you want to minimize. 

To restore the window and display the other windows in the view: 

 Click the  icon at the top-right of the window displayed in the Viewing Area. 

Using the Review Graphs 

Excluding a Standard 

You can use graphs which plot values for the standards used in the calibration to exclude 
standards that do not appear to fit the model. 

1. Place the mouse pointer over the data point for the standard you want to exclude, 
and right-click. 

2. Select Exclude from the menu that is displayed. 

 The standard is excluded from the model and the model is automatically recalibrated. 

You can include the standard once again by unchecking the Exclude checkbox in the 
Standards table and then recalibrating. 

Hiding Standard Names 

If you have used a large number of standards in your model, it might be difficult to see the 
data points due to the presence of the standard names. 

1. Place the mouse pointer over a data point on the graph you want to view, and right-
click. 

2. Select Hide standard names from the menu that is displayed. 

 The names are hidden from the graph. 

To show the names again, right-click on a data point and select Show standard names. 
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Adding a New User-defined View 

1. Click on the tab labeled “+”. 

 The Review Setup dialog is displayed. 

2. Type a name for the new view in the View Name field. 

3. Type a description in the View Description field. 

4. Select an item in the Select Graphs and Reports window and then click >> to add 
it to the list of Selected Graphs and Reports. 

NOTE: Click  to expand a group of options. 

 If you want to remove an item from the Selected Graphs and Reports, select it in the 
list and then click <<. 

5. Click on the item in the list of Selected Graphs and Reports and then use the Up and 
Down buttons to move it to the desired position in the list. 

6. Select the number of rows and columns from the drop-down lists to give the 
Windows Layout you want. 

 The maximum number of rows or columns is 5, but the available options will depend 
on the number of items you have added to the view. The numbers displayed in the 
Windows Layout correspond to the numbers in the list of Selected Graphs and 
Reports. 

7. When you have finished defining the view, click OK. 

 The new view tab is added to the Viewing Area. 

Managing Views 

Deleting a view 

NOTE: You must have a minimum of one view in the method. If you have only one view 
defined, Delete View will not be available. 

1. Display the tab for the view you want to delete. 

2. Click the  icon on the top-right corner of the Viewing Area. 

3. Select Delete View. 

4. Click Yes on the Delete View confirmation dialog. 

 The view is removed from the list. 

Modifying a view 

1. Display the tab for the view you want to modify. 

2. Click the  icon on the top-right corner of the Viewing Area. 

3. Select Modify View. 

 The Review Setup dialog is displayed. 

4. Make the necessary modifications to the view as described in Adding a New User 
Defined View. 

5. Click OK. 
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Adding a view to the default views 

You can setup default views that can be applied to new methods created using the same 
algorithm on the Setup Calibration Review tab for the algorithm. 

To add a view created in a method to the list of defaults: 

1. Display the tab for the view you want to add to the defaults. 

2. Click the  icon on the top-right corner of the Viewing Area. 

3. Select Add to Default View. 

 The selected view is added to the list of Model Review setup items. 

Additional Information 

Before reviewing a model, it must be calibrated. Refer to Calibrating a Method. 

A number of review options are available for Beer's Law and PCR+/PLS1 algorithms, and if 
you choose to use Cross Validation with the QuantC algorithm. 
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Review Options for Beer's Law Algorithm 

The following calibration graph and report options are available on the Review tab for 
methods using the Beer's Law algorithm: 

• Calibration Graph – A plot of property value against the calculated intensity 
parameter (Peak Area, Height or Max Height) selected for the algorithm. The 
Correlation, Standard Error and Standard Error of Prediction are also displayed on the 
graph. 

• Specified vs Calculated Plot – A plot of the property values as defined on the 
Standards tab against the property values calculated from the calibration graph. The 
Correlation, Standard Error and Standard Error of Prediction are also displayed on the 
graph. 

• Residual Plot – A graph showing the spread of the residuals, where a residual is the 
difference between the specified property value, as entered by the user, and the 
calculated property value from the calibration. The Correlation, Standard Error and 
Standard Error of Prediction are also displayed on the graph. 

• Cross Validation - Estimated vs Specified Plot – A graph of the specified 
property values against the property values calculated during the Cross Validation. 
The Standard Error of Prediction (SEP) is also displayed on the graph. This graph is 
not added to the review by default. 

• Cross Validation - Residuals Plot – A graph showing the spread of the residuals 
as calculated by the cross validation. This graph is not added to the review by 
default. 

• Calibration Report – The calibration report gives relevant method details and lists 
the following for each property: 

a. Method Information: including information from the Method Summary tab, 
such as Method Name and Number of Standards. 

b. Property Information: including the Name of property or component 
currently displayed, Pre-Processing settings, the Peak Parameters (including 
Calculation Type: Area, Height or Max Height) and the Type of Fit (if this is 
User Defined, the coefficients used will also be displayed). 

c. Calibration Results: displays the Correlation, Standard Error, Slope and 
Intercept of the calibration graph. 

d. Standards Table: displays the Specified property values, Estimated 
(calculated) property values and residuals. 

e. Cross Validation Results (if enabled): displays the Cross Validation Type 
and the Standard Error of Prediction (SEP). 

f. Standards Table for Cross Validation (if enabled): displays the Validation 
Order, Specified property values, Estimated (calculated) property values and 
residuals. The Validation Order is the position in the Standards Table for 
Leave 1 Out, or the value in the Cross Validation Pattern column (based on 
the blocks and patters options selected for K Fold. 

• Validation Report – The validation report gives more detailed information and 
results for the various calibrations carried out by the cross validation for each 
property. This report is not added to the review by default. 
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Review Options for PCR+ and PLS1 Algorithms 

A number of different Review options are available for methods using either the PCR+ or 
PLS1 algorithms. These are organized into six tabs of default views. 

Model 

Regression Summary 

This report gives a summary of the final regression data.  

Model - SEP 

This graph enables you to view the effect of the principal components (PCs) on the Standard 
Error of Prediction (SEP) of the property.  

Model - Estimated vs Specified 

This graph enables you to decide whether a model is stable, because unstable models show 
a spread of standards around the regression line. 

Model - Outliers 

The graph displays cutoff lines on both axes. Standards exceeding the leverage cutoff 
(vertical) represent spectral outliers and should be examined in the same way as discussed 
for the Standard Leverage graph. Standards exceeding the residual cutoff (horizontal) should 
be checked to see if their concentration has been entered correctly on the Standards tab, 
and, if so, the standards should be re-analyzed to ensure that their concentrations are 
correctly known. 

Cross-Validation 

Cross Validation - Spectral Residual Ratio 

The graph enables you to see if any of the validation standards have features not modelled 
by the selected PCs. The spectral residual ratio, in this case, is the ratio of the residual 
spectral variance for the validation standard to the average residual spectral variance (noise) 
of the calibration standards. If a validation standard has a value greater than 3, it suggests 
that the validation spectrum has features not modelled by the PCs selected. The origin of 
such features can be examined by predicting the validation standard in question and 
examining the residual spectrum from the prediction. 

At the top of the Viewing Area, you can select the number of principal components (PCs) 
from which the values are calculated.  

Cross Validation - SEP 

This graph enables you to view the effect of the number of principal components (PCs) on 
the standard error of prediction (SEP) of the property, for the validation standards. Typically, 
the SEPs should have a minimum corresponding to the number of PCs to be used to model 
the property. Spectrum Quant does not necessarily choose a minimum, but searches 
backwards for the smallest number of PCs that gives an SEP not significantly different from 
the minimum. 
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Cross Validation - Estimated vs Specified 

This graph enables you to assess whether changing the number of principal components 
(PCs) will make the model more stable, because unstable models will show a spread of 
standards around the regression line. 

The graph is based on the final regression model, and enables you to select the number of 
principal components (PCs) from which the values are calculated.  

Cross Validation - Outliers 

This graph displays cutoff lines on both axes. Validation standards exceeding these cutoffs 
could bias the validation standard error of prediction (SEP) and could lead to the wrong 
number of PCs being chosen for the model. 

Cross Validation – Residuals 

This graph should show a random distribution of residuals about the 0 point of the Y-axis. 
Any structure that is evident may indicate a problem with the model.  

At the top of the Viewing Area, you can select the number of principal components (PCs) 
from which the values are calculated. 

Advanced Reports 

Regression Summary 

This report gives a summary of the final regression data. 

Calibration Report 

This is the full calibration report, which contains a number of sections: 

• Method - Full identification of the method including a summary of the calculation 
and pre-processing options selected. 

• Standards - Whether any of the standards were rejected, and the calculated values 
of the properties in the standards. 

• Eigen Analysis, Outlier Test and MLR - Statistical analysis of the calibration. For 
more information, refer to PCA Theory. 

Spectral Validation 

This report details the leverage ratio and residual ratio for each standard used in the 
validation. If you used PLS1 there is a separate report for each property; you can select 
which property to view at the top of the Viewing Area.  

Property Validation 

This report details the full statistical results for each standard for a specific property. There is 
a separate report for each property; you can select which property to view at the top of the 
Viewing Area. 
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Advanced Spectral Diagnostics 

Spectral Variance 

This graph displays a set of curves which enable you to determine the best number of 
principal components (PCs) to be used for the model. 

• X Variance – shows the cumulative amount of spctral variances (as a percentage of 
the total) versus the number of PCs. 

• Y Variance – shows the cumulative amount of property variance (as apercentage of 
the total) versus the number of PCs. 

• F-test significance – shows whether an individual PC is of a similar significance 
compared to the higher-numbered PCs pooled together. A low value shows that the 
PC is significantly different from the subsequent PCs and is likely to be caused by real 
variation in the spectral data, rather than noise. 

• Indicator – shows the Malinowski indicator function, an empirical function designed 
to show a minimum at the optimum number of PCs for describing the data. 

Standard Leverage 

This graph displays a cutoff line set by Spectrum Quant (twice the average leverage value), 
such that all standards that give results above the cutoff are standard outliers. Standards 
shown as outliers should be examined to determine the cause. The two most common 
causes of outliers are: 

• Artifacts in the data. In such cases, examination of the Spectral Leverage graph will 
identify the influential area of the spectrum, enabling you to decide whether to 
remove the standard, change the analysis data range, or select a blank region to 
cover the area. 

• Much stronger or weaker bands than the other standards. This is often seen in 
standards at an extreme of the concentration range. Usually this requires that the 
standard is removed, or that additional standards of a similar nature are added to 
minimize the influence on the calibration.  

Spectral Leverage 

This graph displays a cutoff line set by Spectrum Quant (twice the average leverage value), 
such that all variables that give values above the cutoff are outliers. 

Variable outliers are often caused by regions of high absorbance (which can be overcome by 
changing the data range or using a blank region) or individual standards with artifacts (which 
can be identified from the Standard Leverage and treated as discussed above). 

Regions of low variable leverage may be regarded as contributing only noise, and should be 
considered for blank regions.  

Scores 

There are two types of graph that can be displayed, depending on the principal component 
(PC) you select for each axis using the graph controls: 
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• The first type of graph is given when you select an X axis PC of 0 in the drop-down 
list at the top of the Viewing Area. This is a graph for one PC and shows a profile of 
the scores for that PC, enabling you to look for trends or groupings. 

• The second type of graph is given when you select a different PC for each axis. This 
graph enables you to look for adverse groupings within the model that you may want 
to separate into different models, or identify where new standards are required to 
bridge groups.  

Standard Profile 

The Standard Profile graph enables you to identify where a factor is dominant or absent in 
particular standards, enabling you to identify standard abnormalities. 

1. Click Standards at the top of the Viewing Area to display a list of the standards in 
the method.  

2. Check the checkboxes for the standards you want to display on the graph. 

Loadings 

There are two types of graph that can be displayed, depending on the principal component 
(PC) you select for each axis using the graph controls. 

• The first type of graph is given when you select an X axis PC of 0. This is a graph 
for one PC and enables you to see the important bands for that PC. 

• The second type of graph is given when you select a different PC for each axis. This 
is a graph of the factors for one PC against another and enables you to look for 
trends in the data and identify the bands responsible for those trends. 

Advanced Spectral Diagnostics 

Model - SEP 

This graph enables you to view the effect of the principal components (PCs) on the Standard 
Error of Prediction (SEP) of the property.  

Model - Estimated vs Specified 

This graph enables you to decide whether a model is stable, because unstable models show 
a spread of standards around the regression line. 

Model - Residuals 

This graph should show a random distribution of residuals about the 0 point of the Y-axis. 
Any structure that is evident may indicate a problem with the model.  

Model - Outliers 

The graph displays cutoff lines on both axes. Standards exceeding the leverage cutoff 
(vertical) represent spectral outliers and should be examined in the same way as discussed 
for the Standard Leverage graph. Standards exceeding the residual cutoff (horizontal) should 
be checked to see if their concentration has been entered correctly on the Standards tab, 
and, if so, the standards should be re-analyzed to ensure that their concentrations are 
correctly known. 
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Model - Influence 

This is a graph of the Cook’s distance (a measure of the change in regression when that 
standard is removed) versus the leverage, for each property. The graph displays cutoff lines 
on both axes, where standards exceeding a cutoff can be regarded as too influential to the 
regression. If a standard exceeds both cutoffs, the influence comes from its spectral data, 
while a standard exceeding only the Cook’s distance cutoff is influential because of its 
property value.  

Regression Spectrum 

This graph shows the regression weight for the property selected from the drop-down list at 
the top of the Viewing Area. It enables you to view the features in the data that contribute to 
the model.  

NOTE: The predicted property value is given by the vector multiplication of the regression 
spectrum for a property with the unknown. 

Advanced Cross-Validation 

Cross Validation - Leverage Ratio 

This graph enables you to look for spectral outliers in the validation standards, because a 
validation standard with a leverage ratio above 1 can be considered to be outside the 
calibration. Extreme outliers may bias the SEP value and should be removed from the 
validation. 

At the top of the Viewing Area, you can select the number of principal components (PCs) 
from which the values are calculated.  

Cross Validation - Spectral Residual Ratio 

The graph enables you to see if any of the validation standards have features not modelled 
by the selected PCs. The spectral residual ratio, in this case, is the ratio of the residual 
spectral variance for the validation standard to the average residual spectral variance (noise) 
of the calibration standards. If a validation standard has a value greater than 3, it suggests 
that the validation spectrum has features not modelled by the PCs selected. The origin of 
such features can be examined by predicting the validation standard in question and 
examining the residual spectrum from the prediction. 

At the top of the Viewing Area, you can select the number of principal components (PCs) 
from which the values are calculated.  

Cross Validation - SEP 

This graph enables you to view the effect of the number of principal components (PCs) on 
the standard error of prediction (SEP) of the property, for the validation standards. Typically, 
the SEPs should have a minimum corresponding to the number of PCs to be used to model 
the property. Spectrum Quant does not necessarily choose a minimum, but searches 
backwards for the smallest number of PCs that gives an SEP not significantly different from 
the minimum. 
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Cross Validation - Outliers 

This graph displays cutoff lines on both axes. Validation standards exceeding these cutoffs 
could bias the validation standard error of prediction (SEP) and could lead to the wrong 
number of PCs being chosen for the model. 

At the top of the Viewing Area, you can select the number of principal components (PCs) 
from which the values are calculated. 

Cross Validation - Influence 

This is a graph of the Cook’s distance (a measure of the change in regression when that 
standard is removed during full cross validation) versus the leverage ratio, for each property. 
The graph displays cutoff lines on both axes, where standards exceeding the cutoffs could 
bias the validation standard error of prediction (SEP) and could lead to the wrong number of 
PCs being chosen for the model. 

NOTE: If you have chosen to use K-fold cross validation, then this graph only shows the 
influence of each group of standards. The influence of the individual standards in that 
group may be very different from each other. 

At the top of the Viewing Area, you can select the number of principal components (PCs) 
from which the values are calculated. 

Cross Validation - Estimated vs Specified 

This graph enables you to assess whether changing the number of principal components 
(PCs) will make the model more stable, because unstable models will show a spread of 
standards around the regression line. 

The graph is based on the final regression model, and enables you to select the number of 
principal components (PCs) from which the values are calculated.  

Cross Validation – Residuals 

This graph should show a random distribution of residuals about the 0 point of the Y-axis. 
Any structure that is evident may indicate a problem with the model.  
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Review Options for QuantC Algorithm 

The curve-fitting approach used in QuantC does not involve any calibration procedure, so the 
only occasion when there is any information displayed in the Review is when Cross Validation 
is used. The options below are available and, in each case, are displayed for the property 
selected from the Property drop-down list at the top of the Viewing Area. 

Validation Report 

The validation report gives more detailed information and results of the cross validation for 
each property. 

Cross Validation - Estimated vs Specified 

This graph enables you to assess whether changing the number of principal components 
(PCs) will make the model more stable, because unstable models will show a spread of 
standards around the regression line. 

The graph is based on the final regression model, and enables you to select the number of 
principal components (PCs) from which the values are calculated. 

Cross-Validation - Residuals 

This graph should show a random distribution of residuals about the 0 point of the Y-axis. 
Any structure that is evident may indicate a problem with the model. 
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Independent Validation 

Independent Validation enables you to perform a validation using samples that are not used 
in the calibration set. This is done after the model has been calibrated.  

1. Select Independent Validation in the Method Explorer. 

 The Independent Validation tabs are displayed in the Viewing Area. 

2. Select the Samples tab, the Bias Correction tab (not available for the QuantC 
algorithm) or the appropriate Validation Review tab. 

 The Samples tab enables you to add the spectra for the validation. The Bias 
Correction tab enables you to apply a correction for the offset, or the offset and 
slope, of the Specified vs Calculated or Residuals plot. 

 The Validation Review tabs allow you to review the results of the validation. 

Running an Independent Validation 

1. Add the samples you want to include in the validation on the Samples tab. 

2. Define the graph and reports you want to display in the Independent Validation 
Review. 

3. Click Run Validation on the Samples tab. 

 OR 

 Select Run Validation from the Action menu. 

 OR 

 Click  on the Action bar. 

NOTE: If Run Validation is not available, ensure that the method is calibrated, that you have 
added spectra to the Independent Validation Samples table, and that you have 
entered property values for all the samples. 

 During the validation a progress bar is displayed. 

 When the calibration is complete, the graphs and report are generated for each 
component in the method and the Independent Validation Review tab is displayed. 

4. Review the Validation Review graphs and reports created. 

5. Select the Bias Correction tab and, if required, apply a correction for the offset or 
offset and slope. 

6. Save the method. 
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Samples 

The Samples tab in the Independent Validation enables you to select the Samples that will be 
used for the validation. These should be samples that are not used in the calibration set. 

1. Select Independent Validation in the Method Explorer.  

 The Independent Review tabs are displayed in the Viewing Area. 

2. Select the Samples tab. 

NOTE: A column selector in the top left corner of the Samples table enables you to define 
which columns are displayed by selecting the appropriate check box. 

Adding and Deleting Samples 

Adding Samples 

1. Click Add Samples. 

 The Add Spectra dialog is displayed. 

2. Select the spectra to be used for the independent validation and then click Open. 

 A row is added to the Samples table for each spectrum selected. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Open non-ES Data signature point. 

NOTE: If the Assign sample custom fields to properties and classifications dialog is 
displayed, refer to Adding Samples with custom fields. 

Adding Samples with Custom Fields 

If your spectra have Custom Fields associated with them, you can assign a Property column 
for the Custom Field. If you do not want to include data in a Custom Field, you can select to 
Ignore it. 

1. Click Add Samples. 

 The Add Spectra dialog is displayed. 

2. Select the spectra to be used for the independent validation and then click Open. 

 The Assign sample custom fields to properties and classifications dialog is displayed, 
which lists the Custom Fields for the selected spectra. The options are Property, 
Classification or Normalization (only available if a Normalization was included in 
the Calibration). If you do not want to add a column for the Custom Field to the 
Standards table, select Ignore. 

3. Select the appropriate Property / Classification Name from the drop-down list. 

 If Normalization was selected as the column Type, the Property / Classification 
Name option will be blank. 
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4. Click Accept. 

 The spectra are added to the Samples table, and the data in the custom field for the 
spectra selected is either added to the appropriate column or ignored. 

 OR 

 Click Ignore to ignore data in all Custom Fields. 

 The spectra are added to the Samples table, but any data in Custom Fields will be 
ignored. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Open non-ES Data signature point. 

Selecting Rows 

 Select, or deselect, a complete row in the table by clicking the first (left most) column 
in the row.  

 Any selected rows (or cells) are highlighted. 

 To select a block of rows, hold down the SHIFT key and click the first column in the 
first row and last rows, or click and drag up or down the table. 

 To select a row, or deselect a row leaving the others selected, hold down the CTRL 
key as you click the rows. 

Selecting Columns 

 Select, or deselect, a complete column in the table by clicking the column header.  

 Any selected cells are highlighted. 

Removing Samples 

1. Select the samples that you want to remove. 

2. Click Remove Samples. 

 The Remove Samples dialog is displayed. 

3. Click Yes. 

 The selected samples are removed from the Samples table. 

Using the Spectral View 

Adding Spectra to the Spectral View 

To display spectra in the Spectral View you need to select the appropriate rows in the 
Samples table: 

 Select, or deselect, a complete row in the table by clicking the first (left most) column 
in the row.  

 Any selected rows (or cells) are highlighted. 

 To select a block of rows, hold down the SHIFT key and click the first column in the 
first row and last rows, or click and drag up or down the table. 

 To select or deselect a row, leaving the others selected, hold down CTRL as you click 
the rows. 
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The Spectrum Browser 

The Spectral View includes a table, or spectrum browser, that enables you to select which 
curves you want to work with (for example, when rescaling spectra using the Autorange 
options). The names of the selected spectra are marked by a , and are drawn in full color; 
any unselected curves are not marked and are drawn dimmed. 

 To select a curve in the spectrum browser, click its name. 

 OR 

 Hover your mouse over the curve, right-click and then choose Select Only This 
Curve. 

 The curve is selected, and all other files deselected. 

 To select a block of curves, hold down the SHIFT key and click the first and the last 
name in the block. 

 To select or deselect a curve, leaving the others selected, hold down the CTRL key as 
you click the name of the curve. 

 To select all the curves in the Spectral View, press CTRL+A. 

NOTE: You can hide the spectrum browser by selecting Hide Information Pane on the 
Advanced tab of the Graph Properties dialog. 

Using the Property vs Property Graph 

The Property vs Property plot enables you to view the correlation between different 
properties in the Standards table. By default, the plot displays the Index vs the first property 
in the Standards table. 

Select the property of interest from the Y Axis drop-down list, and then select the required 
option for display from the X Axis drop-down list. You can select Index, Ordered or any 
property defined in the Standards table. 

Selecting Index plots the standards in the order they appear in the Standards table (1, 2, 3, 
etc.) against the value of the property selected for the Y axis. 

Selecting Ordered plots the standards in order of increasing value of the property selected 
for the Y axis against the value of that property. 

Selecting a property for display on the X axis plots the value of that property against the 
value of the property selected for the Y axis. 

Additional Information 

Any spectra added to the Independent Validation table are stored in the method when the 
method is saved. To view the properties of a spectrum saved in the method, or add a 
comment to a spectrum, see Status. 

To export a spectrum from a method as a binary (*.sp) or ASCII (*.asc) file, see Saving 
Spectra from the Spectral View. 
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Independent Validation Review 

The Independent Validation Review tabs enable you to review the validation data. 

 Select Independent Validation in the Method Explorer.  

 The Independent Review tabs are displayed in the Viewing Area. 

 The content of the Review tab depends upon the algorithm selected in your method. 
See Additional Information for further details. 

Reviewing a Validation 

If your model contains more than one Property or component, then you can select which to 
view using the drop-down list at the top of the Viewing Area. 

Maximizing Graphs and Reports 

If your view contains more than one graph or report and you want to review one in more 
detail, then you can maximize it to fill the Viewing Area: 

 Click the  icon at the top-right of the graph or report you want to minimize. 

To restore the window and display the other windows in the view: 

 Click the  icon at the top-right of the window displayed in the Viewing Area. 

Adding a New User Defined View 

1. Click on the tab labeled “+”. 

 The Review Setup dialog is displayed. 

2. Type a name for the new view in the View Name field. 

3. Type a description in the View Description field. 

4. Select an item in the Select Graphs and Reports window and then click >> to add 
it to the list of Selected Graphs and Reports. 

NOTE: Click  to expand a group of options. 

 If you want to remove an item from the Selected Graphs and Reports, select it in the 
list and then click <<. 

5. Click on the item in the list of Selected Graphs and Reports and then use the Up and 
Down buttons to move it to the desired position in the list. 

6. Select the number of rows and columns from the drop-down lists to give the 
Windows Layout you want. 

 The maximum number of rows or columns is 3, but the available options will depend 
on the number of items you have added to the view. The numbers displayed in the 
Windows Layout correspond to the numbers in the list of Selected Graphs and 
Reports. 

7. When you have finished defining the view, click OK. 

 The new view tab is added to the Viewing Area. 
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Managing Views 

Deleting a view 

NOTE: You must have a minimum of one view in the method. If you have only one view 
defined, Delete View will not be available. 

1. Display the tab for the view you want to delete. 

2. Click the  icon on the top-right corner of the Viewing Area. 

3. Select Delete View. 

4. Click Yes on the Delete View confirmation dialog. 

 The view is removed from the list. 

Modifying a view 

1. Display the tab for the view you want to modify. 

2. Click the  icon on the top-right corner of the Viewing Area. 

3. Select Modify View. 

 The Review Setup dialog is displayed. 

4. Make the necessary modifications to the view as described in Adding a New User 
Defined View. 

5. Click OK. 

Adding a view to the default views 

You can save a view set up in a method to the list of default views for the algorithm type. 
Refer to the Setup Independent Validation Review tab. 

To add a view created in a method to the list of defaults: 

1. Display the tab for the view you want to add to the defaults. 

2. Click the  icon on the top-right corner of the Viewing Area. 

3. Select Add to Default View. 

 The selected view is added to the list of on the Setup Independent Validation Review 
tab for the algorithm. 

Additional Information 

Review Options for Beer’s Law Algorithm 

The following graph and report options are available on the Independent Validation Review 
tabs for the Beer’s Law Algorithm: 

• Residual Plot – A graph showing the spread of the residuals, where a residual is the 
difference between the specified property value, as entered by the user, and the 
calculated property value from the calibration. The Standard Error of Prediction 
(SEP) for the property selected is also displayed on the graph. 

• Specified vs Calculated Plot – A plot of the property values entered for the 
validation samples against the property values calculated from the calibration graph. 
The Standard Error of Prediction (SEP) for the property selected is also displayed on 
the graph. 
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• Calibration Report – The calibration report gives relevant method details and lists 
the following for each component: 

– Method Information: including information from the Method Summary tab, 
such as Method Name and Number of Independent Validation Samples. 

– Independent Validation Summary: displays the Standard Error of Prediction 
(SEP). 

– Bias Correction Results: displays the Offset and the Offset and Slope values. 

– Independent Validation Details: displays the Specified property values, 
Estimated (calculated) property values and residual values. 

Review Options for PCR+/PLS1 Algorithms 

The following graph and report options are available on the Independent Validation Review 
tab for PCR+ and PLS1 algorithms: 

• Leverage Ratio – This graph enables you to look for spectral outliers in the 
validation standards, because a validation standard with a leverage ratio above 1 can 
be considered to be outside the calibration. Extreme outliers may bias the SEP value 
and should be removed from the validation.  
At the top of the Viewing Area, you can select the number of principal components 
(PCs) from which the values are calculated. 

• Spectral Residual Ratio – The graph enables you to see if any of the validation 
standards have features not modelled by the selected PCs. The spectral residual 
ratio, in this case, is the ratio of the residual spectral variance for the validation 
standard to the average residual spectral variance (noise) of the calibration 
standards. If a validation standard has a value greater than 3, it suggests that the 
validation spectrum has features not modeled by the PCs selected. The origin of such 
features can be examined by predicting the validation standard in question and 
examining the residual spectrum from the prediction. 
At the top of the Viewing Area, you can select the number of principal components 
(PCs) from which the values are calculated. 

• Validation - SEP – This graph enables you to view the effect of the number of 
principal components (PCs) on the standard error of prediction (SEP) of the property, 
for the validation standards. Typically, the SEPs should have a minimum 
corresponding to the number of PCs to be used to model the property. Spectrum 
Quant does not necessarily choose a minimum, but searches backwards for the 
smallest number of PCs that gives an SEP not significantly different from the 
minimum. 

• Validation - Residuals – This graph should show a random distribution of residuals 
about the 0 point of the Y-axis. Any structure that is evident may indicate a problem 
with the model. 

• Validation - Outliers – This graph displays cutoff lines on both axes. Validation 
standards exceeding these cutoffs could bias the validation standard error of 
prediction (SEP) and could lead to the wrong number of PCs being chosen for the 
model. 
At the top of the Viewing Area, you can select the number of principal components 
(PCs) from which the values are calculated. 
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• Validation - Influence – This is a graph of the Cook’s distance (a measure of the 
change in regression when that standard is removed during full cross validation) 
versus the leverage ratio, for each property. The graph displays cutoff lines on both 
axes, where standards exceeding the cutoffs could bias the validation standard error 
of prediction (SEP) and could lead to the wrong number of PCs being chosen for the 
model. 

• Validation - Estimated vs Specified – This graph enables you to assess whether 
changing the number of principal components (PCs) will make the model more stable, 
because unstable models will show a spread of standards around the regression line. 
The graph is based on the final regression model, and enables you to select the 
number of principal components (PCs) from which the values are calculated.  

• Spectral Validation Report – This report details the leverage ratio and residual 
ratio for each standard used in the validation. If you used PLS1 there is a separate 
report for each property; choose Property in the report control box to select the 
required report.  

• Property Validation Report – This report details the full statistical results for each 
standard, for each property (there is a separate report for each property). 

Review Options for QuantC Algorithm 

The following graph and report options are available on the Independent Validation Review 
tab for the QuantC algorithm: 

• Validation - Estimated vs Specified – This graph enables you to assess whether 
changing the number of principal components (PCs) will make the model more stable, 
because unstable models will show a spread of standards around the regression line. 
The graph is based on the final regression model, and enables you to select the 
number of principal components (PCs) from which the values are calculated.  

• Validation - Residuals – This graph should show a random distribution of residuals 
about the 0 point of the Y-axis. Any structure that is evident may indicate a problem 
with the model. 

• Property Validation Report – This report details the full statistical results for each 
standard, for each property (there is a separate report for each property). 
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Bias Correction 

Bias correction should be used when there is some systematic difference between the 
spectra of the standards used in the calibration and the spectra used for independent 
validation. For example, if a method calibrated on one instrument is used to predict 
validation samples measured using a different instrument, the predicted property values may 
be in error, but have a straight line relationship to the true values. Bias correction enables 
you to apply a correction for the offset, or the offset and the slope, of this line. 

To determine whether there is a bias in the offset or slope of independent validation 
standards: 

1. Select Independent Validation in the Method Explorer.  

 The Independent Review tabs are displayed in the Viewing Area. 

2. Set up and run the Independent Validation. 

3. Review the Independent Validation Review graphs and reports. 

4. On the Validation Specified vs Calculated graph look for an obvious offset or slope to 
the line. 

5. On the Residuals plot look for a significant offset or slope in the residual values. 

6. Select the Bias Correction tab. 

7. Select the component of interest in the Property drop-down list. 

8. Select Validation Specified vs Calculated or Residual in the View Options. 

9. Observe the effect of selecting None, Offset or Slope and Offset in the Apply Bias 
Correction section. 

10. When you have determined and selected the appropriate option, save the method. 

When the calibration is used to perform a prediction, the Bias Correction will be applied. 

NOTE: If you use the Spectrum Quant method in Spectrum software, you will need to select 
the Bias Correction option on the Setup Quant Methods tab in Spectrum. This option 
will only be available if Bias Correction has been configured and saved as part of the 
method in Spectrum Quant. 
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Setting Model Factors 

Once a method is calibrated, you can choose to change the number of factors (PCs) used in 
the calibration and perform a recalculation. You can use the SEP graph to view the effect of 
changing the number of factors on the accuracy of the model. The optimum number of 
factors normally corresponds to the minimum in the SEP graph. This number should be as 
low as possible to give a robust model. 

You may also choose to change the number of factors after performing an Independent 
Validation of the model and comparing the calculated number of factors in the validation 
from the number used by the calibration. 

NOTE: The Set Model Factors option is only available for the PCR+ algorithm.  

1. Select Set Model Factors from the Action menu. 

OR 

Click  on the Action toolbar. 

The Set Model Factors dialog is displayed. This displays the SEP graph for each 
property generated by the calibration, with a vertical marker showing the current 
number of factors. If you have included Cross-Validation and Independent Validation 
in the method, then the corresponding SEP graphs from these processes are also 
displayed. 

2. Click the row in the table below the graphs for the property whose factors you want 
to modify. 

3. Click the Number of Factors in Model table entry and enter the new number of 
factors to be used. 

OR 

Click and drag the vertical cursor in the graph view to the new number of factors. 

A second vertical marker is displayed to show the new number of factors that will be 
used to recalculate the calibration. 

4. Once all the properties have been modified as required, click Set Factors.  

The method calibration is re-calculated, and the Review graphs and reports are 
updated. The reduced model in the Calibration Report now shows the results for the 
new number of factors. 
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Predicting a Spectrum 

Once a method has been calibrated it can be used to predict the properties of interest in a 
sample. 

1. Select Prediction in the Method Explorer. 

 The Samples and Control Limits tabs are displayed. If a prediction has been run 
against any of the samples, a Results tab will also be displayed. 

2. Add the samples you want to predict to the table on the Samples tab. 

3. Set the optional control limits on the Control Limits tab. 

 The Control Limits tab enables you to set prediction limits for each property in your 
Quant method. The prediction results will flag results above the High Value or below 
the Low Value entered. 

4. Select Predict from the Action menu. 

 OR 

 Click Predict on the Samples tab. 

 OR 

 Click  on the Action bar. 

 During the prediction a progress bar is displayed. After the prediction is completed, 
the Results tab is displayed, or updated. 
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Samples 

The Samples tab enables you to manage the spectra to be used for prediction. 

1. Select Prediction in the Method Explorer.  

 The Prediction tabs are displayed in the Viewing Area. 

2. Select the Samples tab. 

NOTE: A column selector in the top left corner of the Samples table enables you to define 
which columns are displayed by selecting the appropriate check box. 

Adding Samples 

1. Click Add Samples. 

 The Add Spectra dialog is displayed. 

2. Select the spectra you want to predict, and then click Open. 

 A row is added to the Samples table for each spectrum selected. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Open non-ES Data signature point. 

Adding Samples with Custom Fields (Normalized Models only) 

If your calibration contained a Normalization field, you can assign custom fields in your 
sample spectra to the Normalization column. 

1. Click Add Samples. 

 The Add Spectra dialog is displayed. 

2. Select the spectra to be used for the prediction and then click Open. 

 The Assign sample custom fields to properties and classifications dialog is displayed, 
which lists the Custom Fields for the selected spectra. 

3. If you want to assign values in a custom field to the Normalization column, select 
Normalization from the Type drop-down list. If not, select Ignore. 

4. Click Accept. 

 The spectra will be added to the Samples table, and the data in the custom field for 
the spectra selected will be added to the Normalization column or ignored. 

 OR 

 To ignore data in all custom fields, click Ignore. 

 The spectra will be added to the Samples table, but any data in custom fields will be 
ignored. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Open non-ES Data signature point.  

Selecting Rows 

 Select, or deselect, a complete row in the table by clicking the first (left most) column 
in the row.  

 Any selected rows (or cells) are highlighted. 

 To select a block of rows, hold down the SHIFT key and click the first column in the 
first row and last rows, or click and drag up or down the table. 
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 To select a row, or deselect a row leaving the others selected, hold down the CTRL 
key as you click the rows. 

Removing Samples 

1. Select the samples that you want to remove. 

2. Click Remove Samples. 

 The Remove Samples dialog is displayed. 

3. Click Yes. 

 The selected samples are removed from the Samples table. 

Predicting Samples 

 Click Predict on the Samples tab. 

 OR 

 Select Predict from the Action menu. 

 During the prediction progress bar is displayed. When the prediction is complete the 
Results tab is displayed. 

NOTE: If Predict is not available, you may already have results for all the spectra listed in 
the table. If you want to repeat the prediction for the existing sample, you will need 
to clear the results. If you add further spectra to the table, and run the prediction, 
these will be added to the existing results. 

Clearing Results 

To clear any existing results before running a new prediction: 

 Click Clear Results to remove the results of a prediction. 

 The results will be cleared and the Results tab will be hidden. 

Using the Spectral View 

Adding Spectra to the Spectral View 

To display spectra in the Spectral View you need to select the appropriate rows in the 
Samples table: 

 Select, or deselect, a complete row in the table by clicking the first (left most) column 
in the row.  

 Any selected rows (or cells) are highlighted. 

 To select a block of rows, hold down the SHIFT key and click the first column in the 
first row and last rows, or click and drag up or down the table. 

 To select or deselect a row, leaving the others selected, hold down CTRL as you click 
the rows. 

The Spectrum Browser 

The Spectral View includes a table, or spectrum browser, that enables you to select which 
curves you want to work with (for example, when rescaling spectra using the Autorange 
options). The names of the selected spectra are marked by a , and are drawn in full color; 
any unselected curves are not marked and are drawn dimmed. 
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 To select a curve in the spectrum browser, click its name. 

 OR 

 Hover your mouse over the curve, right-click and then choose Select Only This 
Curve. 

 The curve is selected, and all other files deselected. 

 To select a block of curves, hold down the SHIFT key and click the first and the last 
name in the block. 

 To select or deselect a curve, leaving the others selected, hold down the CTRL key as 
you click the name of the curve. 

 To select all the curves in the Spectral View, press CTRL+A. 

NOTE: You can hide the spectrum browser by selecting Hide Information Pane on the 
Advanced tab of the Graph Properties dialog. 

Additional Information 

Any spectra added to the Samples table are stored in the method when the method is saved. 
To view the properties of a spectrum saved in the method, see Status. 

To export a spectrum from a method as a binary (*.sp) or ASCII (*.asc) file, see Saving 
Spectra from the Spectral View. 
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Control Limits 

The Control Limits tab enables you to set prediction limits for each property in your Quant 
method. The prediction results will flag results above the High Value or below the Low Value 
entered. 

NOTE: Control Limits are optional, and are active only within Spectrum Quant. They are not 
available when running predictions in Spectrum software. 

The Property column in the Control Limits table lists all the properties defined in the 
Standards table. 

The Standard deviation and Mean values for each property, obtained when the method was 
calibrated, are also displayed in the table.  

Defining Control Limits 

1. Type the required lower limit for each property in the Low Value column. 

2. Type the text you want to be displayed in the Results when the predicted value is 
lower than the Low Value in the Low Message column. 

3. Type the required upper limit for each property in the High Value column. 

4. Type the text you want to be displayed in the Results when the predicted value for a 
property is higher than the High Value in the High Message column. 

5. Ensure that the Enable option is selected for each property to which you want to 
apply control limits. 

Additional Information 

When the prediction is run, the Results tab lists the prediction results for each sample. 
Details for each result are tabulated in the upper right quadrant of the Results tab. If the 
property value lies within the control limits, it is highlighted in Green. If the property value 
exceeds a control limit, the appropriate message is displayed, highlighted in Red. 



Predicting a Spectrum . 85 

Results 

The Results tab lists the prediction results for each sample. 

• The Quant Results for each sample are tabulated in the upper left quadrant of the 
Results tab. 

 This table lists the Sample Name and the value of each property. 

• The Details for each result are tabulated in the upper right quadrant of the Results 
tab. 

 The parameters listed depend on the algorithm being used in the method. See 
Additional Information for further details. 

 If a property value exceeds a control limit, then the appropriate message is also 
displayed, highlighted in Red. 

Additional Information 

Prediction Results for Beer’s Law Methods 

The Details table lists each property value, the Normalization (pathlength), and the prediction 
error for the property. 

 

Prediction Results for PCR and PLS Methods 

The Details table lists the following parameters: 

• Property Value 

• Property Prediction Error 

• M-Distance for each property 

 This is expressed as a ratio; the M-distance is calculated using only those scores used 
for the property P: 

 M-distance ratio =  

 where: 

 np
f is the number of factors used to model the property. 

  

 p   denotes using only factors relevant to modelling the property p. 

 Hence: 

 Tp   is the scores matrix for the calibration excluding rows not relevant to property p.  

• RMS Error 

 The root mean square (RMS) of error gives an overall indication of the quality of 
reproduction of the observed spectrum based upon the factors up to the compression 
point only: 
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 z = û – u 

 where u is an unknown spectrum and û is the spectrum produced from the factors 
up to the cutoff point.  

  

 The RMS should be in the order of the standard deviation of the noise in the 
spectrum.  

• Peak-to-Peak Error 

 The peak-to-peak error gives an indication of localized anomalies (for example, 
spikes) in the observed spectrum: 

  P/P   =   max (u – û) — min (u – û) 

 As a general rule, the peak-to-peak error should be no more than about five times 
the RMS error if the residuals consist of only random noise. Larger values indicate 
either features in the predicted sample that were not present in the calibration set, or 
features that were in the calibration set but were excluded because of the factor 
compression cutoff point.  

• Total M-Distance ratio 

 This is derived from the Mahalanobis statistic, Du
2, for the unknown sample 

spectrum. The number displayed is the ratio of the calculated M-distance for the 
sample divided by the cutoff value. In the calculation of Du

2, all factors up to and 
including the factor selection cutoff point are included: 

 M-distance ratio =  

 where: 

 nf  is the number of factors. 

 ns is the number of standards. 

 Du
2 = ( tu – t )T  Λ-1( tu – t )  

 Λ is the variance-covariance matrix of the scores of the calibration standards, that is, 

  

 tu are the scores for the unknown spectrum, u. 

 T is the matrix of scores for the calibration set. 

 t is the vector of mean scores for each factor for the calibration set. 

 T is the matrix of mean scores for each factor, that is, the ith column of T is set to ti. 

 For centered data, because t = 0 , and the scores are orthogonal, Du
2 reduces to: 

 . 

 Further, if the scores are orthonormal (S t2
ii =1), then the M-distance is simply the 

sum of the squares of the scores. 
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NOTE: A sample for which the total M-distance ratio is >1 might be considered outside the 
range of the calibration set.  

• Residual Ratio  

 This is defined as the ratio of the variance of the errors between the unknown 
spectrum and its calculated spectrum (reproduced from factors up to the cutoff point) 
and the average spectral variance not modeled at the calibration stage. For PCR+ this 
average spectral variance is given by the sum of the error eigenvalues. 

     ( u – û )T ·   ( u – û ) ns 

 FSR  =    

residual spectral variance of calibration 
spectra 

 which for PCR+  

 where: 

 u is an unknown spectrum. 

 û is the spectrum produced from the factors up to the cutoff point. 

 A suggested F-test would be F (α ; (nv – nf ) / 2, (nv –  nf) (ns –  nf – 1) /2), but 
because nv is usually very large, then for α = 0.95 the F-value would always be close 
to 1. As an approximation, an F-test of F (α; 1, (ns – nf  – 1)) could be used. As a 
general rule, an F-value greater than 3 for an unknown sample should indicate a 
significant outlier. 

 

Prediction Results for QuantC Methods 

The Details table lists the following parameters: 

• RMS Error  

 The Root Mean Square error of prediction is a measure of the average error 
(standard deviation) associated with the residual spectrum. This value should be 
comparable to the noise level in the unknown spectrum. 

• Peak-to-Peak Error  

 The peak-to-peak error represents the maximum range of deviation between the 
original (unknown) spectrum and the calculated spectrum (maximum residual - 
minimum residual). Typically, this value should be of the order of five times the RMS 
error. A high peak-to-peak error is indicative of a feature in the unknown sample 
spectrum that is not modelled by QuantC. In such circumstances, we advise you to 
view the residual spectrum to determine the origin of the unmodelled feature. 

• F-Value  

 The F-value summarizes the model-to-noise spectral variance as described by 
analysis of variance (ANOVA). High F-values correspond to the unknown sample 
being well-modelled by the standards. If one of the standards is used as an 
unknown, QuantC produces a perfect fit from the data and the F-value is infinite.  
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• % Variance (R squared) 

 The percentage variance summarizes the amount of spectral variance of the 
unknown that is described by the standards. If the unknown is one of the standards, 
this is 100%.  

• Property Value 

• Property Prediction Error 

Three spectra are also displayed in the Viewing Area: the sample spectrum, the calculated 
spectrum produced by the QuantC algorithm, and the residual spectrum. 

 

 



Publishing Results 
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Publishing Results 

These topics describe the editing and printing options that enable you to publish your results. 

You can: 

• Use the Send To command on the File menu to send your results to, if Microsoft® 
Word is installed, a Microsoft® Word document.  

• Review a Print Preview and Print. 

• Export the prediction results to a CSV file. 

• Use the Report command on the File menu to output a report. 

• Copy and Paste from the currently displayed tab in the Viewing Area to another 
location. 

Additional Information 

You can export spectra from the method as binary (*.sp) or ASCII (*.asc) files. 
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Print and Print Preview 

Print 

Use the Print command in the File menu to print a pre-formatted version of the contents of 
the Viewing Area. 

This dialog also enables you to select a specific Printer and its Properties dialog. 

Alternatively, if you want to print a graph display, right-click in the graph and then select 
Print. 

If you have Spectrum Quant ES, you may be prompted to enter an electronic signature for 
the Quant - Print signature point. 

Print Preview 

Use the Print Preview option in the File menu to view the output before you print the 
document using the current printer settings. The Print Preview dialog enables you to: 

• Review a multi-page document. 

• Amend the Page Setup, which includes the page Size, Orientation and Margins. 

• Zoom in to a particular area of the document, and to use a Snapshot tool to select 
and copy a detail from the document to the Clipboard as a Windows metafile. 

If you have Spectrum Quant ES, you may be prompted to enter an electronic signature for 
the Quant - Print signature point when you select to print the document.  
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Exporting Results 

Use the Export Result command to save your prediction results to a specified folder as data 
files that are accessible to other applications. 

1. Select Export Results from the Action menu.  

 The Save As dialog opens. 

2. If necessary, browse to another (or create a new) folder for the exported file. 

3. Type a File name for your results file. 

4. Click Save. 

 The prediction results are exported into a CSV file with the file name specified, 
located in the selected folder. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Export Results to CSV signature point.  
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Exporting Reports 

Use the Report option from the File Menu to generate a report of the method. 

1. Select Report from the File menu.  

 The Report dialog opens. 

2. Select Save Report if you wish to save the report and/or Print Report to print the 
report to the currently active printer. 

NOTE: Save Report or Print Report must be enabled for the reporting options to be 
available. 

3. Select the Report format from the drop-down list.  

 In Spectrum Quant Standard the options are rich text format (*.rtf) and portable 
document format (*.pdf).  

 In Spectrum Quant ES the available format is secured portable document format 
(*.spdf). 

4. If necessary, browse to another (or create a new) folder for the generated report. 

5. If required, browse to specify the folder location for your report logo.  

 The logo image file can be in BMP, JPG or GIF formats. 

6. Select the sections to be included in the report from the Section Name list, which 
are derived from the template.  

 The options available are Method Information, Standards, PreProcess, 
Algorithm, Review, Independent Validation and Prediction. 

 If you have Spectrum Quant ES, you can also select to include the Signature 
Information for the method in the report. 

7. Click Report. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Report signature point. 

 The report is generated. 

 The filename generated for saved reports is derived from the Method Name. Each 
time a report file is generated, a number is appended to the name. No output will be 
produced if the file cannot be created. 

 If you select a section but there is no relevant data, a section with the appropriate 
heading will be added to the report, but it will be empty. 

Additional Information 

Select Export Results from the Action menu to export the prediction results into a CSV file. 
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Opening an ES Report 

Use the Open ES Report command on the File menu to open a secure (checksummed) 
report file in Spectrum Quant ES. 

1. Select Open ES Report from the File menu, or press CTRL+T. 

 The Open Secured Report File dialog is displayed. By default, all the secured PDF 
report files (*.spdf) in the C:\ pel_data\reports folder are displayed. 

2. Click the filename of the report you want to open. 

 The file is selected, and all other files deselected. 

3. Click Open. 

 A PDF file is created in the reports folder, opened and displayed in the default 
application for PDF files. The *SPDF file remains unchanged. 
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Send To Word 

Use the Send To Word command to copy the contents of the Viewing Area into an editable 
document. 

1. Select the appropriate option in the Method Explorer and display the tab in the 
Viewing Area that contains the results or curves that you want to send. 

2. If the tab contains curves, format and label them until you are happy with their 
presentation.  

 All your labels will be copied. If you send to a Word document your labels are placed 
in text boxes. 

3. Select Send To from the File menu, then Word.  

 If Microsoft® Word™ is installed, the Word option copies into a native Word (*.doc 
or *.docx) file. 

 Your results are copied into the selected document. 

4. Complete and publish your document. 

Additional Information 

The current date is included in your document. 

When you send a Spectral View display the contents of the spectrum browser are included in 
your document, which acts as a key to the graphic. If you do not want this (non-editable) 
information to be included, hide the spectrum browser before sending: 

1. Right-click in the Spectral View, and then select Properties. 

 The Graph Properties dialog is displayed. 

2. Select the Advanced tab, select the Hide Information Pane option, and then click 
OK. 

 The spectrum browser is hidden. 

3. Select Send To from the File menu, then Word. 

 Your results, but not the contents of the spectrum browser, are copied into the 
selected document. 

4. Restore the Spectral View by clearing the Hide Information Pane check box. 
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Copying and Pasting 

Use the Copy (CTRL+C) keyboard shortcut to place information on the Windows Clipboard, 
and the Paste (CTRL+V) keyboard shortcut to paste information from the Clipboard into 
another location. 

The behavior of these keyboard shortcuts depends on the type of information that you are 
copying and pasting. If the keyboard shortcut is not enabled, you may be able to right-click 
and select a command. 

NOTE: If you have Microsoft® Word™, you can manage the clipboard using the Office 
Clipboard task pane. In Word 2003, select Office Clipboard from the Edit menu. In 
Word 2007, click the Clipboard dialog launcher in the Clipboard group on the Home 
tab. 

Copying Data 

Summary tab Selected 

To copy the data from a panel: 

 Right-click in a panel and then select Copy. 

 Ensure that you have not selected any particular parameter or value. 

 OR 

 Press CTRL+C. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Copy to Clipboard signature point. 

 Fields within rows are copied as tab-delimited text. Items on different rows are 
separated by line breaks. 

Graph Selected 

To copy the graph display, including all labels and curves, whether selected in the spectrum 
browser or not: 

 Right-click in the graph window and then select Copy to Clipboard. 

 The graph display is copied as a Windows metafile. You can paste spectra only into 
Windows applications that support metafiles. 

NOTE: The CTRL+C shortcut is not enabled. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Copy to Clipboard signature point. 
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Standards or Samples Table Selected   

To copy a selected field as ASCII text, or the contents of a selected row or column or 
selected cells: 

 Right-click and then select Copy. 

 OR 

 Press CTRL+C. 

 Fields within rows are copied as tab-delimited text. Items on different rows are 
separated by line breaks. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Copy to Clipboard signature point. 

Calibration Report Selected 

To copy a selected field as ASCII text, or the contents of a selected row or column or 
selected cells, from a panel in the Calibration report: 

1. Select the cells, rows or columns you want to copy. 

2. Right-click and then select Copy.  

 OR 

 Press CTRL+C. 

 Fields within rows are copied as tab-delimited text. Items on different rows are 
separated by line breaks. 

 If you have Spectrum Quant ES, you may be prompted to enter an electronic 
signature for the Quant - Copy to Clipboard signature point. 

Pasting Data into the Standards or Samples Table 

You can paste data from an external application, such as Microsoft® Excel™ or Microsoft® 
Word™, into the Standards or Samples tables. 

1. Select and copy the data you want to paste. 

 In the Standards or Samples table, select the first cell where you want to paste the 
data. 

2. Right-click and then select Paste.  

 OR 

 Press CTRL+V. 

 The data is copied to the table. 
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Configuring Default Parameters 

The items on the Setup menu (and on the Setup section of the Navigation Pane) enable you 
to define the default parameters that will be applied when a new method is created. 

The default parameters you can configure are: 

• Model Review – enables you to set up default views for the calibration model Review. 

• Independent Validation Review – enables you to set up default views for the 
Independent Validation Review. 

• Algorithm Defaults – enables you to set the default algorithm parameters for each 
algorithm. You can also define which algorithm will be selected by default when a 
new method is created. 

• Classifications – enables you to set up Classifications and Classes that can be used to 
group your standards. 

• Method Options – enables you to set up versioning and auto-save options. 

• Pre-Processing – enables you to select the pre-processing steps to be applied to your 
spectra, with their respective settings. 

Additional Information 

Provided you are logged into Spectrum Quant as an Administrator, from the Administration 
sub-menu of the Setup menu you can also: 

• Administer the login names and passwords (if required) for each Spectrum Quant 
user. 

In Spectrum Quant ES the Administration sub-menu of the Setup menu also enables you to: 

• Add new Groups and set the permissions for each group (except Administrators). 

• Define the operations in the software that require a Signature from a pre-defined list. 

• Administer the Users Audit Trail. 

Spectrum Quant uses the same security database as Spectrum software. For full details of 
how to set up new users and groups (ES only), refer to the Spectrum on-screen help. 
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Administration 

Each person using Spectrum Quant must be set up as a user by a person who has permission 
to perform administration tasks. 

Spectrum Quant 

Spectrum Quant utilizes two pre-defined groups, namely the Administrators group and the 
Users group. The user Administrator (a member of the group Administrators) is pre-defined. 

Spectrum Quant uses the same security database as Spectrum software. For full details of 
how to set up new users, refer to the Spectrum on-screen help.  

Spectrum Quant Enhanced Security 

Spectrum Quant ES uses the same security database as Spectrum ES software. Spectrum 
Quant ES utilizes four pre-defined groups: Administrators, Users, Reviewers and Approvers. 
The user Administrator (a member of the group Administrators) is pre-defined. 

Each user is a member of one or more groups. The actions a user can perform depend on 
the permissions for the group(s). For full details of how to set up new users, refer to the 
Spectrum on-screen help. 

The Users Audit Trail records all changes to security settings in compliance with 21 CFR 
Part 11. All changes to users, groups and password settings are recorded. It also records 
when the Login History or the Users Audit Trail have been exported and cleared. For full 
details of how to use the Users Audit Trail, refer to the Spectrum on-screen help. 
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Setup Model Review 

The Setup Calibration Review tab enables you to set up default views for the model Review. 
A view is a collection of diagnostic graphs and reports showing information about the quality 
of the calibration model. A Default View is available for each algorithm, but you can modify 
this or add a new view. 

 Select Model Review from the Setup menu. 

 OR 

 Select  in the Setup section of the Navigation Pane. 

 The Setup Calibration Review tabs for the available algorithms are displayed in the 
Dialog Pane. 

NOTE: To see the tab, you may have to resize the Dialog Pane. 

Adding Views 

1. Click Add. 

 The Add View dialog is displayed. 

2. Type a name for the new view in the View Name field. 

3. Type a description in the View Description field. 

4. Select an item in the Select Graphs and Reports window and then click >> to add 
it to the list of Selected Graphs and Reports. 

NOTE: Click  to expand a group of options. 

 If you want to remove an item from the Selected Graphs and Reports, select it in the 
list and then click <<. 

5. Click on the item in the list of Selected Graphs and Reports and then use the Up and 
Down buttons to move it to the desired position in the list. 

6. Select the numbers of rows and columns from the drop-down lists to give the 
Windows Layout you want. 

 The maximum number of rows or columns is 5, but the available options will depend 
on the number of items you have added to the view. The numbers displayed in the 
Windows Layout correspond to the numbers in the list of Selected Graphs and 
Reports. 

7. When you have finished defining the view, click OK. 

 The new view is added to the list on the Setup Calibration Review tab with a 
Summary of the items added. 

 When you create a new method using the algorithm the views listed will be available 
in the Review. 
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Deleting Views 

1. Select the view you want to delete. 

2. Click Delete. 

3. Click Yes on the Delete View confirmation dialog. 

 The view is removed from the list. 

 If you delete a view from the Setup Calibration Review tab, the view will not be 
deleted from the Review of any existing method. 

Modifying Views 

1. Select the view you want to modify. 

2. Click Modify. 

 The Modify View dialog is displayed. 

3. Make the necessary modifications to the view. 

 See Adding Views for details of the options available. 

4. Click OK. 

 The changes are saved to the view and the Summary is updated on the Setup 
Calibration Review tab. 

Restoring the Default View 

 Click Restore Default to delete all views except the default. 

 If the default view has been modified it will revert to the original settings. 

Additional Information 

For details of the graphs and reports available, refer to Review. 
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Setup Independent Validation Review 

The Setup Validation Review tab enables you to set up the default views for the Independent 
Validation Review. A Default View is available for each algorithm, but you can modify this or 
add a new view. 

 Select Independent Validation Review from the Setup menu. 

 OR 

 Select  in the Setup section of the Navigation Pane. 

 The Setup Validation Review tabs for the available algorithms are displayed in the 
Dialog Pane. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 

Adding Views 

1. Select the Setup Validation Review tab for the algorithm you want to set up. 

2. Click Add. 

 The Add View dialog is displayed. 

3. Type a name for the new view in the View Name field. 

4. Type a description in the View Description field. 

5. Select an item in the Select Graphs and Reports window and then click >> to add 
it to the list of Selected Graphs and Reports. 

NOTE: Click  to expand a group of options. 

 If you want to remove an item from the Selected Graphs and Reports, select it in the 
list and then click <<. 

6. Click on the item in the list of Selected Graphs and Reports and then use the Up and 
Down buttons to move it to the desired position in the list. 

7. Select the numbers of rows and columns from the drop-down lists to give the 
Windows Layout you want. 

 The maximum number of rows or columns is 3, but the available options will depend 
on the number of items you have added to the view. The numbers displayed in the 
Windows Layout correspond to the numbers in the list of Selected Graphs and 
Reports. 

8. When you have finished defining the view, click OK. 

 The new view is added to the list on the Setup Validation Review tab with a Summary 
of the items added. 

 When you create a new method using the algorithm the views listed will be available 
in the Independent Validation. 
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Deleting Views 

1. Select the view you want to delete. 

2. Click Remove. 

3. Click Yes on the Delete Independent Validation View confirmation dialog. 

 The view is removed from the list. 

 If you delete a view from the Setup Validation Review tab, the view will not be 
deleted from the Review of any Method already defined. 

Modifying Views 

1. Select the View you want to modify. 

2. Click Modify. 

 The Modify View dialog is displayed. 

3. Make the necessary modifications to the view. 

 See Adding Views for details of the options available. 

4. Click OK. 

 The changes are saved to the View and the Summary is updated. 

Restoring the Default View 

 Click Restore Defaults to delete all views except the default. 

 If the default view has been modified it will revert to the original settings. 

Additional Information 

For details of the graphs and reports available, refer to Independent Validation Review. 



106 . Spectrum Quant User's Guide 

Setup Algorithm Defaults 

The Setup Default Algorithm tab enables you to define the default Algorithm for all new 
methods. 

The Setup Defaults tab for each Algorithm type enables you to set the default Peak 
Parameters and Regression parameters that will be added to methods created using that 
algorithm. 

 Select Algorithm Defaults from the Setup menu. 

 OR 

  

 Select  in the Setup section of the Navigation Pane. 

 The Setup Defaults tabs are displayed in the Dialog Pane. 

NOTE: To see the tab, you may have to resize the Dialog Pane. 

Setup Default Algorithm 

 Select the Algorithm from the drop-down list that you want to set as the default for 
all new methods. 

NOTE: The Algorithms available will depend on the options you have purchased. 

Setup Algorithm Defaults 

For details on how to set the parameters on the Setup Beer’s Law Algorithm tab, refer to 
Beer’s Law Algorithm Parameters. 

For details on how to set the parameters on the Setup PLS1 Algorithm tab, refer to PLS1 
Algorithm Parameters. 

For details on how to set the parameters on the Setup PCR+ Algorithm tab, refer to PCR+ 
Algorithm Parameters. 

For details on how to set the parameters on the Setup QuantC tab, refer to QuantC Algorithm 
Parameters. 
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Setup Classifications 

The Setup Classifications tab enables you to pre-define Classifications for use in your models. 

Classifications are used to group standard spectral files. For example, you might want to 
easily distinguish between standard samples by source location, supplier, batch number or 
date of collection. Each Classification can have a number of Classes, each assigned a color.  

 Select Classifications from the Setup menu. 

 OR 

 Select  in the Setup section of the Navigation Pane. 

 The Setup Classifications tab is displayed in the Dialog Pane. 

NOTE: To see the tab, you may have to resize the Dialog Pane. 

Adding Classifications 

1. Click Add Classification. 

 The Add Classification dialog is displayed. 

2. Type the Name and Description of the Classification. 

3. Click OK. 

 A row is added to the table for the Classification. You can now set up the Classes for 
that Classification in the sub-table. You can add any number of Classes to a 
Classification. 

4. Select the field marked by * and then type the name of the Class. 

 A color is automatically assigned to the class. 

5. If you want to change the default color, select the drop-down arrow at the end of the 
Color field to display the color palette and select a new color. 

6. Repeat Steps 4–5 until you have added all the Classes required to your Classification. 

Removing Classifications 

 Select the row for the Classification to be deleted and then click Delete 
Classification. 

NOTE: Deleting a Classification setup will not delete the Classification from any existing 
methods. 

Deleting a Class from a Classification 

 Select the row for the Class to be deleted and then press the DELETE key on the 
keyboard. 

NOTE: Changes made to a Classification setup will not be applied to any existing methods. 

Additional Information 

Classifications are assigned to calibration standards on the Standards tab. When a 
Classification setup has been applied to a Method it can be customized for that Method. 
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Setup Method Options 

The Setup Method Options tab has options for enabling method versioning and auto-saving. 

 Select Method Options from the Setup menu. 

 OR 

 Select  in the Setup section of the Navigation Pane. 

 The Setup Method Options tab is displayed in the Dialog Pane. 

NOTE: To see the tab, you may have to resize the Dialog Pane. 

Method Options 

 Select the Auto save method on calibration option to save the method 
automatically after calibration. 

Versioning Options 

Versioning enables you to manage different versions of the same method. 

To use versioning: 

1. Select Use versioning. 

2. If you want a new version to be created every time the method is calibrated, select 
the Generate new version on calibration option. 

Additional Information 

Generate new version on calibration will automatically save a new version when the 
method is calibrated. However, if Use versioning is enabled, Create Version will also be 
available on the File menu. This enables you to save the current version and create a new 
version at any time. 

For details on how to manage method versions, refer to Method Versioning. 

To learn more about public and private folders, and save locations, refer to Saving a Method. 
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Setup Pre-Processing 

The Setup Default Algorithm option enables you to define the default pre-processing steps to 
be applied for all new methods (providing that they are supported by the selected algorithm). 

The Setup tab for each step enables you to configure the default options and settings for 
each new method. 

 Select Pre-Processing from the Setup menu. 

 OR 

 Select  in the Setup section of the Navigation Pane. 

 The tabs for setting up the default pre-processing steps are displayed in the Dialog 
Pane. 

NOTE: To see the tabs, you may have to resize the Dialog Pane. 

Setup Summary 

 Check the checkboxes for the Pre-Processing Steps that you want to apply to all 
new methods. 

 The current settings are summarized in the description column. 

NOTE: A step will only be applied if it is supported by the selected algorithm. 

Setup Range 

For details on how to set the parameters on the Setup Range tab, refer to Range. 

Setup Weighting 

For details of how to set the parameters on the Setup Weighting tab, refer to Weighting. 

Setup Normalization 

For details of how to set the parameters on the Setup Normalization tab, refer to 
Normalization. 

Setup Baseline Correction 

For details of how to set the parameters on the Setup Baseline Correction tab, refer to 
Baseline Correction. 
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Viewing Spectra 
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Viewing Spectra 

A spectrum is a set of data that can be displayed on a graph. In Spectrum Quant, the term 
spectrum also includes interferograms, chromatograms, and time drives. The filename of a 
spectrum is displayed in the Information Pane at the bottom of the graph window. 

 

These topics describe how to format your spectra and results so that they are presented as 
clearly as possible:  

Optimizing the Viewing Area 

Optimizing Graphs 

Autorange X, Y, XY 

Previous Range 

Select Only This Curve 

Formatting a Graph 

Graph Labels 

Labeling Graphs using the Vertical Cursor 

Horizontal Cursor 

Autoscale Y 

Optimize 

Overlay/Split 

Status 

Panning, Zooming and Offsetting Spectra 

Range Markers 

Absorbance 

Transmission 
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Optimizing the Viewing Area 

When you are working in the Viewing Area, right-click in a clear area to display a shortcut 
menu containing a selection of useful commands:  

Previous Range 

Full Scale 

Vertical Cursor 

Horizontal Cursor 

Split Display 

Set Anchor Point 

Add Text 

Add Range Marker 

Add Bitmap Image 

Print 

Copy to Clipboard 

Properties 

Additional Information 

If you right-click on a particular curve, a shortcut menu containing a different selection of 
useful commands is displayed. 
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Optimizing Graphs 

When you are working in the Viewing Area, right-click on a curve to display a shortcut menu 
containing a selection of useful commands:  

Set Anchor Point     

Select Only This Curve     

Label This Point     

Label Peaks   

Save As Binary     

Save As ASC     

Remove Curve   

Status     

Appearance     
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Autorange 

Use the Autorange X, Autorange Y, and Full Range commands to rescale the axes so 
that your selected spectra fill the graph, making their features easier to see. 

Autorange X 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Ensure that the spectra you want to rescale are selected in the spectrum browser. 

4. Select Autorange X from the View menu, or click Auto X on the Graph bar. 

 The Y range stays the same, but the X range is set to the Start and End data points 
of the selected spectra. 

Autorange Y 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Ensure that the spectra you want to rescale are selected in the spectrum browser. 

4. Select Autorange Y from the View menu, or click Auto Y on the Graph bar. 

 The X range stays the same, but the Y range is set to the minimum and maximum of 
the displayed region of selected spectra. 

Full Range 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Ensure that the spectra you want to rescale are selected in  in the spectrum browser. 

4. Select Full Range from the View menu, or click Auto XY on the Graph bar. 

 The X range is set to the Start and End data points, and the Y range is set to the 
minimum and maximum, of the selected spectra. 

Additional Information 

Use the Previous Range command to undo the Autorange X command or Autorange Y 
command. Use the Previous Range command twice to undo the Autorange XY command: 
once to undo the Y component and once again to undo the X component. 

Use the Autoscale Y command to rescale every feature in your spectrum. 

Use the Optimize command to rescale every feature in your spectrum, excluding any noise 
spikes or unwanted peaks from atmospheric CO2 or water vapor. 

Use Cancel Offset command to fit any offset spectra on to the graph. 
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Previous Range 

Use the Previous Range command to undo a command that changes the X or Y range 
displayed by the graph. The range may have been changed by zooming using a grow box, or 
by using the Autorange X, Autorange Y or Full Range (Auto XY) commands. 

 Select Previous Range from the View menu. 

 OR 

 Right-click in a clear area of your graph and then select Previous Range. 

 The graph is redisplayed. 

If you have applied a series of commands that affect the ranges displayed, you can use the 
Previous Range command to undo them one by one. 

NOTE: To undo the Full Range (Auto XY) command, use the Previous Range command 
twice; once to undo the X component and once again to undo the Y component. 
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Saving Spectra from the Spectral View 

You can save a curve from the Spectral View in either binary (*.sp) or ASCII (*.asc) format 
using shortcut menu commands. This method enables you to save the file with any filename 
to any location. 

1. Hover your mouse pointer over a curve and right-click to display a shortcut menu. 

2. Select Save as Binary or Save as ASC. 

 The Save As dialog box is displayed. 

3. Browse to the location where you want the file to be saved. 

4. Type or choose a filename. 

 You do not need to include the filename extension because the extension displayed in 
the file selector is added automatically. 

5. Click Save. 
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Formatting a Graph 

Use the Graph Properties dialog to customize the graph display, or to change how the curves 
are displayed. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

 Select Format graph from the View menu, or click Format in the Graph bar. 

 The Graph Properties dialog opens at the Axes tab. 

The Graph Properties dialog has four tabs: 

• Use the General tab to apply a title and description to your graph. 

• Use the Axes tab to change the range and units applied to the X and Y axes. 

• Use the Appearance tab to enable gridlines; and to apply color to text, to line 
elements, and to the curves. 

• Use the Advanced tab to change whether, and how, data points are displayed; 
whether units or numbers are suppressed on the graph axes; the information 
associated with the curve tooltip; and the interpolation, size (line thickness), and 
style applied to the curves. 

Additional Information 

When you are customizing a graph display, perhaps prior to copying it to the clipboard or 
sending it to a Word document, you may prefer to use shortcut menus. For example: 

 To amend the X or Y axes, place the mouse pointer in a clear area of the graph, 
right-click and then select Properties. 

 The Graph Properties dialog opens at the Axes tab. 

 To change the color of a selected curve, right-click on the curve and then select 
Appearance. 

 The Graph Properties dialog opens at the Appearance tab. 
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Graph Title and Description 

Use the General tab in the Graph Properties dialog to apply or edit the title or the description 
of a curve or graph display. 

NOTE: The properties of a graph display are separate to the properties from any curve it 
contains. 

1. Select Format graph from the View menu, or click Format in the Graph bar.  

 OR 

 Right-click in the graph display and select Properties (of the graph display) or 
Appearance (of a curve). 

2. Select the General tab. 

3. Type your Title and/or Description.  

 The Title is displayed at the top center of the graph, using the font size and color 
specified on the Appearance tab. 

4. To confirm changes without closing the dialog, click Apply.  

 OR 

 To close the dialog keeping only applied changes, click Cancel. 

 OR 

 To confirm all changes and close the dialog, click OK. 
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Colors for Curves, Graph Elements and Gridlines 

Use the Appearance tab in the Graph Properties dialog to customize the color of a curve and 
of other elements in the graph display. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

1. Select Format graph from the View menu, or click Format in the Graph bar (hidden 
by default).  

 OR 

 Right-click in the graph display and select Properties (of the graph) or Appearance 
(of a curve). 

2. If it was not selected by default, select the Appearance tab.  

 The options available are: 

Enable 
Gridlines 

Select this check box if you want to see gridlines under your curves.  
You can change the color of the major and minor gridlines in the Text 
and Lines panel.  
The major and minor gridline intervals depend on the graph display. 

Text and 
Lines 

Select the element, such as the title or background that you want to 
change, and then click Color to open the Color dialog. Select a Basic 
color, or one of the Custom colors you may have defined, and then 
click OK.  
When you select a text element, the Size selector enables you to 
select a font size from the drop-down list; select Auto to revert to the 
default font size. 

Curves Select whether your changes on this tab apply to All Curves or only 
to a selected curve.  
Click Color to open the Color dialog. Select a Basic color, or one of 
the Custom colors you may have defined, and then click OK. 

3. To confirm changes without closing the dialog, click Apply.  

 OR 

 To close the dialog keeping only applied changes, click Cancel. 

 OR 

 To confirm all changes and close the dialog, click OK. 
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Range and Units for the X and Y axis 

Use the Axes tab in the Graph Properties dialog to change the range and units applied to the 
X and Y axes of a graph display. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

1. Select Format graph from the View menu, or click Format in the Graph bar (hidden 
by default).  

 OR 

 Right-click in the graph display and select Properties (of the graph) or Appearance 
(of a curve). 

2. If it was not selected by default, select the Axes tab.  

 The options available are: 

Properties 
of 

Select whether your changes on this tab apply to All Curves or only to a 
selected curve. 

Display 
Mode  
  

Select whether the graph display mode should be Overlay (where the 
curves are displayed on a common set of axes) or Split (where the 
curves are displayed on a common X axis, but separate Y axes). 

Y Axis By default the Y axis is autoranged between the largest value and the 
smallest value in all the curves present.  
This panel enables you to enter a range of your choice. If you select 
another unit, make sure that you select appropriate range values. 

X Axis By default the X axis is autoranged between the largest value and the 
smallest value in all the curves present.  
This panel enables you to enter a range of your choice, enhance the 
fingerprint region using the scale-change at 2000 cm-1 convention, if 
appropriate, and to label the X axis units. 

3. To confirm changes without closing the dialog, click Apply.  

 OR 

 To close the dialog keeping only applied changes, click Cancel. 

 OR 

 To confirm all changes and close the dialog, click OK. 

Additional Information 

2000cm-1 scale change is a particular feature of the abscissa scale that enables you to see 
peaks in the region 2000 to 450 cm-1 more clearly. It expands the abscissa scale below 
2000 cm-1 such that each scale interval on the X axis represents half the value it did above 
2000 cm-1. 
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Advanced Curve Format Settings 

Use the Advanced tab in the Graph Properties dialog to change whether, and how, data 
points are displayed; whether units or numbers are suppressed on the graph axes; the 
information associated with a curve tool tip; and the interpolation, size (line thickness), and 
style applied to curves. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

1. Select Format graph from the View menu, or click Format in the Graph bar (hidden 
by default).  

 OR 

 Right-click in the graph display and select Properties (of the graph) or Appearance 
(of a curve). 

2. Select the Advanced tab.  

 The options available are: 

Properties 
of 

Select whether your changes on this tab apply to All Curves or only 
to a selected curve. 

Hide Select one or more of Hide X Axis Units, Hide Y Axis Units, Hide 
X Axis Numbering, and Hide Y Axis Numbering to suppress the 
labels applied to the X and Y scales.  
Select Hide Information Pane to suppress the curve selector that 
would otherwise, for example, be copied to the clipboard with the 
graph display. 

Tool Tip 
Display 

Deselect one or more of these check boxes to suppress elements of 
the tooltip that appears when the mouse pointer is near a curve or 
data point. 

Points Select whether to display data points in the curve and, if so, how 
they should be marked. 

Line Select the Interpolation algorithm (Cubic, Linear, or None) applied 
to the curve joining the data points.  
Select a new Size, in pixels, from the drop-down list to amend the 
curve thickness, perhaps prior to copying the graph display to the 
clipboard or to emphasize a particular curve.  
The Style options enable you to display the curve using a solid, 
dashed, or dotted line. 
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3. To confirm changes without closing the dialog, click Apply.  

 OR 

 To close the dialog keeping only applied changes, click Cancel. 

 OR 

 To confirm all changes and close the dialog, click OK. 
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Graph Labels 

Use the Label Properties dialog to add, edit or customize labels on the graph. 

NOTE: The properties of a graph display are separate from the properties of any curve it 
contains. 

The tabs displayed in the dialog depend on which type of label you are working with: 

• Text label, which enables you to place text at any position on the graph. 

• Point label, which enables you to use your mouse pointer, or the vertical cursor, to 
label particular points on your curve(s), such as when you want to compare the 
position and/or intensities of features. 

• Bitmap label, which enables you to place an image, such as your company logo, on 
the graph display. 

Additional Information 

The graph title label and axis labels are properties of the graph format. 
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Bitmap Labels 

Use the Add Bitmap Image command to add a graphic, such as your company logo, to the 
graph display. 

1. Right-click in a clear area of the graph display and select Add Bitmap Image.  

 The Label Properties Dialog opens and displays the Bitmap tab. 

 The options available are: 

Filename Click Browse and select the BMP file that you want to apply to 
the graph. You cannot crop or resize this image within 
Spectrum Quant. 

Transparent 
Background 

Select this check box if you want the graph background color 
to replace any white areas in your image. 

2. To close the dialog keeping only applied changes, click Cancel.  

 OR 

 To confirm all changes and close the dialog, click OK. 

Additional Information 

Moving a Bitmap Image 

 Select the image, and then drag it to its correct position on the graph. 

Editing a Bitmap Image 

 Select the image, right-click and then select Properties. 

 The Label Properties dialog is displayed, as described above. 

Deleting a Bitmap Image 

 Select the image, right-click and then select Remove. 

Adding other Labels 

You can also add Text Labels and Point Labels to your graph. 
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Text Labels 

Use the Label Properties dialog to add a text label to the graph display. 

1. Select Add Text from the View menu, or click Text in the Graph toolbar.  

 OR 

 Right-click in the graph display and select Add Text. 

 The Label Properties dialog opens and displays the General tab. 

 The options available are: 

Text Type the text for the label. Use the ENTER key to enter a new line. 
The size of the label is auto-fitted to your text. 

Orientation Select whether the label text should be horizontal or vertical.  
A vertical label reads from bottom to top, which matches the Units 
label on the Y axis. 

Font Size Select the size of the label text. 
Insert Enables you to insert one or more variables into the Text field, 

including the current <Date> and <Time>. 
Draw 
Border 

Select this check box if you want a box drawn around the label. 

Color If you want to change the color of the label text and any border, click 
Color to open the Color dialog. Select a Basic color, or one of the 
Custom colors you may have defined, and then click OK.  
The label background is transparent, so the graph background shows 
through. 

2. To close the dialog keeping only applied changes, click Cancel.  

 OR 

 To confirm all changes and close the dialog, click OK. 

Additional Information 

Moving a Text Label 

 Select the graph label, and then drag it to its correct position on the graph. 

Editing a Text Label 

 Select the graph label, right-click and then select Properties. 

 The Label Properties dialog is displayed, as described above. 

Deleting a Text Label 

 Select the graph label, right-click and then select Remove. 

Adding a Bitmap Image 

You cannot paste a graphic element into a text label. However, you can place an image, such 
as your company logo, into the graph using the Add Bitmap Image command. 
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Adding other Labels 

You can also add Point labels, which label particular points on your curves.  
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Point Labels 

Use point labels to compare the position and/or intensities of features. A point label includes 
a tie-line to, and the X value of, a particular position on the curve. 

1. Select the position in the curve that you want to label, right-click and then select 
Label this Point.  

 The Label Properties Dialog opens and displays the General tab. 

 The options available are: 

Text By default, this contains <X Value>. Edit the text as needed.  
Use the ENTER key to enter a new line. The size of the label is auto-
fitted to your text. 

Orientation Select whether the label text should be horizontal or vertical.  
A vertical label reads from top to bottom, which matches the Units 
label on the Y axis. 

Font Size Select the size of the label text. 
Insert Enables you to insert one or more variables into the Text field.  

As well as the <Curve Name> and <Description> you can also insert 
X and Y values and their units. 

Draw 
Border 

Select this check box if you want a box drawn around the label. 

Color If you want to change the color of the label text and any border, click 
Color to open the Color dialog. Select a Basic color, or one of the 
Custom colors you may have defined, and then click OK. The label 
background is transparent, so the color of the graph display 
background shows through. 

2. Select the Advanced tab.  

 The options available are: 

Show Tie 
Line 

This default option draws a line between a label and the peak. 

Label 
Position 

Relative to tie point (default): Label pans as the graph is panned.  
Relative to screen: Label stays in a fixed position on the screen as the 
graph is panned. If the tie line is shown, it is redrawn automatically. 

3. To close the dialog keeping only applied changes, click Cancel.  

 OR 

 To confirm all changes and close the dialog, click OK. 

Point Labels Using the Vertical Cursor 

1. Select Vertical Cursor from the View menu, or click   in the Graph bar.  

 OR 

 Right-click in a clear area of the graph display and select Vertical Cursor. 

 The Vertical Cursor is displayed on the graph, with its position on the X axis value 
displayed at its base. 
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2. Drag the cursor line to a point of interest.  

 Position the mouse pointer over the Vertical Cursor until the mouse cursor changes to 
a double-headed arrow . Hold down the left mouse button and then move the 
mouse left or right to drag the cursor to the new position. Release the mouse button. 

3. Double-click the left mouse button.  

 A label is applied to each curve crossed by the vertical cursor. 

Additional Information 

Moving a Point Label 

 Select the label, and then drag it to its correct position on the graph. 

Editing a Point Label 

 Select the label, right-click and then select Properties. 

 The Label Properties dialog is displayed, as described above. 

Deleting a Point Label 

 Select the graph label, right-click and then select Remove. 

Removing the Vertical Cursor 

 Click  in the Graph bar. 

 OR 

 Right-click in the graph display and deselect Vertical Cursor. 

Adding other Labels 

You can also add Text Labels and Bitmap Labels to your graph. 
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Labeling Graphs using the Vertical Cursor 

Use the Vertical Cursor command to place a vertical line on the graph display that you can 
drag horizontally along the X axis. You can label the position of the cursor in your spectra at 
any point, which enables you to compare the position and/or intensities of features. 

1. Select Vertical Cursor from the View menu, or click   in the Graph bar.  

 OR 

 Right-click in the graph display and select Vertical Cursor. 

 The Vertical Cursor is displayed on the graph, with the value of its position on the X 
axis displayed at its base. 

2. Drag the cursor line to a point of interest.  

 Position the mouse pointer over the Vertical Cursor until the mouse cursor changes to 
a double-headed arrow . Hold down the left mouse button and then move the 
mouse left or right to drag the cursor to the new position. Release the mouse button. 
The X axis value is updated. 

3. Double-click the left mouse button.  

 A Point label is applied to each curve crossed by the vertical cursor. 

Additional Information 

Removing the Vertical Cursor 

 Select Vertical Cursor from the View menu. 

 OR 

 Click  in the Graph bar.  

 OR 

 Right-click in the graph display and deselect Vertical Cursor. 

Moving a Point Label 

 Select the label, and then drag it to its correct position on the graph. 

Editing a Point Label 

 Select the label, right-click and then select Properties. 

 The Label Properties dialog is displayed, as described for Point labels. 

Deleting a Point Label 

 Select the graph label, right-click and then select Remove. 

Adding other Labels   

You can also add Text labels and Bitmap labels to your graph.  
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 Label Peaks 

Use the Label Peaks command to label the peaks in your selected spectra. 

NOTE: Labels are not stored when you save your curve as a *.sp file, or preserved if you 
save your changes when you exit Spectrum Quant. 

1. Select the spectrum whose peaks you want to label. 

2. Place your mouse pointer on the spectrum whose peaks you want to label, right-click, 
and then select Label Peaks.  

Additional Information 

Clearing Peak Labels 

To remove all the peak labels from the selected spectrum: 

 Place your mouse pointer on the spectrum whose peaks you want to remove, right-
click, and then select Label Peaks. 

Moving a Peak Label 

 Select the peak label, and then drag it to its correct position on the graph. 

Deleting a Peak Label 

 Select the peak label, right-click and then select Remove. 

Adding other Labels 

You can also add Text labels, Point labels, and Bitmap labels to your graph.  
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Horizontal Cursor 

Use the Horizontal Cursor command to place a horizontal line on the graph display that you 
can drag vertically along the Y axis. 

1. Select Horizontal Cursor from the View menu, or click in the Graph bar. 

 OR 

 Right-click in the graph display and select Horizontal Cursor. 

 The Horizontal Cursor is displayed on the graph, with the value of its position on the 
Y axis displayed at its end. 

2. Drag the cursor line to a point of interest. 

 Position the mouse pointer over the Horizontal Cursor until the mouse cursor changes 
to a double-headed arrow . Hold down the left mouse button and then move the 
mouse up or down to drag the cursor to the new position. Release the mouse button. 
The Y axis value is updated. 

Additional Information 

Removing the Horizontal Cursor 

 Select Horizontal Cursor from the View menu. 

 OR 

 Click  in the Graph bar.  

 OR 

 Right-click in the graph display and deselect Horizontal Cursor. 
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Range Markers 

Use range markers to highlight regions of the spectrum. You can add multiple range markers 
to the same graph. 

1. Right-click in a clear area of the graph display, and then select Add Range Marker.  

 A pair of vertical cursors are added to the graph window, separated by a highlighted 
region the height of the graph window. The position on the X axis of the cursor is 
displayed at the base of each cursor. 

2. Drag each cursor so that the highlighted region covers the feature of interest.  

 Position the mouse pointer over the vertical cursor until the mouse cursor changes to 
a double-headed arrow . Hold down the left mouse button and then move the 
mouse left or right to drag the cursor to the new position. Release the mouse button. 
The highlighted region is expanded or contracted and the  X axis values. 

Removing Range Markers 

 Right-click on the range marker and select Remove. 

Additional Information 

You can zoom in to a region of interest using a grow box. 
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Autoscale Y 

Use the Autoscale Y command to display the selected spectra so that each spectrum fills the 
graph vertically, which enables you to compare spectra of different intensities. 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Ensure that the spectra you want to rescale are selected in the spectrum browser. 

4. Select Autoscale Y from View menu or click Autoscale Y on the Graph toolbar 
(hidden by default). 

 The selected spectra are scaled vertically, so the spectra completely fill the graph. 
The ordinate scale is removed because, the spectra are on different scales. 

Additional Information 

Removing Autoscale Y 

 Select Autoscale Y from View menu, or click Autoscale Y on the Graph toolbar. 

Offset 

Removing Autoscale Y also removes any vertical offset applied to the selected spectra. 
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Optimize 

Use the Optimize command to rescale your graph, while ignoring any large noise spikes or 
peaks from atmospheric CO2 or water vapor. 

These unwanted features can dominate the spectrum, making peaks in regions of interest 
difficult to see. 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Ensure that the spectra you want to rescale are selected in the spectrum browser. 

4. Select Optimize from the View menu.  

 The spectrum is rescaled. 

NOTE: The Optimize command changes the way your spectra are displayed in the Viewing 
Area. Your data are not changed. 

Additional Information 

Use the Autorange X command to rescale every feature in your spectrum, including any 
spikes or peaks from atmospheric CO2 or water vapor. 
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Overlay/Split 

Use the Overlay/Split command to switch between the overlay display mode and the split 
display mode when displaying two or more curves. 

Split 

Split Display mode displays each curve in its own coordinate system. It formats the graph 
such that all the spectra are autoscaled and automatically offset one above the other. Any 
spectra that are added to the graph later are also autoscaled and offset. 

Overlay 

Overlay display mode formats the graph such, that the spectra are displayed on top of each 
other, in the same coordinate system. 

In Overlay mode, you can vertically offset one spectrum from another, which may enable you 
to see its features more easily.  
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Status 

Use the Status dialog to view information about the way in which a spectrum was collected 
and, if applicable, was processed.  

1. Select the spectrum in the Spectral View. 

2. Place the mouse pointer over the curve, right-click, and then select Status. 

 The Status dialog is displayed. The Status dialog box includes a useful subset of the 
History information. 

3. Select the Sample tab and edit the Description and Comments fields as required. 

4. Select OK to save the changes and close the dialog. 
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Panning, Zooming and Offsetting Spectra 

Use the techniques and tools described in these topics to: 

• Zoom in on a region of the graph; 

• Offset a spectrum so that its features can be seen more clearly; 

• Pan a spectrum up and down or left and right. 

NOTE: These techniques only change the way the spectra are displayed; they do not modify 
the data in any way. 
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Zooming to a Region of Interest 

Use the mouse to draw a grow box in the graph. You can move and resize this grow box. 
When the box surrounds the region of interest, you can zoom in by double-clicking inside the 
grow box. The region of interest is displayed on the graph display: 

1. Position the mouse pointer at the top-left corner of the region of interest. 

2. Hold down the left mouse button and drag the mouse diagonally until the grow box 
covers the region of interest. 

3. Release the left mouse button.  

 A grow box has been drawn around the region of interest. 

4. Double-click inside the grow box.  

 The graph is zoomed to display only the region of interest. 

Additional Information 

Changing the Size of a Grow Box 

1. Position the mouse pointer on the border of the grow box.  

 The cursor changes to a two-headed arrow, for example . 

 You can resize the box diagonally by positioning the pointer at a corner, or in one 
direction only by positioning the pointer at an edge. 

2. Hold down the left mouse button and drag the mouse until the grow box is the size 
you require. 

3. Release the mouse button. 

Moving a Grow Box 

1. Position the mouse pointer inside the grow box.  

 The cursor changes to a four-headed arrow . 

2. Hold down the left mouse button and drag the grow box to the required position. 

3. Release the mouse button. 

Removing a Grow Box 

 Position the mouse pointer outside the grow box and click. 

Returning to the Previous Ranges 

 Select Previous Range from the View menu, or click on the Graph Bar (hidden 
by default). 
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Offsetting Spectra 

In Overlay mode, you can vertically offset one spectrum from another, which may enable you 
to see spectral features more easily. If you select one or more spectra, they will be offset 
relative to the other spectra. If you select all the spectra, they are panned vertically rather 
than offset. 

 Move your mouse pointer close to the Y axis and drag the vertical pan pointer to 
move the spectrum. 

 The Y range start and end values for the graph change, but the X range values do 
not. The numbers on the Y scale disappear when you introduce an offset. 

Additional Information 

Autorange Y 

When you introduce an offset, you may find that one or more spectra have moved off the 
top or bottom of the graph. 

1. Select the spectra that you want to fit on to the graph.  

 The spectra are underlined, indicating that they are selected. 

2. Select Autorange Y from the View menu or from the Graph Bar.  

 The spectra are fitted onto the graph, and the offset is maintained. 

Canceling Offsets and Restoring the Y Scale 

1. Select the spectra whose offset you want to cancel. 

2. Select Cancel Offset from the View menu.  

 Any offsets are removed from the selected spectra. 

NOTE: If spectra are removed so that the graph contains only one spectrum, any offset is 
automatically removed and the Y scale is restored. 

 



Viewing Spectra . 141 

Panning 

Moving Spectra to the Left or Right 

 Move your mouse pointer close to the X axis and drag the horizontal pan pointer left 
or right to move your spectra. 

 The X range start and end values for the graph change, but the Y range does not. 

Moving Spectra Up or Down 

 Move your mouse pointer close to the Y axis and drag the vertical pan pointer to 
move the spectra. 

 The Y range start and end values for the graph change, but the X range does not. 

NOTE: In Overlay mode, if you have one or more spectra selected from a larger number of 
spectra in the graph, the selected spectra are offset. 

Using an Anchor Point 

1. Select the spectra you want to move. 

2. Right-click in the graph and select Set Anchor Point.  

 An anchor point is placed at the position of the mouse pointer. 

3. Drag the anchor point horizontally or vertically to move the selected spectra. 

NOTE: In Overlay mode, if you have one or more spectra selected from a larger number of 
spectra in the graph, the selected spectra are offset as you drag up or down. 
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Absorbance 

Use the Absorbance process command to transform one or more spectra whose ordinate 
scale is in transmittance (%T) units to spectra whose ordinate scale is in absorbance (A) 
units. 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Select Absorbance from the View menu, or click  on the Graph bar.  

 The selected spectra are transformed and displayed with absorbance (A) units. 
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Transmittance 

Use the Transmittance process command to transform one or more spectra whose ordinate 
scale is in absorbance (A) units to spectra whose ordinate scale is in transmittance (%T) 
units. 

1. Display the spectra that you want to view in the Spectral View. 

2. Click on the Spectral View graph to select it. 

3. Select %Transmittance from the View menu, or click  on the Graph bar. 

 The selected spectra are transformed and displayed with transmittance (%T) units. 
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Audit Trail (Spectrum Quant ES only) 

Any activity carried out within Spectrum Quant ES that affects the way data or stored is 
recorded in a method Audit Trail. You can view the Audit Trail of the current method, or any 
methods saved in the database. 

Viewing the Audit Trail 

 Select Audit Trail from the Audit menu. 

 The Audit Trail dialog is displayed. 

 The dialog allows you to view the methods in the database. 

 If Show details is selected, the lower part of the dialog shows the detailed Audit 
Trail for the selected method. 

 To exit the Audit Trail dialog, click Close. 

Selecting the Methods Displayed 

You can view a filtered list of available methods and select one to view the Audit Trail. 

1. Select the appropriate filter from the Method selection drop-down list.  

 The options are Current Method, When Created, Last Modified, Locked, 
Reviewed, Approved. 

2. Select the start date and time for the list in From.  

 From allows the selection of a start date and time for the methods that will be 
displayed. So if, for example, Last modified is selected, only those methods last 
modified from, and including, the From date will be displayed. If Current Method is 
selected, From is not available. 

3. Select the maximum number of methods you want to display.  

 So if, for example, Last modified is selected, with 10 set as the maximum number of 
methods to display, only the first 10, most recently modified methods from and 
including the From date will be displayed. If Current Method is selected, Number 
of methods is not available. 

Audit Trail 

The Audit Trail area, in the lower part of the screen, shows a chronological list of activities 
carried out within the method (most recent at the top). You can select which columns to 
display in the table using the column selector in its top left corner. 

The columns are: 

• Category – provides an overview of the type of action that has been audited. For 
example, Status Change. 

• Audit – the audit entry indicates what type of setting was changed. For example, if 
Status Change is the Category, the Audit entry might be Lock, Approve, or Review. 

• Old Value – the previous value applied to the Audit entry that was changed. For 
example, the Status might have been Unlocked. 

• New Value – the value applied when the Audit entry change was made. For 
example, the Status might have been changed to Locked. 
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• Full Name – the full user name of the user that made the change. 

• User Name – the user name of the user that made the change. 

• Time and date – the date and time of the change. 

The following additional columns are relevant for Audit items that require a signature: 

• Sign point – the type of signature point, for example, Lock Quant Method. For more 
information on the signature points in Spectrum Quant ES, refer to Signing. 

• Signature – the signature of the user (this is the same as the User Name). 

• Signature (full name) – the full user name of the user (this is the same as the Full 
Name). 

• Reason – the reason given for the signature. 

• Comment – any comment added at the signature point. 

• Signature time and date – the time and date of the signature point. 

For details on setting up signature points, refer to Signatures in the Spectrum Help file. 

Saving the Audit Trail 

To save the current Audit Trail to file: 

1. Click Save.  

 A Save As dialog is displayed. 

2. Select the required destination and enter a filename.  

 The Audit Trail is exported as a CSV file that can be opened in a spread-sheet 
application, for example, in Microsoft® Excel™ . 

Printing the Audit Trail 

1. To print the Audit Trail of the currently displayed method, click Print.  

 The Print Preview dialog is displayed. 

2. Review the printed output, and then select Print from the File menu. 

Additional Information 

The Spectrum Quant ES Database has a default maximum size of 8 GB. 

The Spectrum Quant ES Audit Trail is saved to the database QuantES.mdf. The database is 
located at: 

• Windows XP – C:\Documents and Settings\All Users\ Application 
Data\PerkinElmer\Quant\QuantES.mdf 

 OR 

 Windows 7/8 – C:\ProgramData\PerkinElmer\Quant\QuantES.mdf 
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Lock/Unlock Method 

NOTE: The Lock Method or Unlock Method options are only available for Spectrum Quant 
Enhanced Security software. 

When a User has completed work on a method, it should be presented for review and/or 
approval. The method is Locked to indicate that it is ready for review and to make it visible 
to other users with Review and Approve permissions.  

Lock Method 

The Lock Method option allows the user to make a method available for review and/or 
approval by users with the appropriate permissions. 

When a method is approved, all versions except the default version are removed. For this 
reason, when a method is locked, an unlocked copy is created in the same folder with the 
name <Method Name> Copy.qmd 

To lock a method: 

1. Open the method you want to lock. 

2. If your method contains versions, ensure that the version for review and/or approval 
is set as the default. 

3. Select Lock Method from the Audit Trail menu. 

 If a signature is required for the Lock Method action, the Quant - Lock Method dialog 
is displayed. 

4. Enter the required information for the signature. 

5. Click OK. 

 The Method Copy Created dialog is displayed. This informs you that a copy of the 
method has been saved at the stated location.  

6. Click OK. 

 The Method Status is changed to Locked. The method becomes visible to users with 
Review and/or Approve permissions in the For Review/Approval folder under 
Registered Methods in the Method Browser. 

NOTE: The For Review/Approval folder is visible to users with Review and/or Approve 
permissions only. 

Unlock Method 

A locked method (Method Status Locked or Reviewed) can be unlocked by any user with the 
appropriate permission. A method cannot be unlocked once it has been approved (Method 
Status Approved). 

To unlock a method: 

1. Open the method you want to unlock. 

2. Select Unlock Method from the Audit Trail menu. 

 If a signature is required for the Unlock Method action, the Quant - Unlock Method 
dialog is displayed. 

3. Enter the required information for the signature. 
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4. Click OK. 

 The Method Status is changed to Unlocked. The Method is removed from the For 
Review/Approval folder. 

NOTE: The Review/Approval folder is visible to users with Review and/or Approve 
permissions only. 

Additional Information 

See also Reviewing and Approving a Method. 
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Signing 

The ability to formally sign at Signature Points is a function of the Enhanced Security version 
of Spectrum Quant. 

An electronic signature as defined by 21 CFR Part 11 means a computer data compilation of 
any symbol or series of symbols executed, adopted, or authorized by an individual to be the 
legally binding equivalent of the individual's handwritten signature. 

The list of Signature Points within the software is pre-defined. The Administrator is able to 
define the settings (that is, whether a signature and comment is required) for each Signature 
Point individually, or apply the same settings to all Signature Points. In addition, the 
Administrator can define a list of reasons for each Signature Point. When prompted for a 
signature, the user then selects a reason from this list. 

A Signature Point will only require a signature if Signature required is selected. Otherwise, 
the software will ignore the Signature Point and the user will not be prompted for a 
signature.  

The list of Signature Points in Spectrum Quant ES includes entries for both Spectrum ES and 
Spectrum Quant ES. Entries relating to Spectrum Quant ES cover the following actions: 

• Saving methods 

• Opening non-ES Data 

• Exporting and importing methods 

• Exporting data 

• Copying data to the clipboard 

• Generating reports 

• Printing data 

• Locking and unlocking methods 

• Approving and reviewing methods. 

Refer to Signatures in the Spectrum Help file for more information on the signature points in 
Spectrum Quant and Spectrum ES. 

Signing at a Signature Point 

NOTE: If Signature required is not selected for a signature point, you will not be 
prompted for a signature. However, if any Reasons have been set up for the 
signature point, you will still be prompted to select one. 

When a Signature Point occurs in the software that requires an action, a dialog will be 
displayed: 

1. Type your User name and Password. 

2. Select the Reason for the action from the drop-down list, if available. 

3. Type any additional information into the Comment field, if required. 

4. Click OK.  

 The details of the Signature Point will be added to the Audit Trail. 
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Additional information 

Locked methods can be reviewed or approved by users that are members of a group with the 
appropriate permissions. Refer to Reviewing and Approving for more information. 

NOTE: To perform an action, you must be a member of a group with the appropriate 
permission, as defined by the Administrator on the Groups tab. Whether or not the 
action requires a signature is defined by the Administrator on the Signatures tab. 
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Reviewing and Approving Methods 

Reviewing and Approving methods a function of the Enhanced Security version of Spectrum 
Quant and can only be performed by someone with the appropriate permissions. It is up to 
the Administrator to set the correct privileges to ensure that only the appropriate people can 
‘sign off’ data. For example, by default, members of the group Reviewers have the Quant - 
Review a Method permission and members of the group Approvers have the Quant - Approve 
a Method permission. 

We use the term ‘Review’ to mean that the person has looked at the method and has agreed 
that it is correct. This is along the lines of a peer review and any number of people can 
review data as determined by your internal procedures. 

We use the term ‘Approve’ to mean that a person with the ‘authority’ has signed off the 
method as fit-for-purpose and, again, details of who is allowed to do this should be 
documented in your internal procedures. After a method has been approved it can be moved 
to a public folder so that all users can access it. 

A method must be Locked by the user before it can be reviewed or approved. It can be 
approved without first being reviewed. 

You can enter an electronic signature using the Review or Approve option from the Audit 
menu. 

Once a method has been approved, it will be read-only. You will be able to view the method 
parameters, but no changes can be made. If the method contained multiple versions, only 
the default version is retained when the method is approved. However, when a method is 
locked a copy is automatically saved to the same folder so that you retain a copy of any 
other versions. 

Reviewing Methods 

To review a method, it must first be opened in Spectrum Quant ES. 

1. Open the For Review/Approval folder in the Method Browser. 

2. Select and open the method in Spectrum Quant. 

3. Select Review from the Audit menu.  

 The Review Method dialog is displayed. 

4. Type your User name and Password. 

5. Select the Reason for the review, if available. 

6. Type any Comment required. 

7. Click OK.  

 The method status in the Method Browser is updated to Reviewed. The method 
remains in the For Review/Approval folder with the status Reviewed. A user with 
appropriate permissions can either Unlock or Approve the method. 
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Approving Methods 

To approve a method, it must first be opened in Spectrum Quant ES. After a method has 
been approved it can be added to a public folder to make it visible to all users. 

1. Open the For Review/Approval folder in the Method Browser. 

2. Select and open the method in Spectrum Quant. 

3. Select Approve from the Audit menu.  

 The Quant - Approve Method dialog is displayed. 

4. Type your User name and Password. 

5. Select the Reason for the approval, if available. 

6. Type any Comment required. 

7. Click OK.  

 The Move Approved File dialog is displayed. 

8. Click OK to move the method to the default Public folder (where it will be visible to 
all users).  

 OR 

 Select Browse from the Location drop-down list and navigate to a folder where you 
want to move the method, and then click OK. 

 OR 

 Click Cancel to keep the method in the same location. 

 The method status is updated to Approved. It can no longer be modified. Any 
versions other than the default version have been removed. The method is added to 
the Approved Methods group. If you selected a new location for the method, it is 
moved to that folder. 

Additional information 

Once a method has been Approved it cannot be modified. To save changes you must use 
Save As to create a new version of the method. The new method will have the Method 
Status Unlocked. 
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Spectrum Quant User Interface 

These reference topics describe the elements of the Spectrum Quant user interface: 

Viewing Area 

Method Explorer 

Navigation Pane 

Dialog Pane 

Menus 

Toolbars 

Additional Information 

• The View menu includes options that enable you to select whether a toolbar is 
shown or hidden. 

• For information about showing and hiding toolbars, and locking and unlocking 
toolbars, see Showing, Hiding and Moving Toolbars. 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 

• For information about adding or removing toolbar buttons or menu items, see 
Customizing Toolbars. 
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Viewing Area 

The Viewing Area contains one or more tabs, depending on the option you have selected in 
the Method Explorer. 

For more information refer to the appropriate topics below:  

Method Summary 

Standards 

Pre-Processing 

Algorithm 

Review 

Independent Validation 

Prediction 
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Method Explorer 

The Method Explorer is to the left of the Viewing Area. Use the Method Explorer, together 
with the tabs in the Viewing Area, to set up your Quant Method and run a Quant Prediction. 

To learn more about the shortcuts displayed in the Method Explorer, click on the name: 

 

Method Name / Method Version Name 

 

Standards 

 Pre-Processing 

 

Algorithm 

 

Review 

 

Independent Validation 

 

Prediction 

Additional Information 

Information about the status of the method or method version is displayed in the Method 
Explorer: 

• A method or version that is currently being edited is indicated by *. 

• The version that has been set as the default is indicated by bold characters. 

Refer to Building a New Method and Working with Methods for more information on creating 
a method and setting up a prediction. 

Opening and Closing the Method Explorer 

 To open or close the Method Explorer, click the button at the center of the left edge 
of the Viewing Area. 

 OR 

 Select Method Explorer from the View menu. 

 To open or close the Method Explorer, Navigation and Dialog panes simultaneously, 
hold down the SHIFT key and click the button that opens or closes any of these 
panes. 

Resizing the Pane 

 Open the pane, and then drag the edge of the pane containing the button (not the 
button itself) to the width or height required. 
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Menu Bar 

The following topics describe the menus available in the Menu bar:  

File 

View 

Action 

Setup 

Audit Trail (ES only) 

Navigation 

Help 

Additional Information 

The Menu bar is placed at the top of the Spectrum Quant workspace. It cannot be turned off, 
floated or customized. 
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File Menu 

Use the File menu to create or open methods, save your method or method version, print the 
current display and generate reports. 

To learn more about a command, click on its name.  

 

New CTRL+N     

 

Open CTRL+O     

  Send To 

 

Word 
 

  

 

Save CTRL+S     

 

Save As       

 Save Method 
Without Spectra 

   

 

Create Version CTRL+Y     

 

Print Preview       

 

Print CTRL+P     

 

Report CTRL+R     

 

Open ES Report 
(ES only) 

CTRL+T     

  Recent Methods >     

 

Exit       

Additional Information 

Recent Methods enables you to select from a list of up to ten methods (which includes the 
file path) that have been opened previously. 
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View Menu 

Use the View Menu commands to modify the View. To learn more about a command, click on 
the name.  

 

Full Range       

 

Autorange X       

 

Autorange Y       

 

Previous Range       

 

Cancel Offset       

 

Format Graph       

 

Add Text       

 

Vertical Cursor       

 

Horizontal Cursor       

 

Autoscale Y       

 

Optimize       

 

Overlay/Split       

 

Absorbance       

 

%Transmittance       

  Main Toolbars > 
 

Action 

      
 

Graph 

        Customize 

 

Method Explorer       

 

Navigation Pane       

 

Dialog Pane       

Additional Information 

Viewing Graphs 

The View menu commands work on the active graph in the Viewing Area only. To make a 
graph active, click the left mouse button anywhere on the graph. The graph currently 
selected is highlighted. 

Menu items referring to how curves are displayed can also be displayed on the Graph 
toolbar. 

For more information about viewing graphs, see Optimizing Graphs. 
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Showing or Hiding Interface Elements 

Menu items referring to toolbars and panes enable you to quickly show or hide parts of the 

Spectrum Quant interface. For a toolbar,   indicates that the toolbar is visible. For the 

Method Explorer, Navigation and Dialog Panes,  indicates that the pane is open. 

You can organize your workspace by hiding a toolbar, or by showing a toolbar that had been 
hidden. 

 Click the  icon to the left of the name of the toolbar that you want to hide 

 OR 

 Click the shaded area to the left of the name of the toolbar that you want to show. 
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Action Menu 

Use the Action menu commands to calibrate a method, re-calculate a calibration using 
different settings, perform a prediction, export your prediction results or run an independent 
validation.  

 

Calibrate 

 Set Model Factors 

 

Predict 

 

Export Results 

 

Run Validation 
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Setup Menu 

Use the options on the Setup menu to define the default parameters that can be applied to 
all new methods, and to set up a login name and password (if required) for each user.  

To learn more about a command, click on its name. 

  Administration >   Setup Users 

        
Users Audit Trail 

(Spectrum Quant ES only) 

 

Model Review       

 

Independent Validation Review       

 

Algorithm Defaults       

 

Classifications       

 

Method Options       

 Pre-Processing    

Additional Information 

To view the Administration sub-menu, you must be logged in as an Administrator. 
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Audit Trail Menu (Spectrum Quant Enhanced Security Only) 

The Audit Trail menu is only available in Spectrum Quant ES. The commands available will 
depend on your permissions and the current status (for example, Locked or Unlocked) of the 
method. 

To learn more about a command, click on its name.  

 

Audit Trail 

/  Lock Method / Unlock Method 

 

Review Method 

 

Approve Method 
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Navigation Menu 

Use the Navigation Menu commands to navigate a method or method versions.  

  Method Name/Version n > 
 

Standards 

    Pre-Processing 

      
 

Algorithm 

      
 

Review 

      
 

Independent Validation 

      
 

Prediction 

  … >   … 

If versioning is enabled, a sub-menu is added for each version in the method. The active 
version is indicated by a check mark. 



Using and Customizing the User Interface . 167 

Help Menu 

These are the commands available on the Help menu. Use the Help Menu commands to find 
details about application function.  

  Contents     

  Index     

  Search     

  About     

Additional Information 

The Contents, Index and Search help commands allow you to view and search the on-
screen help. 

Use the About help command to display information about the version of Spectrum Quant 
that you are using. 
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Toolbars 

The workspace has following toolbars: 

• The Action bar. By default, this toolbar is located at the top left of the Viewing Area. 

• The Graph bar. By default, this toolbar is located at the top of the Viewing Area, to 
the right of the Action bar. 

Additional Information 

You can remove or define additional toolbars to suit your preferred manner of working. 

You can also easily customize your global and local toolbars so that they include the tools 
you need and exclude the tools you do not use. For example, you can decrease the apparent 
complexity of the application by excluding unused tools from the Graph bar. 

• The View menu includes options that enable you to select whether a toolbar is shown 

 or hidden. 

• For information about manipulating toolbars, see Showing, Hiding and Moving 
Toolbars. 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 
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Action bar 

Use the Action bar to commands to calibrate a method, re-calculate a calibration using 
different settings, perform a prediction, export your prediction results or run an independent 
validation. 

 

 

Calibrate 

  
Set Model Factors 

 

 

Predict 

 

 

Export Results 

 

 

Run Validation 

    Reset Toolbar 

 Additional Information 

The  icon above indicates that the command is included in the default toolbar. 
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Graph Bar 

Use the Graph bar to optimize how your spectra are displayed.  

 

 

Auto XY 

 

 

Auto X 

 

 

Auto Y 

  
 

Prev 

  
 

Cancel Offset 

  
 

Format 

  
 

Text 

 

 

Cursor 

 

 

Cursor 

  
 

Autoscale Y 

  
 

Optimize 

  
 

Split 

  
 

Absorbance 

  
 

% Transmittance 

    Reset Toolbar 

Additional Information 

The  icon above indicates that the command is included in the default toolbar. 

You may decide to include other commands that you use frequently. See Personalizing 
Toolbars. 

These commands are also available from the View menu, and some are available from a 
shortcut menu in the Viewing Area. 

The Graph bar commands work on the active graph in the Viewing Area only. To make a 
graph active, click the left mouse button anywhere on the graph. The currently selected 
graph is highlighted. 
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Navigation Pane 

The Navigation Pane on the right hand side of the screen has two options: 

Setup – which enables you to access shortcuts to items on the Setup menu. 

Method – which enables you to access the Method Browser. 

Additional Information 

Changing the Order of the Options in the Navigation Pane 

 To change the order of items in the Navigation Pane, click the icon you want to move 
using the left mouse button, and then drag it to the new position. 

 A horizontal rule on the Navigation pane indicates the position at which the icon will 
be added. 

Opening and Closing the Navigation Pane 

 To open or close the Navigation pane, click the button at the center of the right edge 
of the Viewing Area. 

 OR 

 Select Navigation Pane from the View menu. 

 To open or close the Method Explorer, Navigation and Dialog panes simultaneously, 
hold down the SHIFT key and click the button that opens or closes any of these 
panes. 

Resizing the Pane 

 Open the pane, and then drag the edge of the pane containing the button (not the 
button itself) to the width or height required. 
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Navigation Pane - Setup 

Click Setup in the Navigation Pane to display shortcuts to key items from the Setup menu. 

 Click  to define your default setups for the Model Review. 

 OR 

 Click  to define your default setups for the Independent Validation Review. 

 OR 

 Click  to define your Algorithm Defaults. 

 OR 

 Click   to define your Classifications. 

 OR 

 Click   to define your Method Options. 

 OR 

 Click  to define your Pre-Processing Steps. 

Additional Information 

Changing the Order of the Options in the Navigation Pane 

 To change the order of items in the Navigation Pane, click the icon you want to move 
using the left mouse button, and then drag it to the new position. 

 A horizontal rule on the Navigation Pane indicates the position at which the icon will 
be added. 

Opening and Closing the Navigation Pane 

 To open or close the Navigation pane, click the button at the center of the right edge 
of the Viewing Area. 

 OR 

 Select Navigation Pane from the View menu. 

 To open or close the Method Explorer, Navigation and Dialog panes simultaneously, 
hold down the SHIFT key and click the button that opens or closes any of these 
panes. 

Resizing the Pane 

 Open the pane, and then drag the edge of the pane containing the button (not the 
button itself) to the width or height required. 
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Method Browser 

The Method Browser tab is where you can browse folders containing methods. These might 
be user-specific (Private) or global (Public) methods. If you have Spectrum Quant ES, 
additional groups will be available displaying locked methods ready For Review/Approval and 
Approved Methods. 

1. Click Method in the Navigation Pane to display the Method section. 

2. Click Browser   to display the Method Browser tab in the Dialog Pane. 

Method Browser Navigation 

The left pane of the Method Browser tab contains a list of available folders. 

The methods in the currently selected folder are displayed in a table that includes the 
Method Name, Method Description, Properties and Algorithm. In Spectrum Quant ES, the 
table also includes the Method Status (Not Registered, Unlocked, Locked, Reviewed or 
Approved). 

The Private (user-specific) and Public (global) folders are displayed by default. These folders 
are created during the software installation. Users can add additional folders, which are also 
user-specific. 

For details of the default folder locations, refer to Saving a Method. 

Method Status (Spectrum Quant ES only) 

In Spectrum Quant ES, the Method Status indicates whether the method is Not Registered, 
Unlocked, Locked, Reviewed or Approved. 

Methods located in the folders that have not been registered in the Spectrum Quant ES 
database are Not Registered. These may be methods created in Spectrum Quant Standard, 
another PerkinElmer software application, or methods created in another Spectrum Quant ES 
database. Upon opening, these methods will require a signature if the Quant - Open non-ES 
Data signature point is enabled. The Method Status is then Unlocked. Refer to Signing for 
more information. 

Any method that has been locked for review or approval has the Method Status Locked. A 
method that has been reviewed has the Method Status Locked, and any method that has 
been approved has the Method Status Approved. 

Registered Methods View (Spectrum Quant ES only) 

If you have Spectrum Quant ES, and you have Review or Approve permissions, the For 
Review/Approval  and Approved Methods groups will be visible under Registered 
Methods in the Method Browser. 

The For Review/Approval group contains links to methods (in any folder, Private, Public or 
user-created) that have been Locked or Reviewed. Similarly, the Approved Methods group 
contains links to methods that have been Approved. 
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Opening a Method 

To open a method listed in the Method Browser: 

 Select the required method in the table and click Open. 

 OR 

 Select the required method in the table and double-click the left mouse button. 

 If you have Spectrum ES and open an unregistered method, then you may be 
prompted for a signature for the Quant - Open non-ES Data signature point. 

Deleting Methods 

NOTE: In Spectrum Quant ES, a locked method (Method Status Locked, Reviewed or 
Approved) cannot be deleted. To delete a Locked or Reviewed method, it must be 
unlocked first. It is not possible to delete an Approved method from the database. 

1. Select the method you want to delete. 

2. Click Delete. 

 The Delete Method dialog is displayed. 

3. Click OK. 

Importing and Exporting Methods 

Importing a Method 

1. Click Import. 

 The Select Method For Import dialog is displayed. 

2. Browse to and select the method you want to import. 

3. Click Open. 

 The method is imported to your Private user folder. 

 If you have Spectrum ES, you may be prompted for a signature for the Quant - 
Import Method signature point. 

Exporting a Method 

1. Select the method you want to export. 

2. Click Export. 

 The Browse For Folder dialog is displayed. 

3. Navigate to and select the folder where you want to export the method. 

 OR 

 Browse to the desired location and click Make New Folder to create a new folder, 
and then rename it. 

4. Click OK. 

 If you have Spectrum ES, you may be prompted for a signature for the Quant - 
Export Method signature point. 
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Methods are exported to the QMDX file format in Spectrum Quant ES. This file format cannot 
be opened using the Open option on the File menu. You must import the method first and 
then open it. 

Adding and Removing Folders 

Adding a New Folder 

1. Click Add folder. 

 The Browse For Folder dialog is displayed. 

2. Navigate to and select the folder you want to add to the Method Browser. 

 OR 

 Browse to the desired location and click Make New Folder to create a new folder, 
and then rename it. 

3. Click OK. 

 The new folder is included in the list of available folders. This folder is user-specific 
and will not be visible to other users. 

Removing a Folder 

NOTE: The group of folders in Spectrum Quant ES containing locked methods cannot be 
removed. 

1. Select the folder you want to remove. 

2. Click Remove Folder. 

 The Remove Folder dialog is displayed. 

3. Click Yes. 

 The folder is removed from the list of available folders. However, the folder and 
contents will not be deleted from disk. 

Additional Information 

You can also open a method from the File menu. 
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Dialog Pane 

The Dialog Pane is at the bottom of the workspace. The contents of the Dialog Pane, 
arranged on one or more tabs, reflect the shortcut selected in the Navigation Pane. 

Opening and Closing the Dialog Pane 

 To open or close the Dialog Pane, click the button at the center of the bottom edge 
of the Viewing Area. 

 OR 

 Select Dialog Pane from the View menu. 

 To open or close the Method Explorer, Navigation and Dialog panes simultaneously, 
hold down the SHIFT key and click the button that opens or closes any of these 
panes. 

Resizing the Pane 

 Open the pane, and then drag the edge of the pane containing the button (not the 
button itself) to the width or height required. 
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Showing, Hiding and Moving Toolbars 

Showing and Hiding Toolbars 

You can organize your workspace by hiding a toolbar, or by showing a toolbar that had been 
hidden. 

 In the View menu, click the  icon to the left of the name of the toolbar that you 
want to hide. 

 OR 

 Click the shaded area to the left of the name of the toolbar that you want to show. 

NOTE: The Menu bar cannot be hidden. 

Locking and Unlocking Toolbars 

Locking toolbars 

Locking a toolbar protects it from some inadvertent changes. A locked toolbar can be hidden, 
and its buttons re-arranged or reset, but it cannot be customized or dragged to a new 
location. 

 Right-click the  button to the right of the toolbar and then click Lock The 
Toolbars. 

 The toolbars are locked when  is displayed to the left of this command. 

Unlocking toolbars 

 Right-click the  button to the right of the toolbar and then click Lock The 
Toolbars. 

 The toolbars are unlocked when  is not displayed to the left of this command. 

Moving, or Floating, a Toolbar 

When a toolbar is unlocked, a dotted drag handle is displayed, usually on its left edge. This 
handle enables you to change the position of a toolbar, or to float it in a separate window. 

 Place your mouse pointer over the drag handle on the toolbar you want to move, 
click the left mouse button, and then drag the toolbar to its new position. 

Additional Information 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 

• For information about adding or removing toolbar buttons or menu items, see 
Customizing Toolbars and Menus. 
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Personalizing Toolbars 

You can personalize toolbars by organizing their appearance and by showing, hiding and re-
arranging buttons. 

Showing and Hiding Buttons 

The toolbars are, by default, populated by standard sets of buttons (that is, icons or text 
entry fields). You can organize your workspace by hiding any buttons that you do not use 
very often, or by showing a button that had been hidden. 

 Click the  button to the right of the toolbar you want to modify, select Add or 

Remove Buttons, the name of the toolbar, and then click the  icon to the left of 
the name of the button that you want to hide. 

 OR 

 Click the shaded area to the left of the name of the button that you want to show. 

Re-arranging Buttons on a Toolbar 

You can arrange the buttons in the toolbars to suit your preferred method of working. 

1. Hold down the ALT key and select the edge of the button you want to move.  

 The button is surrounded by a black box. 

2. Drag the button to its new position on the toolbar.  

 The button is placed at the position of the cursor. 

Changing the Icon Size 

3. In the View menu, select Main Toolbars and then select Customize.  

 OR 

 Right-click the  button to the right of a toolbar and then click Customize. 

 The Customize dialog is displayed. 

4. Select the Options tab.  

 By default, the Large Icons in Toolbars option is enabled (checked). 

5. If you want to display the toolbar buttons with smaller icons, as used in the menus, 
disable (uncheck) the Large Icons in Toolbars option. 

6. Click Close. 
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Resetting a Toolbar 

 Click the  button to the right of the toolbar you want to reset, select Add or 
Remove buttons, the name of the toolbar, and then click Reset Toolbar. 

 The toolbar is reset to the factory standard button set and arrangement. 

Additional Information 

• For information about showing and hiding toolbars, and locking and unlocking 
toolbars, see Showing, Hiding and Moving Toolbars. 

• For information about adding or removing toolbar buttons or menu items, see 
Customizing Toolbars. 
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Customizing Toolbars and Menus 

Adding Buttons to a Toolbar 

You can customize a toolbar by adding buttons that are not simply hidden in the current 
setup. For example, you can add a button that is usually displayed in another toolbar. 

1. In the View menu, select Main Toolbars and then select Customize.  

 OR 

 Right-click the  button to the right of the toolbar, and then click Customize. 

 The Customize dialog is displayed. 

2. Select the Commands tab, and then click Rearrange Commands.  

 The Rearrange Commands dialog is displayed. 

3. Select the Toolbar option, select the toolbar you want to customize from the drop-
down list, and then click Add.  

 The Add Command dialog is displayed. 

4. Select from the Categories of command available, and then select the Command 
you want to add.  

 You can select any available command from the All Commands category. 

5. Click OK.  

 The command is added to the list of commands that you can rearrange. 

6. Position the command in the toolbar by clicking Move Up and Move Down. 

7. If you want to insert a separator 'below' a button (as listed in the dialog, usually to 
the right of the button when the toolbar is displayed), click Modify Selection and 
select the Begin a Group option. 

8. Click Close. 

9. Click Close to shut the Customize dialog. 

NOTE: Although you can use the Rearrange Commands dialog to delete a command from a 
toolbar, you may prefer to simply hide it. 

Alternatively, you can drag-and-drop icons onto toolbars: 

1. In the View menu, select Main Toolbars and then select Customize.  

 OR 

 Right-click the  button to the right of the toolbar, and then click Customize. 

 The Customize dialog is displayed. 

2. Select the Commands tab. 

3. Select from the Categories of command available, and then select the Command 
you want to add.  

 You can select any available command from the All Commands category. 
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4. Drag the icon onto the toolbar in the position you want to add it.  

 The command is added to the toolbar. 

5. Click Close to shut the Customize dialog. 

Creating a New Toolbar 

You can create a new toolbar containing any of the available commands, such as those 
needed for a particular task. You could hide the toolbar when it is not needed. 

1. In the View menu, select Main Toolbars and then select Customize.  

 OR 

 Right-click the  button to the right of a toolbar and then click Customize. 

 The Customize dialog is displayed. 

2. Select the Toolbars tab, and then click New.  

 The New Toolbar dialog is displayed. 

3. Enter a Toolbar name and select its default Location, and then click OK.  

 The New Toolbar dialog closes, and an empty toolbar is added. 

 The toolbar name will be added to the Main Toolbars sub-menu in the View menu, 
which enables you to show or hide it. 

4. If you want the toolbar to be hidden by default, deselect the checkmark to the left of 
its name in the Toolbars pane. 

5. To populate your toolbar, continue from Step 2 in Adding Buttons to a Toolbar.  

 OR 

 Click Close. 

Customizing the Menu Bar 

NOTE: The menu system is very flexible, but there are some restrictions. For example, some 
sub-menus are treated separately and not every command is available. 

You cannot add a new menu to the Menu bar, or add a command that does not exist. 
However, you can simplify a menu by not displaying a command that you never you use, 
display a command in another menu, or rearrange a menu to make a useful command more 
prominent. 

1. In the View menu, select Main Toolbars, and then select Customize.  

 OR 

 Right-click in the Menu bar and then click Customize. 

 The Customize dialog is displayed. 

2. Select the Commands tab, and then click Rearrange Commands.  

 The Rearrange Commands dialog is displayed. 
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3. Select the Menu Bar option, and then select the menu or sub-menu that you want 
to customize.  

 If any of the existing commands in the menu can be modified, they are listed in the 
Commands pane. 

4. If you want to add a command to the menu, click Add, select the command from the 
Add Command dialog, and then click OK.  

 The command is added to the list of commands that you can rearrange. 

5. Position a selected command in the menu by clicking Move Up and Move Down, or 
remove it by clicking Delete. 

6. If you want to insert a separator below a command, click Modify Selection and 
select the Begin a Group option. 

7. Click Close. 

8. Click Close to shut the Customize dialog. 

Additional Information 

• For information about showing and hiding toolbars, and locking and unlocking 
toolbars, see Showing, Hiding and Moving Toolbars. 

• For information about manipulating toolbar buttons, see Personalizing Toolbars. 
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Theory of Quant Algorithms 
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Theory of Beer’s Law Algorithm 

The Beer’s Law algorithm calculates the quantities of components in the sample spectrum 
using the height or area of peaks, on the assumption that for each component there is an 
isolated band whose strength varies proportionally with the concentration of the component 
in the sample.  

The concentration of a component in the sample (X) is determined by measuring the height 
or area of the band that is associated with this particular component. The concentration of 
the component is calculated using the equation as per the Fit Type selected (Linear, 
Quadratic, Cubic or User Defined), where the values for the equation parameters are 
determined by the method calibration and Y is the height or area that is measured. 

Beer’s Law can be used with samples of differing but known pathlength, for example with 
pressed films. There is an option to enter a pathlength for each sample. If you choose this 
option, measured absorbances are scaled by the inverse of the pathlength to give the 
equivalent absorbances that would be obtained at constant pathlength. 

Using the Peak Ratio option, it is also possible to use an internal reference band from a 
component at known concentration for samples of unknown pathlength or unknown dilution. 
This material must have an isolated band and be present at a known concentration. The 
measured absorbances are then scaled so that the absorbance of the reference band is 
proportional to the concentration of the reference material. 
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Beer’s Law Algorithm Calibration 

A Beer’s Law method is calibrated using a least squares polynomial fit for each component of 
known concentration on three or more standard spectra. The software calculates the 
polynomial fit regression, a Standard Error and a Standard Error of Prediction (SEP) from the 
standard data. Residuals (differences from the nominal standard concentrations) are also 
calculated as part of the calibration. 

For the linear fit, the slope (b) and intercept (a) are calculated from the Variance and the Co-
variance of the data. The Standard Error equations are displayed below.  

 

where : 

n = number of standards 

Quadratic and cubic functions are fitted using the same methodology, but with the squares 
and cubes of the predictor variable X included in the regression. The user-defined fit type 
allows the user to define the coefficients directly and does not use any regression. 

The Standard Error of the Prediction is calculated using the following equation. 
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Beer’s Law Property Correlation 

When you perform a property correlation, a mean spectrum (Mean.sp) and a standard 
deviation spectrum (Standard Deviation.sp) are displayed on the Spectral View in the 
Standards tab (if Show Statistical Data is enabled). A property correlation spectrum is 
displayed for each component specified in the method ([Component name].sp).  

These spectra are calculated as follows: 

Mean 

Sum the absorbance value at each wavelength and divide by the number of standard 
spectra. 

Standard Deviation 

 

where : 

x = the absorbance value at one wavelength 

n = number of calibration standards 

Property Correlation 

 

where: 

Si
pc = is the ith value of the property correlation spectrum for the property. 

xi = is the ith value of the mean spectrum. 

xji = is the ith value of the spectrum of the jth sample. 

pj = is the property value of the jth sample. 

p = is the mean property value. 

ns = is the number of standards. 

nv = is the number of variables. 

Additional Information 

To export the spectra as a binary (*.sp) or ASCII (*.asc) file, see Saving Spectra from the 
Spectral View. 
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Overview of Full-Spectrum Algorithms 

The calibration procedure for the full-spectrum algorithms available in Spectrum Quant is 
based on either a modified form of principal components regression (PCR) or on a partial 
least squares (PLS) fit for one or more properties. In Spectrum Quant, the regression model 
for each property is refined by selecting only those factors considered to be of statistical 
significance in determining that property. 

In PCR+, the spectra are modeled by one set of factors and each property is modeled by 
relating the concentration values to those factors. In PLS1, the spectra are modeled by a 
different set of factors for each property and the concentration values are modeled by the 
respective factors. Hence PLS1 really contains n separate calibrations, where n is the number 
of properties in the method. 

As part of the calibration procedure, Spectrum Quant generates a calibration report file that 
contains information about the structure of the calibration set and the quality of the property 
regression model. For many typical applications, a detailed understanding of this file is not 
required because all the important information can be displayed from the Review graphs and 
reports. However, the calibration report file can provide extremely useful information for 
estimating the accuracy and validity of the calibration equations. 

Typical concerns may be: 

• The distribution of the calibration data and identification of outliers. 

• The number of independent contributions to the set of calibration spectra. 

• The quality of the regression modeling and the influence of individual samples and 
model parameters. 

• The relationships between models for different properties (that is, collinearity 
between properties). 

• The effect of refining the model. 
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Decomposition of the Data Matrix 

The decomposition step makes it possible to express the data (spectra) as a linear 
combination of independent terms: 

X  =  S  x  FT 
(ns x nv)  (ns x nf )  (nf x nv) 

where: 

X is the matrix of calibration spectra (spectra are columns). 

F is the matrix of factors (principal components or latent variables), where T denotes 
transpose. 

S is the matrix of scores. 

ns is the number of spectra. 

nv is the number of data points (variables) per spectrum. 

nf is the number of factors (principal components or latent variables). 

In descriptions of the PLS algorithm, F is often referred to as P, and S referred to as T; that 
is, X=TPT. If T is orthogonal (that is, the scores are independent of each other), then in 
general the P matrix of factors or loadings is not orthogonal, whereas in the PCR case the 
scores and loadings are orthogonal.  

Centering/Scaling of the Data 

Data are centered/scaled according to the following formula: 

   xi j —   z i j  
Xi j

*
  =   

   si j  
zij = 0 ,    sij = 0   = none (covariance about the origin) 

zij = xi  ,    sij = 1   = mean (covariance about the mean) 

zij = xi  ,    sij = σi   = autoscale (autoscaled data) 

where xi and σi are the mean value and standard deviation of the ith column of X 
respectively.  
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Theory of Principal Component Analysis  

The aim of Principal Component Analysis (PCA) is to express the variation in the spectral data 
in as few terms as possible. In this sense it is a maximal data compression scheme. 

Eigenvalues 

Principal components (factors) are listed in decreasing order of the magnitude of the 
associated eigenvalue, li . The eigenvalues satisfy the following eigenvalue equations: 

Q-1ZQ = [ li , dii ]  =  L 

where: 

Z = XTX 

Q is the eigenvector matrix and is equal to the scores matrix, S. 

L is a diagonal matrix of the eigenvalues. 

dii is the Kronecker delta. 

Each eigenvalue represents the spectral variance expressed by the associated principal 
component. The sum of the eigenvalues is equal to the total spectral variance of the data 
set. 

If there is a drop exceeding 105 between two successive eigenvalues, all subsequent 
eigenvalues are excluded from any calculation relating to the determination of the number of 
significant principal components (rank). This avoids the possibility of falsely identifying the 
rank because of rounding errors in the calculation of the eigenvalues. 

Having found the scores, S (=Q), the factors(F) can be found via F=XTS.  

Determination of the Rank of Data 

The rank is the number of independent sources of variation within the data, excluding 
random noise. Determination of the rank of the data is a key step in the analysis. The 
principal components retained after PCA should contain all significant spectral variations 
within the data, but minimize random noise. 

Indicator Function 

The Indicator Function (IND) is an empirical function found to be sensitive in its ability to 
distinguish between real factors and noise (real and error eigenvalues). The number of 
principal components corresponding to the minimum in the IND function indicates the 
number of significant principal components in the data, more commonly called the rank of 
the data. 



190 . Spectrum Quant User's Guide 

 

Reduced Eigenvalues 

The reduced eigenvalues allow the error eigenvalues (noise) to be detected. In theory, all 
reduced eigenvalues resulting from noise should have similar magnitudes. Plotting reduced 
eigenvalues versus number of factors, the number of significant principal components (rank 
of the data) should correspond to the edge of a plateau in the reduced eigenvalues, 
indicating a distinction between real factors (information) and noise. 

 

F-statistics and Significance Levels 

An F-test can be applied to the reduced eigenvalues to allow the number of significant 
principal components (rank) to be determined. The smallest eigenvalue is assumed to result 
from noise. The significance of the next smallest eigenvalue also being a member of the 
noise population is calculated using an F-statistic. If the eigenvalue is similar to the noise 
eigenvalue, the two eigenvalues are pooled to form a weighted average noise eigenvalue for 
testing the next smallest eigenvalue. 

The number of significant principal components (rank) corresponds to the number of factors 
with a significance level of less than 10% (by default). Factors with significance levels 
greater than 10% are deemed to be noise. 

NOTE: The 10% level is usually satisfactory. However, the cumulative spectral variance 
expressed by the factors may provide guidance in selecting the appropriate level. If 
the number of standards is greater than 50 or greater than 500, it is recommended 
that you reduce this value to 1% or 0.1% respectively. 

Selection of Factor Compression Cutoff Point 

The cutoff point indicates the number of factors that will be retained for the multiple linear 
regression (MLR) modeling. The decision is based on: 

• The total number of standards. 

• The number of factors corresponding to the minimum in the IND function. 
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• The number of factors corresponding to the point where the F-test significance level 
first drops below 10% (backwards search). 

• The user-defined maximum number of factors as specified on the algorithm 
parameters tab. 

The maximum number of factors allowed by Spectrum Quant is arbitrarily set at two-thirds of 
the number of standards. If the number of factors wanted by Spectrum Quant exceeds this 
limit, there are too few calibration standards for the number of sources of variation in the 
data.  
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Outlier Tests 

Variable and spectral outliers may be identified by calculating the respective leverage value. 
Leverage is calculated using the following formula: 

zT
i (ZT Z)–1 zi 

where zi is a vector of the coordinates of the ith object as described below, and Z is a matrix 
of zi for all values of i where the zi form rows of the matrix Z. 

A cutoff is applied to the leverage value to determine if the variable or standard is an outlier. 

This cutoff is set to 2 x , representing twice the average leverage value.  

Variable Outliers 

Each of the variables is tested for exceeding the leverage cutoff value. Variables exceeding 
this limit are included in the calibration report. Variables above the cutoff represent features 
in the spectra of the calibration set that have little or no correlation with other features and 
hence are a major source of discrimination between spectra in the calibration set. It is 
undesirable to base a model on factors where a small number of variables are dominating. 
The major causes of variable outliers are artifacts in spectra or noise associated with large 
features. 

In the calculation of variable outliers, zi is the loadings for the ith variable for all factors up to 
the factor compression cutoff point.  

Standard Outliers 

The standard leverage can be used to look for the presence of a typical standards in the 
calibration set. Standards whose leverage exceeds the cutoff usually contain an unduly large 
contribution from one factor. In such cases, the source of such abnormalities should be 
investigated and the sample assessed for further suitability as a calibration standard. The 
major causes of standard outliers are artifacts in spectra or noise associated with large 
features (which will show up as outliers) and standards that have isolated property values 
(that is, a standard with a property value that is not close to any other standard). 

In this case, zi is the scores for the ith standard for all factors up to the factor compression 
cutoff point.  
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Multiple Linear Regression 

Multiple Linear Regression (MLR) is used to model the property values in terms of the scores 
for the calibration standards. For np properties: 

    Y =        T     x    CT   +   K    +    E 

(ns x np) (ns x nf) (nf x np) (ns x np) (ns x np) 

where: 

Y is the matrix containing all the property values for each standard. 

K is a matrix with each row containing the same value, namely the intercept for that 
property. 

E is a matrix of residuals. 

C is the matrix of regression coefficients. 

The regression coefficients are estimated by the method of least squares: 

C+ = YTT+{T+TT+}-1 

where T+ is the scores matrix augmented with a column of 1s to give an extra column in C to 
allow for the constant term in the regression (that is, the K matrix can be absorbed into C+ 
and T+, giving Y = T+ x C+T + E). 

For PLS, the regression coefficients are calculated as part of the data decomposition step, 
and hence the MLR need not be explicitly performed. However, if there are missing property 
values in the data, Spectrum Quant still uses the spectra of the standards with missing 
property values to generate scores and loadings, but does not use them when calculating the 
regression coefficients. As a result of this, the score vectors used to calculate regression 
information are no longer orthogonal to each other and hence a full MLR with all the factors 
has to be performed at the generation of every PLS factor.  
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Full Regression Model 

The results for the full regression model, using all factors up to and including the factor 
selection cutoff point, are listed for each property. Hence for the kth property, the estimated 
or calculated property values are given by: 

 

The leverage for each standard is calculated from the same formula as before, except that zi 
is now the vector of scores for the ith standard augmented with 1 for the intercept term and 
using only those factors deemed to be significant to the regression. For the full model this is 
all factors up to the compression cutoff point. In the case of mean control or autoscaled 

data, it will be seen that these leverages are offset from the PCA leverages by because 
of the bias introduced by the intercept term. 

The value of the regression coefficient, cKj, the standard deviation of the regression 

coefficient, scKj, the computed t-value and its associated significance level, and the 
correlation of property versus scores for each factor, are tabulated in the calibration report. 
The relative significance of each factor in estimating the values for that property can be 
found by comparing the magnitudes of the associated t-values.  

The variables below are calculated as part of the full regression model. 

Coefficient of Determination, R2 

The coefficient of determination (listed as R-squared) for the full model gives the proportion 
of variability of the property that is described by the model. It indicates the strength of the 
relationship between the property values and the scores. It can be considered as the simple 
ratio: 

 

= variance covered by model 
     total property variance 

where: 

RSS = variance not covered by the model (residual sum of squares). 

SYY = total property variance.  

Multiple Correlation 

The Multiple Correlation, R, is the square root of the coefficient of determination, R2. 
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Standard Error of Estimate (SEE) 

The Standard Error of Estimate (SEE) for the regression gives an indication of the quality of 
fit of the regression. It should not be confused with the Standard Error of Prediction (SEP) 
for independent samples. SEE can be described as the square root of the residual variance 
divided by the number of degrees of freedom, where the residual sum of squares (RSS) is 
calculated as in the equation above: 

 

Intercept 

Analogous to the simple linear regression calculation for y = mx + c, the intercept term 
refers to the constant term in the regression. 

The regression coefficients corresponding to each factor are usually calculated first. Then the 

mean calculated property value can be determined from this regression coefficient 
vector, and the means of the scores for each factor: 

 

where: 

 

The intercept is the difference between the mean observed property value y and the mean 
calculated property value: 

 

and indicates the distance from the origin to the mean of the learning set in units of the 
property value. For autoscaled or mean-centered data, the mean of the scores for all factors 

is zero and hence = 0 and intercept = y .  

Correlation of Property versus Factor Score 

For each factor, the (partial) correlation of its scores with the property values are listed. This 
gives an indication of the strength of the relationship between the property values and the 
scores for that factor with the influence of the other factors removed. 

For mean-centered or autoscaled data, the partial correlation for each factor is a direct 
measure of the degree of property variance described by that factor, the influences of the 
other factors, and that of the intercept on this factor being zero. 
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For the jth factor: 

  cross-correlation between the scores for factor j and property values 
rj

2
  =   

  (standard deviation of property value) x (standard deviation of scores for factor j) 

 

NOTE: Summations are from i = 1 to ns. 

Standard Error of Regression Coefficient 

The standard error of regression coefficient, scj, is calculated from the scores covariance 
matrix and the standard error of estimate: 

 

that is, the square roots of the diagonal elements of the inverse of the scores covariance 
matrix multiplied by the standard error of the estimate. 

It is found that, for mean-centered and autoscaled data, the standard errors of the 
regression coefficients are equal. This is not necessarily the case when no scaling is 
performed on the data (covariance about the origin). 

This can be seen by considering the terms of the dispersion matrix D in the expression for 
scj: 

D = (T+TT+)–1 

For mean-centered or autoscaled data: 

d11 = ns-1 

dij = 1 for i = j ≠ 1 

otherwise 

dij = 0 because of the orthonormality of the PCs. 

Hence, scj are equal factors with the error for the intercept being: 

 

For data that has not been scaled, the scores of f1 (factor 1) are all positive or all negative, 
hence a non-zero correlation between the scores for f1 and the intercept exists: 

d12, d21 ≠ 0 

d22 » dii for i > 2 

dii are similar for i>2 
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Hence the scj are not equal for all j but scj for the first factor tends to be much larger than 
that for the remaining factors. The scj for the remaining factors tend to be similar.  

F-test 

In order to evaluate the overall performance of a model, an F-statistic can be calculated to 
determine whether the property variance accounted for by the model is significantly better 
than the residual property variance: 

( ) ( )

( ) ( )∑

∑

=

=

−−

−−−
=

s

s

n

i
fii

n

i
fsi

nyy

nnyy
F

1

2

1

2

1ˆ

1ˆ
 

where nf is the number of significant factors in the model. Note that each sum square has 
been corrected for the degrees of freedom.  

The % significance value, 100(1-α), for the F-term can be found using:  

F (α;nf -1, ns-nf -1) = F-value, in statistical tables. 

A poor regression will give a low (<3) value for F. The F-value can be viewed as a measure 
of the signal-to-noise in the model. 

SEP Estimates 

The SEP estimate gives an estimate of the standard error of prediction (SEP), that is, the 
magnitude of the error expected when independent samples are predicted using the model. 
In effect, a standard is removed from the MLR and a model built using the other ns-1 
standards. Note that the standard is only removed from the MLR, not from the data 
decomposition, as in full cross-validation. The removed standard is then predicted using this 
model. This is done for each standard in the calibration set. The SEP Estimate is calculated 
from: 

 

where denotes the predicted property value for the ith standard when it was dropped 
from the MLR. 

This formula provides a very fast way of estimating the error to be found in the property 
values when predicting, and provides results very similar to the full cross-validation SEP 
values when each standard in the calibration set has another standard that is reasonably 
similar.  

% Significance Level to Minimum SEP 

This is a backwards search on the SEP values, starting at the minimum. The minimum SEP 
could be used as the criterion for the number of factors to include in the final model. 
However, because robust models are required, we recommend that you use as few factors as 
possible in the model. It may well be the case that fewer factors can be used without 
significantly impairing the SEP value. Hence all SEP values up to the minimum are compared 
to the minimum, using an F-test: 
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and the % significance level , 100 x (1-α), calculated from: 

Fj
min = F (α; ns  –  j  –  1, ns – nmin – 1 ) 

where nmin is the number of factors corresponding to the minimum SEP value.  

% Significance Level of Extra Term 

An alternative way of looking for a robust model using the SEP values is to ask if adding a 
further factor to the model significantly improves the SEP value. Again, an F-test can be 
calculated by: 

 

and the % significance level, 100 x (1-α), calculated from: 

Fj
extra = F (α; ns ,nv (ns  – j  –  1)) 

Because nv can be very large, the significance level is approximated with: 

F (α; 1,ns – j  –  1) 

If the SEP increases when an extra term is added, then no significance level is calculated.  

Determination of the Number of Factors in the Reduced Model 

The determination of the number of factors to be used in the reduced model can be based 
on a number of criteria, such as tests on the minimum SEP estimate, the minimum MLR 
F-test and an MLR t-values test. 

Note that for PCR+, the factors are dropped from the regression starting with the least 
significant factor (smallest t-value), until only one factor remains, calculating the statistics at 
each iteration. For PLS methods, the factors are dropped starting with the last PLS factor, 
until only the first PLS factor remains. In all cases, the % significance level to a minimum 
SEP result is taken as giving the best model (whether using SEP estimates or SEPs generated 
from validation).  

Minimum MLR F-test 

As each factor is dropped from the regression, the F-value for that combination of factors is 
calculated. The number of factors that gives the largest F-value is taken to be the cutoff.  
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MLR T-values Test 

The t-values for each regression coefficient give a probability for the associated regression 
coefficient being significant to the regression. Given a list of significances with the 
requirement of looking for values below a cutoff, then for a given cutoff significance level 
there is an appreciable probability that in a large list there will be some factors that are 
deemed to be significant when they are not. Hence the cutoff level must be reduced by the 
number of degrees of freedom in order to avoid this situation (Bonferoni inequality). The 
cutoff significance is set at 5%, and so for a list of nf factors, the t-value corresponding to 

 

is calculated. As can be seen, the probability of a factor being significant is much stricter for 
large nf, but this is relaxed when nf is small; for example, out of 20 factors the probability 
that a regression coefficient is non-zero has to be greater than 99.75% before the 
corresponding factor is deemed significant, whereas for one factor the probability that the 
regression coefficient is non-zero only has to be greater than 95% before being deemed 
significant. The number of factors to be chosen for the cutoff corresponds to all factors being 

deemed significant at the level.  
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Theory of PCR+ Algorithm  

The technique attempts to establish a relationship, one for each component or property of 
interest, between the spectra of a set of calibration standards, and the corresponding 
property values determined by independent means (e.g. experimentally). These relationships 
can be used for the subsequent prediction of unknown samples. 

In PCR+, the spectra are again modeled by one set of factors, and each property is modeled 
by relating the concentration values to those factors. PCR+, in the PCA stage, only seeks to 
account for variations in the spectral data and then, in the Multiple Linear Regression (MLR) 
stage, correlates this with the property data. 

Note that for PCR+, the factors are dropped from the regression starting with the least 
significant factor (smallest t-value), until only one factor remains, calculating the statistics at 
each iteration. For PLS methods, the factors are dropped starting with the last PLS factor, 
until only the first PLS factor remains. In all cases, the % significance level to a minimum 
SEP result is taken as giving the best model (whether using SEP estimates or SEPs generated 
from validation). 

For PCR+, the average spectral variance is given by the sum of the error eigenvalues, 

( ) ( )
spectra ncalibratio of variance spectral residual

ˆˆ s
T nuuuu

FSR
−−

=  

which for PCR+ 

 

where: 

u is an unknown spectrum. 

û is the spectrum produced from the factors up to the cutoff point. 

A suggested F-test would be F (a ; (nv – nf ) / 2, (nv –  nf) (ns –  nf – 1) /2), but because nv is 
usually very large, then for a = 0.95 the F-value would always be close to 1. As an 
approximation, an F-test of F (α ; 1, (ns – nf  – 1)) could be used. As a general rule, an 
F-value greater than 3 for an unknown sample should indicate a significant outlier. 
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Theory of PLS1 Algorithm 

The chemometric approach to quantification provides a choice of multivariate calibration 
algorithms, an example of which is Partial Least Squares (PLS1) Regression. In PLS1, the 
spectra are modeled by a different set of factors for each property, and the concentration 
values are modeled by the respective factors. Hence PLS1 really contains n separate 
calibrations, where n is the number of properties in the method. 

For the PLS1 algorithm, each property is analyzed individually with respect to the spectral 
data. This means that if there is a high degree of correlation between properties, it is more 
efficient to use the PCR+ algorithm. Partial Least Squares seeks to express the variation in 
the property information by correlating it with the spectral information, whereas PCR+, in the 
PCA stage, only seeks to account for variation in the spectral data and then in the MLR stage 
correlates this with the property data. Hence, for PLS, only spectral information that relates 
to property variation will be accounted for. In practice, because there is usually noise 
associated with property values, and since spectral features from one property overlap 
others, the majority of spectral variance is usually accounted for. 

PLS1 can be considered as a weighted form of PCA. Instead of finding the eigenvalues of the 
spectral data matrix XTX, the spectral data is weighted by the property values Y to give a 
new matrix XYTYXT. Hence, spectra with small property values are de-weighted with respect 
to those with large property values. However, rather than find all the eigenvalues of XYTYXT, 
only the first one is found. The contribution of the corresponding score on the spectral values 
X and the property values Y are subtracted from X and Y respectively. The new matrices X1 
and Y1 now form a new weighted matrix XYTYXT and the first eigenvalue of this matrix is 
found. This procedure is continued until Xn and Yn correspond to just noise in the spectral 
data and property values respectively.  

The reason why only one eigenvalue is calculated is: 

 

(where ci is the vector of property regression coefficients or PLS Y-weights) that is, more 
variance in the weighted matrix XYTYXT can be accounted for by subtracting the contribution 
of the current latent variable and score and finding the first eigenvalue of the resultant 
matrix product, than can be accounted for by finding subsequent eigenvalues of XYTYXT. 

For PLS1, y replaces Y because it is a vector rather than a matrix. The algorithm for PLS1 
can hence be thought of as:  

1. Find the first eigenvector of XT
0 y0 yT

0 X0 (this gives the loading weights, w) and 
corresponding spectral score, latent variable and regression coefficient by: 

  

 a) Here, w1 has been scaled to unit length, that is wT.w = 1. 

 b) Project into data matrix to find corresponding PLS scores: 

 (scaling to unit length) 



202 . Spectrum Quant User's Guide 

 c) Project score into data matrix to find corresponding nonorthogonal PLS loading: 

  

 d) Regress score on property values to find regression coefficient: 

  

2. Create new product matrix XT1  y1 , where: 

X1 = X0   –   t1• pT
1  

 y1 = y0 - t1c1 

3. Continue 1 and 2 until Xn and yn are of the order of noise, then: 

 y = Tc + e 

 where T is the matrix {t1, t2,....., tn}, and 

 X = TPT + E = TGWT + E 

 where matrix P is {p1, p2,....., pn}, matrix W is {w1, w2,....., wn}, G is an upper bi-
diagonal matrix, and e and E are noise. In Review, it is the w vectors that are 
displayed as the loadings and the t vectors that are displayed as the scores. Note 
that there is no direct relationship between the scores and the loadings as there is in 
PCR+, where X=SFT. The equivalent of the factor matrix F in PLS1 is the P matrix, 
but this is not orthogonal (that is, the columns are not independent of each other). 

 However, because G is an upper bi-diagonal: 

 pi = wi • gii  +  wi+1 • gi+1,i    for i = 1, ... nf – 1 

 

 where nf is the number of PLS1 factors (latent variables). So each p vector is a 
combination of the corresponding w vector and the previous w vector. 
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Determination of Rank 

We strongly recommend that a validation procedure is performed in determining the rank for 
PLS1 calibrations, because there is a tendency for overfit. The overfitting is a consequence of 
noise in the property data, resulting in the residual property data nearly always having a 
non-zero correlation with the spectral data. If validation is not used, two criteria are used to 
determine how many PLS factors are to be used. 

The first is identical to the F-test on the reduced eigenvalues in PCR. In this test, the average 
variance of the residual spectral data is compared to the spectral variance accounted for at 
the current factor. When this value rises above a given threshold, a flag is set. 

 

where: 

K2 is the total spectral variance 

λi is the spectral variance accounted for by the ith PLS factor. 

The second is identical to the backward Standard Error of Prediction (SEP) F-test as in the 
MLR stage of the PCR. SEP estimates are calculated for successive combinations of PLS 
factors. Initially a minimum in the SEP estimate value is required. However, if one is not 
reached after the minimum number of PLS factors (as specified in the method) or five, 
whichever is the larger, have been calculated, the flag is set when the SEP for two successive 
factors does not significantly change. 

 

where: 

is the predicted property value for the ith sample using j PLS factors 

hii is the leverage of the ith sample in the property subspace SEPk is the Standard Error of 
Prediction estimate with k PLS1 factors, with k<j and SEPk being the next smallest value to 
SEPj. 

If, for the ith factor, both F-ratios indicate little change in the amount of spectral and property 
variance being modeled, no more factors are calculated and this is taken as the rank of the 
matrix product XT

0  y0. 

In order to determine the cutoff points, Spectrum Quant uses the  F-test significance value, 
as defined in the method, for the spectral F-ratio and the backward search SEP significance 
value, also defined in the method, for the SEP F-ratio. These are set by default to 10% and 
25% respectively. 
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Theory of QuantC Algorithm 

QuantC is a software algorithm that is suited to multicomponent quantitative analysis of 
FT-IR spectra. It uses a curve-fitting technique that combines simple method development 
with the ability to analyze complex mixtures.  

Instead of measurements at discrete frequencies, QuantC uses data from complete spectra 
or user-defined regions. Spectra of a series of standards of known composition are recorded 
and stored. These standards are usually mixtures, rather than the pure individual 
component. The number of standard samples (containing up to fifteen components) must be 
equal to or greater than the number of components. When the spectrum of a sample is 
measured, the program attempts to match this spectrum by adding together the spectra of 
the standards in varying proportions, yielding a calculated sample spectrum. The closest 
match is that giving the least squared deviation between measured and calculated spectra, 
with the difference between the measured and calculated spectra called the residual 
spectrum. From the proportions of the standard spectra and the known concentrations and 
pathlengths, the composition of the sample can be calculated.  

Since this method uses all of the information in the spectra, better precision is achieved than 
if only a few frequencies are used. Method development is simplified, as it is not necessary to 
specify analytical frequencies and baseline points for each component. The overall 
measurement range has to be defined and the program can be instructed to ignore regions 
where there are absorption bands from components not included in the analysis. Baseline 
estimation is handled automatically by the program.  

The curve-fitting approach used in QuantC does not involve any calibration procedure, so 
that no calibration curves are generated. If the spectrum being analyzed is identical to one of 
the standard spectra, the program obtains a perfect fit using the matching standard. The 
performance of a chosen method can only be verified by analyzing samples of known 
composition. 
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